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Введение 

 
HFSS v. 13 - это программа расчета электромагнитного поля для 

проектирования СВЧ структур, имеющая несколько алгоритмов расчета [1]. 
Последняя версия программы HFSS выполняет расчеты методом конечных 
элементов в частотной области, переходные процессы, использует метод 
интегральных уравнений, а также гибридный подход: метод конечных 
элементов + метод интегральных уравнений. 

Каждый метод в HFSS реализован в виде программы, в которой нужно 
создать исследуемую структуру, задать параметры материалов и 
рассчитываемые характеристики. После этого HFSS генерирует сетку для 
решения задачи методом конечных элементов. В программе HFSS сетка 
генерируется адаптивно в зависимости от особенностей структуры и 
особенностей поля в ней.  

В HFSS версии 13 сделан большой шаг вперед по сравнению с 
предыдущими версиями программы, разработанными в фирме Ansoft. В ней 
выполнены модификации алгоритмов генерации сетки и алгоритмов расчета. 
Новый быстрый и устойчивый алгоритм TAU генерирует более 
качественную тетраэдральную сетку.   

Формирование системы уравнений, обеспечивающее смешанный 
порядок следования ее блоков, а также произвольная декомпозиция области 
решения,  позволяют реализовать в  HFSS возможности 
высокоэффективного расчета (High-Performance Computing HPC). 
Программа черчения трехмерной модели была улучшена операциями типа 
вставки и переноса  двумерных и трехмерных моделей (imprinting), а 
интерфейс был модифицирован для лучшего использования и 
автоматизации. 
     HFSS рассчитывает широкий спектр внешних параметров СВЧ устройств 
и антенн, к которым относятся электрические и магнитные поля, токи, S-
параметры, ближнее и дальнее поле, а также может рассчитать переходной 
процесс и временнЫе изменения электромагнитных полей [2-4] 

Разработчики могут быть уверены в точности HFSS при 
проектировании устройств, которые включают  внедряемые пассивные и 
активные  "чипы" и моделировать, таким образом, активные антенны, 
многослойные интегральные схемы СВЧ, ВЧ/СВЧ  компоненты и 
биомедицинские устройства (рис. В.1, В.2).  
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                    Новыми свойствами в  HFSS 13.0 являются:  

• Новый, устойчивый метод разбиения на тетраэдры;  
• Реализация криволинейных элементов; 
• Расчет производных изменения характеристик при варьировании 

переменных;  
• Чтение файлов ACIS R19. 2  (19 версии); 
• Улучшенная связь с программой ANSYS DesignXplorer; 
• Расчет переходного режима;  
• Реализация гибридного метода конечных элементов  и метода 

интегральных уравнений; 
• Интеграция с общей платформой ANSYS;  
• Многопроцессорное уплотнение сетки разбиения; 
• Улучшенная постпроцессорная обработка данных;  
• Вывод широкополосных характеристик исследуемых структур.  

 

 
Рис. В.1. Модель пятизвенного волноводного фильтра, с рассчитанным в 

комплексе ANSYS температурным распределением 
 
   Существенно также, что к программе  HFSS -13 прилагается ряд примеров, 
которые можно использовать в качестве шаблонов, и которые показывают 
новые возможности программы. 
     HFSS использует в качестве основного инструмента решения 
электродинамических задач метод конечных элементов.  В этом методе весь 
объем разбивается на тетраэдры, внутри которых поле представляется в виде 
объемных базисных функций с неизвестными коэффициентами, которые 
находятся из решения системы линейных уравнений. 

В HFSS версии 13  добавлен программный модуль HFSS-IE, 
реализующий  метод интегральных уравнений, который использует 
двумерные базисные функции, описывающие токи  на поверхностях, в том 
числе  объектов с конечной проводимостью, что позволяет описывать 
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диэлектрические и металлические объекты с потерями. Этот метод часто 
называется методом моментов (МОМ).  Модуль  HFSS-IE разработан для 
моделирования больших излучающих структур. Этим методом в HFSS 
можно выполнить: 
• расчет радиолокационного поперечника рассеяния (Radar Cross Section 
RCS); 
• расчет антенны, расположенной на большом объекте, например на 
автомобиле; 
• расчет коэффициента связи между удаленными антеннами; 
• расчет электромагнитной совместимости; 
• расчет многопортовых СВЧ структур и антенн. 

       Метод интегральных уравнений в силу особенностей формулировки 
граничной задачи рассчитывает поле в бесконечном пространстве [5,6]. 
Поэтому он не нуждается в поверхностях, моделирующих поглощение поля 
излучения: radiation boundary, perfectly matched layer и т.д. Это избавляет 
пользователя программы от необходимости окружать излучающий объект 
замкнутым воздушным объемом (box) с условиями излучения на 
поверхностях. Также появляется возможность расчета антенн, 
расположенных над поверхностью земли с конечной проводимостью.  

     Этот метод работает в  стандартном интерфейсе HFSS. Перечислим его 
особенности:  

• излучающие (открытые) объекты описываются без воздушного бокса; 

• имеется возможность анализировать объекты, содержащие бесконечные 
плоские структуры, в том числе бесконечные экраны и т.д.; 

• программа допускает использование дискретных источников возбуждения 
и источников в виде падающих плоских волн;  
• программа поддерживает расчет в диапазоне частот, задаваемый в виде 
дискретных точек и в режиме интерполяции;  

• программа производит расчет ближнего и дальнего полей; 

• для структур с большими электрическими размерами HFSS-IE использует 
методы сжатия разряженной  матрицы, ускоряющие вычислительный 
процесс; 

• возможно разделение модели на составные части, анализируемые с 
помощью различных методов расчета. 

В HFSS 13 легко реализуется вставка проектов разных типов друг в 
друга. Чтобы вставить проект HFSS или HFSS-IE достаточно кликнуть  Insert 
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HFSS Design  или  Insert HFSS-IE Design и новый проект появится в дереве 
проекта под именем HFSSDesignn или HFSS-IEDesignn, где  n - номер 
добавленного проекта в порядке его появления в общем проекте.      В проект 
можно включить больше, чем одну установку на решение. Причем можно 
задать методы решения HFSS или HFSS-IE, добавляя конструкции, 
анализируемые разными методами. Каждая установка решения включает 
следующую информацию: 

• общие данные о решении;  
• параметры уплотнения сетки разбиения, если нужно, чтобы сетка 

разбиения была уплотнена в областях с высокой скоростью изменения 
поля;  

• диапазон частот анализа. 

При решении задачи методом HFSS-IE можно выполнить импорт 
расчета, выполненного методом конечных элементов в задачу, которая будет 
решаться методом интегральных уравнений. Для этого можно 
импортировать рассчитанные в HFSS поля в дальней зоне Far Field Wave или 
в ближней зоне Near Field Wave.    В проект можно включить больше, чем 
одну установку на решение. Причем можно задать методы решения HFSS 
или HFSS-IE, добавляя конструкции, решаемые разными методами.  

 

Рис. В.2. Пространственная диаграмма направленности антенной решетки, 
элементами которой в HFSS-13 могут быть щелевые, вибраторные, 
спиральные, пач-антенны, антенны Вивальди и др. излучающие элементы 
 
        В HFSS-13  реализован новый вид порта - порт Флоке. Он используется 
при моделировании периодических структур. Применение этого порта 
разберем в следующей главе, в которой будет моделироваться бесконечная 
граница раздела двух диэлектрических сред.  
   Благодарим за плодотворные дискуссии, просмотр и обсуждение рукописи 
к.т.н., в.н.с. Мишустина Б.А. и к.т.н. Подковырина С.И. 
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1. Моделирование наноструктуры в оптическом диапазоне 
частот 

  
      При проектировании оптических приборов часто возникает задача 
оптимизации характеристик отражающих поверхностей [7,8]. В качестве 
перспективной отражающей поверхности в научных исследованиях и 
прикладных разработках используют периодическую структуру, состоящую 
из металлических конусов (см. рис. 1.1).  Такая структура считается 
перспективной для создания оптических усилителей, преобразователей 
частоты и других приборов. 
 

    
                         a)                                                                   б) 

 
в) 

Рис. 1.1. Схема a) и топология б) оптического усилителя, в) фрагмент 
модели наноструктуры, используемой для создания оптических усилителей 

 
Представленная на рис. 1.1 реализация отражающей поверхности не 

является единственно возможной. Используются также структуры с 
полусферическими и эллиптическими окончаниями, дисками и т.д. Во всех 
случаях перед системой электродинамического моделирования стоит задача 
расчета частотной характеристики коэффициента отражения от 
периодической структуры. 

Формулировка граничной задачи выглядит следующим образом: на 
бесконечную в плоскости XOY периодическую структуру падает из верхнего 
полупространства плоская волна. Требуется найти рассеянное структурой 
поле.  
 Естественным методом анализа бесконечных периодических структур 
является применение условий периодичности, которые сводят задачу для 
бесконечной структуры к анализу одного периода.  
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 Следует отметить, что анализ падения плоской волны на бесконечную 
периодическую структуру является достаточно новой задачей в практике 
применения таких программных средств как HFSS. Поэтому, прежде чем 
перейти непосредственно к расчету структуры показанной на рис. 1.1, 
целесообразно численно с помощью аппарата периодических граничных 
условий решить тестовую задачу и сравнить численное решение с 
аналитическим. В качестве тестовой структуры была выбрана граница 
раздела двух сред. Для нее известно строгое аналитическое решение в виде 
коэффициентов отражения и прохождения плоских волн [6, 7], которые 
будем сравнивать с численными результатами. 
 
Падение плоской волны на границу раздела двух сред. При падении плоской 
волны на поверхность раздела двух сред, её поляризация не меняется. Если 
вектор Е лежит в плоскости падения, то такая поляризация называется 
параллельной, если вектор E перпендикулярен плоскости падения – 
перпендикулярная поляризация. 

Для моделирования бесконечных периодических структур  в программе 
HFSS используются периодические граничные условия, которые 
устанавливаются на противоположных сторонах бокса, охватывающих 
период анализируемой структуры. Пример использования граничных 
условий этого типа показан на рис. 1.2. Верхний параллелепипед заполнен 
вакуумом с диэлектрической проницаемостью равной единице, нижний – 
диэлектриком с относительной проницаемостью 2.25. Размер бокса по осям 
0X  и  0Y равен в данном примере 320 нм. 

Бесконечная граница раздела двух сред, строго говоря, не является 
периодической структурой. Поэтому применение аппарата периодических 
граничных условий для ее анализа нуждается в пояснении.  
 Рассмотрим известное [6] представление поля внутри прямоугольного 
канала Флоке. Под каналом Флоке понимается часть пространства, 
ограниченная вертикальными стенками (см. рис. 1.2), на которых 
установлены периодические граничные условия. Для прямоугольного канала 
Флоке составляющие поля E, H при 0>z   имеют следующий вид 

       ∑∑ −−−=
n m

zyixi
mn

mnmneazyхE ,
,),,( γβκ

,   (1) 

 
где      yxL , – периоды повторения структуры по осям 0X и 0Y (рис.1.2),  

       xn Ln /20 πκκ += ,       ym Lm /20 πββ += ,    

       
222

, mnmn k βκγ −−= ,  mna , – амплитуды n, m гармоник, k  - 
волновое число свободного пространства.  
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 Постоянные 00,βκ  задаются падающим полем, которое имеет вид 
плоской волны: 
    ϕθκ cossin0 k= , 
    ϕθβ sinsin0 k= , 
θ  - меридиональный угол падения плоской волны, а ϕ  - азимутальный угол.  
 Ряд (1) называется в теории периодических структур разложением поля 
по гармоникам Флоке, каждая из которых является членом ряда (1). Можно 
увидеть, что гармоника Флоке с нулевыми индексами 0== mn , которую 
часто называют основной гармоникой, имеет структуру поля, совпадающую 
с полем падающей волны. Так как мы рассматриваем полупространство при 

0>z , то эта гармоника описывает поле отраженной волны.  
 Можно записать разложение аналогичное (1) для полупространства при 

0<z . Основная гармоника в этом разложении будет соответствовать 
прошедшей (преломленной) волне.  
 Гармоники высших порядков необходимы для описания ближнего 
поля, которое возбуждается, если период имеет сложную структуру, 
например, показанную на рис. 1.1 б, в. В случае плоской поверхности вид 
решения электродинамической задачи известен [2,6,7]. Поле описывается 
отраженной и преломленной волнами. Высшие гармоники Флоке не 
возбуждаются.  
 Таким образом, применение периодических граничных условий для 
анализа границы раздела двух сред оправданно тем, что отраженная и 
преломленная волны описываются основными гармониками Флоке, а 
гармоники высших порядков не возбуждаются.  
  

               
 
Рис. 1.2. Фрагмент диэлектрической подложки, на которую падает плоская 

волна.  
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    Интересно отметить, что поле основной гармоники не зависит от периодов 
yxL , . Поэтому при решении тестовой задачи размеры отдельных ячеек 

можно выбирать произвольным образом, так как зависящие от величины 
периодов гармоники Флоке высших порядков, как отмечалось выше, не 
возбуждаются. 
 
Решение задачи о падении плоской волны с помощью HFSS. Рассмотрим 
далее решение тестовой задачи о падении плоской волны на границу раздела 
двух сред с помощью HFSS. 

Командой  Modeler->Units выведем диалог, показанный на рис. 1.3, в 
котором зададим единицу измерения длины - нанометр (nm).  

 
Рис. 1.3. Установка единиц размеров структуры 

 
   Начертим бокс размером 320 nm x 320 нм и высотой 200 нм командой  
Draw->Box (рис. 1.4). Размеры бокса в плоскости XOY несущественны. Мы 
выбрали их равными периодам структуры, изображенной на рис. 1.1. 
Создаваемый бокс расположен в нижнем полупространстве и заполнен 
материалом с диэлектрической проницаемостью отличной от единицы. 
 

 
Рис. 1.4. Черчение бокса - фрагмента диэлектрической плоскости 

 
Зададим материал,добавляя в проект диэлектрик c ε=2.25, нажимая на 

кнопку Add Material (рис. 1.5). 
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Рис.  1.5. Добавление диэлектрика с проницаемостью 2.25 в проект 

 
Аналогично зададим сверху этого бокса, бокс размером 320 нм x  320 

нм и высотой 800 нм. Данный бокс не имеет диэлектрического заполнения. 
Нажмем далее клавишу F, чтобы перевести объект в режим выделения 

сторон и установим на вертикальных сторонах верхнего и нижнего боксов 
периодические граничные условия Master и Slave (рис.1.6). 

            
Рис. 1.6. Постановка периодических граничных условий на стороны боксов 

 
Таким образом, в структуре будут присутствовать 4 пары поверхностей 

типа Master-Slave. 
Для решения граничной задачи в системе HFSS на горизонтальных 

поверхностях, ограничивающих канал Флоке по вертикали необходимо 
установить порты, которые получили название портов Флоке. Для установки 
порта Флоке выделим нижнюю поверхность нижнего бокса и зададим 
команду Assign Exitation -> Floquet Port, по которой вызывается диалог 
рис. 1.7.  
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Рис. 1.7. Установка портов Флоке на нижнюю и верхнюю сторону 

 
        Параметры порта задаются в диалоге, показанном на рис. 1.8. Данный 
диалог позволяет работать с многомодовыми портами Флоке. Поэтому в нем 
имеется возможность задания номера гармоники, которая используется для 
определения параметров порта. Мы работаем с двухмодовыми портами 
Флоке. Такой режим соответствует каналу Флоке с двумя 
распространяющимися гармониками. Обе они имеют индексы n=0,  m=0, 
которые мы установим в данном диалоге. Отличие между двумя 
распространяющимися гармониками Флоке состоит в разной их 
поляризации. В нашем случае мы имеем волны с параллельной и 
перпендикулярной поляризациями. В терминологии, принятой в HFSS эти 
две волны обозначены как волны TM и TE. Поэтому в строке число волн 
(number of modes) ставим цифру 2 (две волны),   а в качестве мод выберем 
волны TM (H) и TE (E). 
 

 
Рис. 1.8. Установка параметров порта Флоке при решении задачи 

 
В HFSS порты Флоке можно ставить только на изотропную среду с 

диэлектрической проницаемостью равной единице. Поэтому установить 
порт непосредственно на нижней поверхности диэлектрика мы не можем. 
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Нам необходимо создать некоторый воздушный зазор между средой и 
портом. 

Если между нижним портом Флоке и диэлектрической средой остается 
зазор (рис. 1.7), то в расчет вносится погрешность из-за отражения волн от 
новой границы раздела. Необходимость создания такого зазора можно 
считать недостатком программы HFSS.  

Для того, чтобы такое вторичное отражение исключить, ставим снизу 
вместо порта поглощающую границу Radiate, соприкасающуюся с нижней 
стороной диэлектрической платы. При этом мы теряем возможность расчета 
коэффициента прохождения через структуру, так как порт в нижней части 
канала Флоке заменяется указанной границей. Тем не менее, возможность 
расчета коэффициента отражения сохраняется. 

Плоская падающая волна задается командой Assign Exitation -> 
Incident Wave ->Plane Wave. По этой команде появляется диалог рис. 1.9, 
на закладке General Data которой установим координаты точки, в которой 
падающая волна имеет нулевую фазу. 

 

 
Рис. 1.9. Закладка General диалога падающей волны 

 
Угол падения связан с углом направления Eo, что задается в виде 

координат векторов k(-sin(Teta),0, sin(Teta)),  Eo(-
cos(Teta),0,sin(Teta)), которые устанавливаются в диалоге Incident Wave 
Source (рис. 1.10). Teta – переменная, которая задает угол падения волны. 
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Рис. 1.10. Параметризация угла падения плоской волны: вектора 

распространения k  и вектора электрического поля E.  
 

Чтобы рассчитать характеристики отражения и преломления падающей 
волны под разными углами падения, будем изменять угол падения плоской 
волны Θ  в плоскости ZОX (φ=0) в диапазоне 0…90°.  

Это выполняется с помощью параметрического анализа. Командой 
Optimetric->Add->Parametric  выведем диалог (рис. 1.11) задания 
параметров параметрического анализа (перебора параметра Teta от 0° до 90° 
через 10°). 

 
Рис. 1.11. Задание параметрического анализа при изменении угла падения 

 
В результате такого анализа получаем характеристики поля, картины 

поля, углы отражения и преломления электромагнитных волн для различных 
углов падения. 

Известны аналитические зависимости для коэффициента отражения и 
прохождения (передачи) при падении волны на границу раздела двух сред, 
т.е. при условии, что толщина платы стремится к бесконечности. 
Коэффициент отражения по полю для волны с параллельной поляризацией 
(рис. 1.12) равен [7] 
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где ε - диэлектрическая проницаемость среды, на которую падает волна, Θ - 
угол падения. Для частного случая перпендикулярного падения волны 
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Коэффициент передачи поля для волны с параллельной поляризацией 
равен 

                         θεθε
θε

2sincos
cos2
−+

=T      (3). 

 
В силу отмеченных особенностей HFSS, не позволяющих установить 

порт Флоке на поверхность с диэлектрической проницаемостью отличной от 
единицы нам приходится ограничить толщину диэлектрического слоя d  и 
установить порт Флоке на поверхности отделенной от нижней поверхности 
слоя небольшим зазором (ср. с [14,15]). В этом случае формулы (2) и (3) 
непосредственно для сравнения с расчетными данными использовать нельзя. 
Их необходимо модифицировать с учетом второй границы диэлектрического 
слоя. Такую модификацию нетрудно выполнить, используя соотношения (2) 
и (3). В результате получаем следующие выражения для коэффициентов 
отражения и прохождения плоской волны ss TR ,  через слой: 
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                       θεγ 2sin−= , 
 
где d- толщина диэлектрического слоя, λπ /2=k  - волновое число 
свободного пространства. В формулах (4)  TR,  - коэффициенты отражения 
и прохождения через границу раздела двух сред для волн обеих 
поляризаций. Например, для волны параллельной поляризации в качестве 

TR,  надо взять параметры TR ,  (2), (3). 
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Расчеты, выполненные на HFSS и характеристики, рассчитанные по 
формулам (4), сравниваются на рис. 1.12. Кривые на рис. 1.12 построены для 
разных значений толщины слоя d =100, 200 и 300 нм. Точками показаны 
данные полученные с помощью HFSS, а сплошными кривыми по формулам 
(4). Видно, что расчетные и теоретические результаты хорошо совпадают. 

 
 
Рис. 1.12. Рассчитанный на HFSS коэффициент отражения в диапазоне 

углов падения для разных толщин подложки 
 

Поэтому мы можем сделать вывод, что для моделирования падения 
электромагнитных волн оптического диапазона на металлические 
поверхности со сложной структурой можно использовать метод конечных 
элементов, реализованный в HFSS.  

 
Рис. 1.13. Коэффициент отражения падающей плоской волны с 

вертикальной поляризацией 
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Убедившись, что численные расчеты совпадают с теоретическими 
результатами, можно выполнить моделирование поверхности, состоящей из 
конических металлических наноструктур, используемых для усиления 
люминесценции в оптическом усилителе (рис. 1.13).    

      Серебряные поверхности с расположенной на них системой 
наноразмерных острий, используется для усиления люминисценции 
адсорбированных сред с ионами редкоземельных элементов, обусловленного 
плазмонами. С помощью HFSS-13 можно получить параметры таких систем, 
широко используемых в настоящее время в волоконно-оптических 
усилителях для длины волны 1.54 микрона.    
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2. Волноводная антенная решетка 
 
 

Выполним моделирование волноводной антенной решетки [1,13]. Ее 
излучающая апертура состоит из открытых концов квадратных волноводов 
(рис. 2.1). Считаем, что ось 0z направлена вдоль осей волноводов. Плоскость 
z=0 совпадает с апертурой решетки. 

Последовательность работы будет следующая: 
• создание отдельного излучателя в виде отрезка квадратного 

волновода;  
• создание бокса, расположенного сверху излучателя; 
• задание граничных условий  PerfectE на стенках волновода; 
• задание порта Флоке на торцевой поверхности бокса; 
• задание волноводного порта; 
• установки анализа на частоте 300 МГц; 
• запуск на расчет; 
• вывод характеристик. 

 
Рис. 2.1. Геометрия антенной решетки 

 
Геометрия антенной решетки показана на рис. 2.1. Рассматриваем 

модель в виде бесконечной решетки. Волноводные порты находятся в 
области 0<z  и имеют вид квадратных волноводных портов (рис. 2.2) с 
основной волной линейной поляризации. Направление вектора 
электрического поля этой волны показано на рис. 2.1 в виде стрелок. 
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Рис. 2.2. Модель HFSS одного элемента антенной решетки с 
координатными векторами 

      
Анализ бесконечной решетки можно свести к  анализу одного периода 

благодаря теореме Флоке, упоминавшейся в главе 1. Отметим, что для 
бесконечной решетки понятие диаграммы направленности (ДН) не может 
быть корректно определено, так как оно вводится только для источников 
излучения с конечными размерами. Строго говоря, ДН бесконечной решетки 
описывается дельта – функцией и физического смысла не имеет. Тем не 
менее, существуют приближенные приемы, позволяющие использовать 
результаты анализа бесконечной структуры для оценки ДН конечной 
решетки. О них будем говорить ниже. Непосредственно анализ бесконечной 
решетки позволяет судить о решении задачи ее согласования со свободным 
пространством. 

На рис. 2.2 показана геометрия одной ячейки бесконечной антенной 
решетки. Модель состоит из двух областей. Нижняя часть представляет 
волновод, и сверху его расположен воздушный бокс. На вертикальных 
гранях бокса устанавливаются периодические граничные условия. На 
верхней поверхности бокса задается порт Флоке. 

 
Создание модели отдельного излучателя. Чтобы создать отдельную ячейку 
антенной решетки необходимо выполнить следующие действия: 
 
1. Откройте проект и дайте ему имя  AGW. 
2. Командой  Draw>Box создайте произвольный бокс, и затем 
отредактируйте его параметры в разделе Edit>Properties (рис.2.3) 
3. Выберите созданный бокс и отредактируйте его прозрачность (параметр 
визуализации создаваемого объекта) Transparency = 0.8. 
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Рис. 2.3.Параметры волновода Рис. 2.4.Параметры воздушного 
бокса 

 
4. Операцией  Draw>Box создайте второй бокс и отредактируйте его 
размеры и свойства Edit>Properties (рис. 2.4). 
 
   Задание границ Master и Slave.  
 
1. Нажмите на клавишу F, переводя HFSS в режим выбора поверхности, 

выделите боковую сторону верхнего бокса и задайте команду  
HFSS>Boundaries>Assign>Master.  Появляется диалог границы Master. 

 
2. Оставьте имя по умолчанию как Master1. 
  
3. Кликните в выплывающем меню U vector, и кликните New Vector. 

Появляется диалог Measure и появляется Create Line. 
 
4. Задайте вектор  U координатной системы в месте, показанном на 

поверхности на рис. 2.2. Кликните нижний правый угол (начальная 
точка), и протащите курсор к левому углу (конечная точка) и кликните. 

 
5. Кликните  OK, чтобы закрыть диалог. 
 
6. Выберите противоположную фаску и вызовите ведомое граничное условие 

HFSS>Boundaries>Assign Slave... Появляется диалог Slave с выбранной 
закладкой General (рис. 2.5). 

 
7. Выберите Master1 как ведущую  границу Master. 
 
8. Начертите вектор U Vector как показано на рис. 2.5. 
 
9. Выберите режим Reverse direction для вектора V. 
 
10. Оставьте неизменными другие установки и нажмите OK. 
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Рис. 2.5. Диалог задания разности фаз между границами Master и Slave 

 
 
11. Повторите эту процедуру для границ Master2 и Slave 2, как показано на 
рис. 2.6. Для вектора V на границе Master2  нужно установить обратное 
направление (Reverse direction). 

         
Рис. 2.6. Границы Master и  Slave устанавливаемые на противоположные 

грани воздушного бокса модели антенны 
 

В диалоге на рис. 2.5 имеются две опции установки задержки фазы 
между границами Master - Slave: по углам сканирования Scan Angle и по 
задержке фазы Input Phase Delay. 
 
Задание волноводного порта. Отрезок волновода содержит 4 стороны, на 
которых нужно задать граничные условия PerfectE. Это будет 
соответствовать тому, что стороны металлические. Удерживая клавишу Ctrl, 
выделим 4 стороны нижнего бокса и зададим их как  идеальные 
электрические стенки командой Assign Boundarys -> Perfect E. 
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Рис.  2.7. Задание границы идеальной проводимости на стенках волновода 
     
     Чтобы задать волноводный порт: 
 
1.  Выберите нижнюю грань нижнего бокса (рис. 2.8). 
 
2. Нажмите правой кнопкой мыши и из выплывающего меню выберите 
Assign>Excitations>WavePort. Появляется ассистент WavePort. 
 
3.  Установите в нем количество мод равное 2. 
 

        

Рис. 2.8. Задание интегральных линий квадратного волноводного порта 
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5. В разделе Integration Line выберите New  line и начертите две взаимно 
перпендикулярные интегральные линии для каждой моды, как показано на 
рис. 2.5. 
6. Оставьте другие установки, используя команду Next для перехода  к 
   другой странице и кликните OK.  Заданный волноводный порт появляется 
в списке   Excitation. 
 Отметим, что выбор двух мод в порту обусловлен тем, что квадратный 
волновод является двухмодовым волноводом, в котором существуют две 
распространяющиеся волны, отличающиеся поляризацией поля. Задание 
интегральных линий показывает, что мы в качестве волн в порту используем 
волны двух ортогональных линейных поляризаций. 
 
Установка портов Флоке. На верхней грани верхнего бокса 
устанавливается порт Флоке. В отличие от граничного условия излучения и 
PML этот порт позволяет рассчитать и вывести значение коэффициента 
передачи S21 из волноводного порта в порт Флоке. 
 
     Для установки порта Флоке надо выполнить следующие действия: 
 
1. Выделите верхнюю грань верхнего бокса. 
2. Нажмите правой кнопкой мыши и выберите Assign>Excitation>Floquet 
Port из выплывающего меню. Появляется ассистент порта Флоке (рис. 2.9). 
 

 
 

Рис. 2.9. Выбор направлений веркторов согласования портов Флоке 
 
3.  В разделе Lattice Coordinate System определяются направления A и B 
порта Флоке. 
 
4. Щелкните Next, принимая Phase Delay по умолчанию, и снова Next для 
перехода к странице установке мод порта Флоке Modes Setup (рис. 2.10). 

По умолчанию диалог параметров мод Флоке включает две моды порта 
Флоке. Моды Флоке определяются двумя индексами mn,  и поляризацией 
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Polarisation State.  Индексы mn,  можно понять из формулы (1) в главе 1. 
Основная мода Флоке имеет нулевые индексы. Эта мода (волна) 
распространяется при любых, сколь угодно малых, периодах решетки. Если 
период решетки достаточно велик, то появляются распространяющиеся 
волны с ненулевыми индексами. Каждой паре индексов mn,  соответствуют 
две волны, отличающиеся поляризацией. 

 

 
Рис. 2.10. Выбор характеристик каналов Флоке 

 
Последний столбец таблицы мод маркируется "Attenuation 

(Затухание)".    Это - затухание моды вдоль направления, нормального к 
плоскости решетки в дБ на единицу длины. Значения для зеркальных мод 
составляет 0 дБ, так как они распространяются в свободном пространстве и 
поэтому не ослабляются. Данный параметр не задается, а рассчитывается 
программой. 

Моды высших типов могут быть как распространяющимися, так и 
затухающими. Режим их распространения зависит от угла сканирования. 
Возможны ситуации, в которых при малых углах сканирования мода 
высшего порядка затухает, а при увеличении угла она становится 
распространяющейся. Если периоды решетки меньше половины длины 
волны в свободном пространстве, то при любых углах сканирования 
распространяются только две основные моды. В нашем случае периоды 
больше половины длины волны. Поэтому при больших углах сканирования в 
дополнение к основным модам должны появляться распространяющиеся 
моды с ненулевыми индексами. 
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Рис. 2.11. Задание углов сканирования, от диапазона  которых зависит 

количество задаваемых мод в портах Флоке 
 

Нажмите на кнопку Modes Calculator (рис.2.12). Данный диалог 
необходим для расчета параметров мод Флоке и правильного выбора числа 
мод, необходимых для корректного описания порта. В появившемся диалоге 
нужно поставить углы, по которым будет выполняться сканирование луча в 
антенной решетке. Выше отмечалось, что наша решетка при больших углах 
сканирования может функционировать в многомодовом режиме. Рассчитаем 
параметры десяти мод (рис. 2.12), установив 10 в разделе Number of Modes. 

       
Рис. 2.12. Установленные моды в портах Флоке 
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5. В закладке Post Processing задается положение отсчетной плоскости. 
 

Установка отсчетных плоскостей используется, когда пользователя 
интересует фаза параметра рассеяния. По умолчанию отсчетная плоскость 
находится в плоскости волнового порта. Операция de-embeding позволяет 
изменить положение отсчетной плоскости. Данное изменение влияет только 
на фазы параметров рассеяния и не влияет на их модули.  
6. В закладке 3D Refinement можно моды Флоке, которые участвуют в 
адаптивном измельчении 3-D сетки.     

Сетка разбиения, которая создается HFSS на последующих шагах 
адаптации, является фактически компромиссной для одновременного 
анализа всех мод  одновременно. 
7. Примите другие настройки по умолчанию, и нажмите OK, чтобы закрыть 
мастер портов Флоке.  Порт Флоке появляется в дереве проекта в разделе 
Excitation. 

 
Зададим углы сканирования как переменные проекта, для чего: 

 
1. В меню задайте команду  Project>Project Variables. Это вызовет окно 
Properties для этого проекта (рис. 2.13). 
2. Кликните кнопку Add. Это вызовет диалог Add Property. 
 

 
Рис. 2.13. Диалог переменных проекта 

       
3. Установите имя переменной  $phi_scan, и ее величину 0 deg. Эта 
переменная будет использоваться в качестве азимутального угла. 
4. Кликните OK. Теперь переменная $phi_scan  будет добавлена  в окно 
проекта Properties. 
5. Кликните кнопку Add чтобы показать снова диалог Add Property. 
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6. Установите  имя переменной, описывающей угол места name = $theta_scan 
и его величину  0 deg. 
7. Кликните OK. Диалог Add Property закрывается и добавляется 
переменная проекта $theta_scan. 
8. Кликните OK, чтобы закрыть окно проекта Properties. 
 

Нужно заметить, что при использовании углов сканирования в моделях 
элементарной ячейки, плоскость периодичности (здесь плоскость антенной 
решетки) должна быть параллельной плоскости XOY в глобальной системе 
координат. 
 
Установки на решение. Чтобы сделать установки на анализ выполните 
следующие операции: 
 
1. Нажмите правой кнопкой мыши на  Analysis в дереве проекта и выберите  
Add Solution Setup. Откроется диалог Solution Setup (рис.2.14). 
2. В закладке General, установите частоту решения Solution frequency = 
299.79 Mhz, Maximum Number of Passes = 5, и Maximum Delta S = 0.02. 
 

        
Рис. 2.14. Диалог установки на решение 

 
3. В закладке Options, отметьте режим Do Lamda Refinement и установите 
опцию Lambda = Use Default. 
4. Установите Maximum Refinement Per Pass = 30%,  
                         Minimum Number of Passes = 5, и  
                         Minimum Converged Passes = 2. 
5. Выберите базовые функции Order Basis function: First Order, и кликните  
OK. 
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Запуск расчета и просмотр результатов. Запустите расчет командой 
HFSS>Analyze. После завершения, нажмите на иконку Results  и выберите 
Solution Data. 

На рис. 2.15 показано окно с матрицей рассеяния, которое появляется 
после завершения расчета. Отметим следующее. 
 
• S-матрица имеет размерность 6×6 с учетом 2-х мод портов Флоке.  
 
• Моды Флоке в этой S-матрице перечисляются в порядке, заданном в 
панели установки порта Флоке. При обращении к этой панели, мы, таким 
образом, имеем в виду, что 
 
           FloquetPort1:1 относится к моде Флоке TE00 и 
           FloquetPort1:2 относится к моде Флоке  TM00. 
 

 
Рис. 2.15. Диалог данных решения Solution Data 

 
• Столбцы и строки в матрице на рис. 2.15 соответствуют стандартному 
определению матрицы рассеяния. Столбцы соответствуют волнам, 
падающим на разные порты, а строки - волнам отраженным от разных 
портов. Например, первый столбец матрицы соответствует возбуждению 
падающей волной волнового порта 1. Элементы этого столбца равны 
амплитудам волн отраженных от разных портов в режиме, когда 
возбуждается только один волновой порт 1.  Возбуждение волнового порта 
соответствует работе решетки на передачу.   

 
• Столбцы, соответствующие портам Флоке описывают параметры решетки 
в приемном режиме.  
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Параметрическое свипирование угла сканирования. Чтобы показать 
возможности порта Флоке, рассчитаем зависимость  коэффициента 
отражения решетки по волновому порту, как функцию угла сканирования. 
Когда сканирование происходит в E-плоскости решетки, при угле 27.5° 
наблюдается эффект ослепления. Чтобы показать это, нужно найти 
характеристики в E-плоскости при изменении угла сканирования от scan = 0 o 
до scan = 90o. 
 
              Чтобы выполнить такой параметрический анализ: 
 
1. Нажмите на Optimetrics в дереве проекта и выберите Add Parametric. 
Это выводит диалог Setup Sweep Analsysis с закладкой Sweep Definitions. 
2. Кликните кнопку Add. Это выводит диалог Add/Edit Sweep. 
3. Из выплывающего меню Variable, выберите  $theta_scan. 
4. Выберите Linear step. 
5. Установите Start=0 deg, Stop=90 deg, и Step = 3 deg (рис. 2.17). 
 

 
 

 

Рис.   2.17. Задание диапазона 
изменение угла Theta в 

параметрической оптимизации 

Рис. 2.18. Выбор опции сохранения 
поля и сетки разбиения при 
выполнении параметрической 

оптимизации 
 
 
6. Кликните кнопку  Add  и  OK, чтобы закрыть диалог Add/Edit Sweep. 
Диалог Setup Sweep Analysis включает переменную $theta_scan. 
7. Откройте закладку General и убедитесь, что в Sim Setup установлен 
режим  Setup1 with the Include. 
8.  Откройте закладку Options чтобы убедиться, что опции Save Fields and 
Mesh отмечены, и что опция Copy Geometrically Equivalent Meshes (рис. 
2.18) не отмечена. В этом случае  на каждом шаге параметрического анализа 
будут сохраняться характеристики дальнего поля. 
 
9. Кликните OK. В разделе Optimetrics появляется установка Parametric. 
 
    Текущая пара основных мод, достаточных для описания нормального 
падения волны, должна быть дополнена модами высших типов для описания 
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решетки при больших углах сканирования.  Подготовка мод для 
параметрического свипирования состоит из следующих шагов: 
 
1. Повторно войдите в панель установки порта Флоке и щелкните по вкладке 
типов волн. Для того, чтобы определить список мод, нужных для 
моделировании при всех углах сканирования, используем калькулятор мод. 
2. Вызовите калькулятор мод, щелкая по кнопке Modes Calculator. 

Расчет калькулятора является дополнительной информацией, для 
создания списка рекомендуемых мод  для порта Флоке. Его результаты 
нужны для выбора числа мод и не влияют на расчетную модель решетки.  
3. Выберите 10 мод для порта (с запасом). Вероятно, мы уменьшим это 
число, но для этого требуется дополнительное исследование. 
4. Установите частоту 299.97 MHz, на которой будет выполняться 
моделирование. Если установки задачи содержат  две или больше частот 
свипирования, обычно выбирается наивысшая частота для того, чтобы 
обнаружить появление распространяющихся мод высоких порядков.  
5. Чтобы установить набор типов волн, который будет достаточным для 
каждого направления сканирования в параметрической развертке, углы 
сканирования развертки вводятся в формате "start-stop-step". Вводимые углы 
- сферические полярные углы в глобальной системе координат. 

Для данного случая угол Phi = 90°, так что введите это значение как 
стартовое значение и конечное значение в полях Phi. Угол сканирования 
Theta в развертке меняется от 0 до 90° с шагом 0.5°, так что введите эти те 
же самые значения в полях калькулятора Theta. 
6. Нажмите OK, чтобы запустить на расчет калькулятор и просмотреть 
рекомендуемый список мод (как на рис. 2.12). 

 
Рис. 2.20. Характеристики сканирования отражения и прохождения 

характеристик типов волн 
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Отметим следующее: 

 
• Исходная пара основных мод TE00 и TM00 остается сверху таблицы мод 
Флоке (рис. 2.12). Затухание их равно нулю, что означает, что эти моды 
распространяются без ослабления, то есть являются распространяющимися. 
• Затем в таблице идет вторая пара мод TE01 и TM01. Они распространяются 
без затухания, по крайней мере, в одном направлении. 
• Затем следуют шесть мод с минимальным затуханием 60 дБ/м. Эти моды не 
распространяются ни в одном из выбранных направлений. 

Теперь нужно сделать окончательный выбор числа мод, учитываемых в 
порту Флоке. Этот выбор основан на следующих соображениях. Любые 
моды Флоке, распространяющиеся хотя бы в одном направлении должны 
быть учтены в таблице мод. Поэтому в нее нужно включить первые четыре 
моды, которые достигнут порта Флоке неослабленными. 

Оставшиеся типы волн, имеющие ненулевое затухание, являются 
кандидатами на исключение из таблицы.  С точки зрения эффективности 
моделирования и интерпретации результатов лучше их удалить.   

В связи с этим отметим:  
Поскольку длина элементарной ячейки составляет 1.25 м, любая из 

последних шести мод, при возбуждении в прямоугольной апертуре, 
достигнет порт Флоке с затуханием равным 1.25 * 60.00 = 75 дБ, то есть 
очень сильно ослабленной. Поэтому в большинстве случаев такими модами 
при описании порта Флоке можно пренебречь. 
7. Таким образом, введем число мод в поле Number of Modes = 4. В списке 
мод остаются только моды TE00, TM00, TE01, и TM01. 
8. Кликните OK, чтобы выбрать этот набор мод и затем запустите 
параметрический анализ (это займет определенного время расчета). 
 
         Просмотр результатов параметрического анализа.  
 

Как только моделирование закончено, элементы S-матрицы как 
функции угла сканирования можно видеть в закладке Matrix Data или на 
графике. Анализируя матрицу рассеяния для разных углов сканирования, 
можно видеть, что связи между типами волн TE00 и TE01 очень маленькие. 
     
   Чтобы вывести зависимости модулей коэффициентов отражения и 
передачи ТМ, как функций угла сканирования выполните следующие 
действия: 
 
1. Кликните правой кнопкой на Results в дереве проекта, и выберите  Create 
Modal Solution Data Report>Rectangular Plot.   Появляется диалог Report. 
2. В закладке Trace, в разделе X выберите $theta_scan. 
3. Для  Y выберите S Parameter как Category, S(Wave Port1:1) как 
характеристику (Quantity) и модуль Mag как Function.  
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4. Кликните OK чтобы создать новый график.  Новый отчет выводится на 
экран и добавляется под именем Result в дереве проекта с первой 
трассировкой, приведенной под графиком. Кнопка Add Trace становится 
активной  в диалоге Reports. 
5.  Выберите имя характеристики в дереве проекта. Это выводит окно 
    свойств для Trace. 
6. Отметьте опцию Specify Name чтобы открыть поле Name и измените имя 
    на Reflection. Этим будет изменяться имя на характеристике. 
7. Добавьте два дополнительных графика и измените их имена: 
    mag(S(WavePort1:1, FloquetPort1:2)) соответствует TM00 Transmission; 
    mag(S(WavePort1:1,FloquetPort1:4)) соответствует  TM01 Transmission. 
8. В дереве проекта выберите X Y Plot 1.  Это показывает свойства Properties 
    для графика. 
9. Отредактируйте поля Name  на Reflection и Transmission и нажмите Enter. 
      

Результаты параметрического анализа представлены на рис. 2.20. 
Заметим, что коэффициент отражения стремится к единице при угле 27.5°. 
Этот эффект получил название эффекта ослепления, поскольку в 
окрестности угла ослепления эффективность решетки резко падает, т.к. вся 
энергия, поступившая на волновой порт не излучается в пространство, 
отражается. 

Также отметим, что тип волна TM01 становится распространяющейся 
приблизительно при угле 30°. Об этом говорит резкий рост коэффициента 
передачи из волнового порта в волну ТМ01 порта Флоке при углах больших 
30°. 

В данном примере рассмотрены вопросы согласования: коэффициент 
отражения решетки. В следующем разделе будут рассматриваться и  
характеристики излучения антенной решетки.  
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3. Антенная решетка из антенн Вивальди 

 
 
 

Выполним расчет антенной решетки, составленной из элементарных 
излучателей, каждый из которых представляет собой широкополосную 
антенну Вивальди.  Решетка из антенн Вивальди создается, используя 
периодические граничные условия и порты Флоке. 

Антенна питается коаксиальной линией с волноводным портом. На 
верхней поверхности ячейки антенной решетки  устанавливается порт Флоке 
(см. рис. 3.1). На боковых сторонах ячейки вводятся периодические 
граничные условия. При этом противоположные и параллельные друг другу 
стороны объявляются границами  Master и Slave. Подложка имеет 
диэлектрическую проницаемость εr = 6 и толщину 1.27 mm. Полосковые 
проводники являются 2D объектами с граничными условиями PerE. Расчет 
выполняется на частоте 4.5 ГГц и в режиме интерполяции в диапазоне 2 … 5 
ГГц.      
    

 
Рис. 3.1.  Интерфейс HFSS c отдельной антенной Вивальди 

 
 

3.1. Черчение антенны Вивальди 
 

Установим единицы измерения длины – миллиметры и начертим 
диэлектрическую плату в виде параллелепипеда размером 34 x 60 x 1.27 мм 
(рис. 3.2) командой Create -> Box. 
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Рис. 3.2. Размеры  антенны Вивальди, являющейся элементом антенной 

решетки 
 

Внесем диэлектрик в раздел переменных и зададим проницаемость 
параллелепипеда равной 4.  Параметры параллелепипеда можно 
отредактировать в диалоге рис. 3.3. 
 

 
Рис.  3.3. Размер подложки с проницаемостью 6  и толщиной 1.27 мм  
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Антенна Вивальди работает в большой полосе частот, и наибольшая 

широкополосность достигается при экспоненциальном изменении щели от 
начала рупора к растру. 

Начертим  проводники антенны Вивальди, используя функциональные 
зависимости. Черчение линии, которая задается в виде функции, 
выполняется по команде Geometry -> Curve -> Analitic Curve. Появляется 
диалог рис. 3.4, в который введем функциональную зависимость координат 
точек на ребре полоскового проводника от переменной t. Координата Z 
зависит от переменной t линейно. Поэтому зависимость координаты Y от t 
можно рассматривать, как зависимость от координаты Z. 
 

 
Рис.3.4. Задание функций, по которым чертится кривая 

 
Используем для задания формы кромки проводника 

экспоненциальную функцию:  
 
                      X(t)=0, 
                      Y(t)=0.25*exp(0.123*t), 
                      Z(t)=t. 
 

Ширина зазора между проводниками в самом узком месте при t=0 
равна 0.5 мм. Переменная  t меняется от 0 до 33.3 (рис. 3.4). Функциональная 
зависимость задается в 24 точках. 

Теперь дополним экспоненциальные кривые прямыми линиями  и 
окружностью, которые играют роль симметрирующего устройства системы 
питания антенны Вивальди (рис. 3.7). 
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Рис. 3.5. Топология и размеры симметрирующего резонатора 

 
Далее начертим окружность, играющую роль резонатора 

симметрирующего устройства антенны Вивальди  (рис. 3.5). 
 

 
Рис.  3.6. Параметры круглого резонатора, который является частью 

симметрирующего устройства 
 

Теперь начертим прямоугольник, который сформирует щелевую 
линию связывающую резонатор и коаксиальную линию (рис. 3.7). 
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Рис. 3.7. Черчение прямоугольника для создания щелевой линии 

 
После подготовки к черчению сложной формы, которая включает 

окружность, экспоненциальную линию, и все поверхности будущей антенны 
Вивальди, зададим команду Draw-> Line и выполним захват одной точки 
экспоненциальной кривой. Когда дойдем до точки, в которой нужно сделать 
переход на окружность, переведем режим черчения в  Center Point Arc 
(рис.3.8) 
 

 
 
Рис. 3.8. Переход из режима черчения отрезков линий (Straight) в режим 

черчения окружности с помощью центра и радиуса. 
 

Теперь нужно объединить экспоненциальный отрезок с ломаной 
линией командой Unite. Далее из замкнутой формы создадим плоскость 
командой Modeler -> Surface -> Cover Line.   



 38

 
Рис. 3.9.  Полосковый проводник антенны Вивальди с симметрирующим 

устройством 
 
     Далее выделим экспоненциальный отрезок и развернем его на 180°, 
просто переменой знака координаты  Y(t) (рис. 3.10). 

 
Рис. 3.10. Черчение второго полоскового проводника 

 
Возбудить антенну Вивальди можно разными способами. Можно, 

например, поставить дискретный порт между вибраторами антенны. А 
можно включить в структуру реальный отрезок коаксиальной линии, на вход 
которой включается СВЧ генератор. Начертим внутреннюю жилу 
коаксиальной линии в виде цилиндра длиной 8 мм.  Черчение коаксиальной 
линии выполняется командой Draw->Cilinder, по которой появляется диалог 
(рис. 3.11). 
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Рис.  3.11. Параметры внутреннего  провода коаксиальной линии радиусом 

0.375 мм длинной 8 мм 
 

Далее начертим внешнюю оболочку коаксиальной линии, также 
командой Draw->Cilinder, и зададим параметры, показанные на рис. 3.12. 
На эту внешнюю оболочку устанавливается граничное условие Perfect E. 
 

 
 
Рис. 3.12. Черчение внешнего цилиндра outer, на его верхней поверхности 

автоматически устанавливается условие Perfect E 
 

Далее начертим бокс излучения, окружающий антенну Вивальди,  
командой Draw -> Box и установим его размеры, показанные на рис. 3.13. 
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Рис.  3.13. Задание размеров бокса, окружающего антенну Вивальди 34 x 36 
x 60 мм 

 
На сторонах этого бокса зададим граничное условие Radiate.  Зададим 

порт на торце коаксиальной линии (рис. 3.14). 
 
 

 

Рис. 3.14.  Создание волнового порта 
в сечении коаксиальной линии 

Рис. 3.15. Ячейка антенной решетки, 
охваченная периодическими граничными 

условиями 
 
 

Порт Флоке используется при моделировании бесконечных 
периодических структур (см. главы 1 и 2). Анализ бесконечной структуры 
сводится к анализу одного периода структуры (элементарной ячейки). На ее 
противоположных боковых сторонах задаются условия периодичности. На 
верхней поверхности необходимо выполнить одно из возможных 
«открытых» граничных условий, моделирующих процесс излучения в 
свободное пространство. В качестве поверхностей с «открытыми» 
граничными условия в HFSS используются PML, поверхность излучения и 
порт Флоке. 

Достоинством порта Флоке является то, что с его помощью можно 
описывать не только отражение волны, поступающей на вход антенны 
Вивальди, но и передачу энергии в свободное пространство. В бесконечной 
периодической структуре поле в свободном пространстве имеет вид 
гармоник Флоке. Каждая из таких гармоник является плоской волной, 
распространяющейся в пространстве под определенным углом. Как 
отмечалось в главе 1 и 2 большая часть гармоник Флоке является 
нераспространяющимися, а основная гармоники и одна-две гармоники 
высших типов могут распространяться. При этом гармоники высших 
порядков могут при одних углах сканирования быть распространяющимися, 
а при других нераспространяющимися. 
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Использование порта Флоке позволяет рассчитывать коэффициенты 
передачи из волноводного порта в гармоники Флоке и наоборот. Как и в 
случае волноводного порта, эта информация дается в форме S-матрицы, 
связывающей отраженные и падающие волны (рис. 3.19-3.24).  
 

                     
Рис.  3.16. Параметры порта Флоке, в таблице указано номер моды, 
состояние поляризации, индекс моды, затухание и режим уплотнения  

Affects Refinements 
 

Выберем количество мод 6 и нажмем кнопку “Modes Calculator” . В 
диалоге Mode Table Calculator  внесем частоту и углы, на которые будет 
сканировать антенная решетка. Количество мод нужно увеличивать до тех 
пор, пока в списке появляются нераспространяющиеся типы волн. В 
закладке 3D Refinment выбираются моды, которые будут учитываться при 
выполнении уплотнения сетки. 

Далее зададим центральную частоту 4.5 ГГц и выполним расчет 
антенной решетки в диапазоне частот от 2 до 5 ГГц. Результаты расчета 
частотной характеристики |S11| показаны на рис. 3.17. 

 
 
Рис.  3.17. Частотная характеристика коэффициента отражения от 

антенны Вивальди 



 42

 

            
Рис. 3.18. Ближнее поле в сечении антенны Вивальди и ток на поверхностях 

полосковых проводников 
 
 

Из рис. 3.18 видно, что антенна возбуждается симметрично, чего не 
было бы, если бы в структуре отсутствовало симметрирующее устройство.  
 

   
Рис. 3.19. Первая мода канала Флоке Рис. 3.20. Вторая мода канала Флоке 

 
 

Отметим, что с точки зрения электродинамики использование модели 
решетки в виде канала Флоке не позволяет рассчитывать ДН антенны этого 
типа, так как эта модель строго может использоваться исключительно для 
анализа бесконечной решетки, которая имеет ДН с нулевой шириной, то есть 
в виде дельта функции. Однако, в HFSS имеется возможность расчета ДН 
канала Флоке путем замены одного из портов Флоке на поверхность 
излучения. К этой возможности следует относится с осторожностью, имея 
ввиду, что получаемая ДН не является ни ДН решетки, ни отдельного ее 
элемента. Она дает лишь качественное представление о ДН решетки, когда 
она возбуждается по одному из ее входов. В антенной технике такую ДН 
называют ДН излучателя в составе решетки. Тем не менее, надо помнить, что 
расчет по описанной выше методике позволяет получить указанную 
характеристику лишь приближенно. 
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4.  Антенная решетка на вибраторных антеннах 

 
   

Рассмотрим антенную решетку из четырех вибраторных антенн с 
металлическим отражателем (рис. 4.1).   В такой решетке положением луча 
можно управлять, изменяя фазы напряжений, подводимым к отдельным ее 
элементам. Отражательная панель улучшает характеристики решетки, 
создавая в горизонтальной плоскости однонаправленное излучение.  

Выполнить анализ такой антенной решетки можно в единой 
конструкции, т.е. не применяя периодических граничных условий. 
 

 
Рис. 4.1. Антенная решетка с отражателем 

 
Элементы решетки расположены на тефлоновой подложке (ε=4) 

толщиной 1.6 мм. Возбуждения осуществляются через дискретные порты.  
Граница излучения задается на сторонах воздушного бокса.  Переменная 
фазового сдвига для постпроцессорной обработки имеет имя phase_shift. 
Центральная частота, на которой работает антенная решетка 1.9 GHz. 
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Рис. 4.2. Геометрия одной из четырех антенн, расположенных с шагом по 

оси Z равным 103 мм 
 

Начертим диэлектрическую подложку толщиной 1.6мм 
(диэлектрическая проницаемость 4), командой Draw->Box. Полученные 
размеры подложки можно откорректировать в диалоге рис. 4.3. 

      
 

Рис.  4.3. Диалог фрагмента диэлектрической платы 
 

Передвинем координатную систему на плоскость, на которой будем 
чертить вибратор, выделив сначала курсором одну из плоскостей 
(предварительно нажав F),  командой Modeler->Coordinate System ->Create 
->Face CS. 
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Далее начертим вибратор, по точкам (рис. 4.3), как многоугольник, 
задавая команду  Draw -> Polyline. 
 

 
Рис. 4.3. Черчение одной части вибратора 

 
Далее создадим новую систему координат, сдвинутую относительно 

начала системы по оси X на 18 мм, равную половине длины подложки 
командой Modeler-> Coordinat System -> Create -> Relative CS->Offset . И 
сделаем разворот с копированием этой части вибратора на 180° командой 
Edit->Duplicate->Around Axis (рис. 4.4). 
 

 
Рис.  4.4. Выбор оси Y, вокруг которой прокручивается вибратор с 

копированием 
 

Теперь между линиями вибратора начертим прямоугольник (рис. 4.5), 
на который затем устанавливается дискретный порт командой HFSS-
>Excitation->Assign->Lumped Port.  
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Рис. 4.5.  Постановка интегральной линии на дискретный порт 

 
 

Далее выполним копирование со сдвигом этой вибраторной антенны, 
чтобы получить 4 антенны, составляющих антенную решетку (рис.  4.7). 
 
Черчение отражателя. Конфигурация металлического отражателя 
уголкового типа показана на рис. 4.6. Взаимное расположение отражателя и 
диэлектрической платы с вибраторами представлено на рис. 4.7. Отражатель 
содержит отверстия, которые могут использоваться для вывода 
возбуждающих линий и соединения их с выходами делителя мощности, 
который играет роль схемы питания решетки. 
 

Рис. 4.6.  Положение отражательной плоскости антенной решетки с 
отражателем 

 
     Общая высота диэлектрической подложки 420 мм, а диэлектрическая 
проницаемость  ε=4. После черчения решетки, можно задать установки на 
расчет и диапазон частот анализа. При проведении расчета решетки нужно 
учесть, что антенная решетка представляет собой СВЧ многополюсник, 
имеющий четыре входа. HFSS рассчитывает матрицу рассеяния такого 
многополюсника в установленном диапазоне частот. Однако, получаемые 
при этом значения коэффициентов отражения не равны, представляющим 
наибольший практический интерес коэффициентам отражения решетки в 
рабочем режиме, в котором одновременно возбуждаются все четыре входа.  
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Рис. 4.7.   Структура и размеры антенной решетки. Общая высота 
рефлектора 420 мм 

   
Для определения коэффициентов отражения решетки в рабочем 

режиме Si,j_corr (i,j=1,…4) необходимо их рассчитать, используя элементы 
матрицы рассеяния S(i,j) по формулам, которые представлены на рис. 4.8.  
 

 
 
Рис. 4.8. Переменные, по которым считаются S-параметры антенны при 

одновременном возбуждении ее входов 
 

 На рис. 4.8 под Vi понимаются комплексные амплитуды напряжений, 
возбуждающих элементы решетки.  
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   Известно, что для уменьшения уровня боковых лепестков антенной 
решетки крайние элементы нужно возбуждать с меньшей амплитудой, чем в 
центре. Амплитуды возбуждения можно задать в качестве переменных (см. 
рис. 4.8). Если принять V_port1= V_port4 = 0.66 и V_port2= V_port3 = 1, то 
получим ДН, показанную на рис. 4.9. 

Разность фаз питания двух соседний антенн задается переменной 
phase_shift на этапе постпроцессорной обработки. Для создания такого 
режима, в диалоге, выводимом по команде HFSS>Fields>Edit Sources, в котором 
находится переменная “Offset phase”. Задайте множитель переменной сдвига 
фазы phase_shift. 

    Задать переменную phase_shift  можно,  нажимая на имя проекта  
HFSSDesign2, в дереве проекта. Переменные проекта можно видеть в окне 
Properties.  В этом окне можно изменить величину phase_shift. Выберем 
phase_shift = 30º, что будет соответствовать графику на рис.  4.9.  

 

 
Рис. 4.9. ДН отдельного вибратора антенной решетки 
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Рис. 4.10. Трехмерная ДН антенной решетки 

 
При большом количестве элементов антенной решетки ее уже 

невозможно рассчитать в виде единой конструкции. Для решения такой 
задачи нужно использоваться периодические граничные условия. 
     Возбуждение каждого элемента антенной решетки выполняется с 
помощью многоканального делителя мощности (МДМ). Пример МДМ 
вместе с вибраторами показан на рис. 4.11. В случае синфазного возбуждения 
порты возбуждаются так, что поля в дальней зоне суммируются в 
направлении оси 0у. Этот процесс виден из распределения поля, показанного 
на рис. 4.11. 

 

 
Рис. 4.11. Ближнее поле в плоскости xOy  антенной решетки 
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   Отметим, что совместный расчет излучающей решетки вместе со 
схемой питания представляет собой для HFSS весьма сложную задачу, 
которая требует больших затрат компьютерных ресурсов. Такое положение 
обусловлено тем, что разветвленная микрополосковая схема, реализующая 
МДМ требует для своего анализа использования весьма густой сетки. 
Пример такой сетки представлен на рис. 4.12, на котором также показано 
распределение токов на металлических проводниках. 

 
Рис.  4.12. Вибраторная решетка, отражатель и схема распределения 

 
 Учитывая большую трудоемкость решения обсуждаемой задачи в 
HFSS, представляет интерес применение комплексного подхода, в котором 
сочетается использование разных программных средств для расчета разных 
фрагментов сложной структуры. При этом каждая часть анализируется с 
помощью методов в наибольшей степени адекватных физике ее 
функционирования. 
 

Расчет  МДМ  в  системе  MWO.  Схему  распределения  мощности  будем 
проектировать  в  системе  Microwave  Office  (MWO)  используя 
подпрограмму  EMSight,  которая  осуществляет  расчет  полосковых 
структур  методом  моментов.  Такой  подход  для  анализа  полосковых 
схем  намного  эффективнее  метода  конечных  элементов,  который 
используется  в  HFSS.  При  этом  излучающая  решетка  будет 
анализироваться  с  помощью  HFSS.  Ниже  мы  обсудим  возможность 
корректного  использования  данных,  полученных  с  помощью  одной 
системы, для расчетов в другой.  
 Проблема согласования расчетных данных, полученных в разных 
системах проектирования решается путем использования дискретных портов. 
Для этого при моделировании вибраторов применяется модель, показанная 
на рис. 4.13. Ее особенностью является использование двух дискретных 
портов P1,2, включенных между проводниками линии передачи, 
возбуждающей вибратор и металлическим отражателем. При таком 
представлении элемента решетки вся она рассчитывается в HFSS как СВЧ 
многополюсник с восемью выходами (шестнадцатиполюсник в 
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терминологии, принятой в России и восьмиполюсник по англоязычной 
терминологии – eight port junction).  

 
Рис. 4.13. Модель вибратора с двумя портами 

 
 Использование такой модели позволяет рассчитать матрицу рассеяния 
решетки без МДМ размером 8х8.  
 Рассмотрим далее основные этапы проектирования МДМ в системе 
MWO. МДМ представляет собой комбинацию нескольких элементарных 
делителей мощности ЭДМ на два канала, соединенных друг с другом 
линиями передачи. Структурная схема МДМ показана на рис. 4.14. 
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Рис. 4.14. Структура МДМ 

 
 В состав МДМ показанного на рис. 4.14 входят ЭДМ Д1, 
осуществляющий деление мощности пополам, ЭДМ Д2, делящий мощность в 
отношении 3:7 и возбудитель вибраторов В. Неравное деление мощности в 
ЭДМ Д2 обеспечивает спадающее распределение поля на краях решетки, 
благодаря которому снижается уровень боковых лепестков ее ДН в 
вертикальной плоскости. 
    Возбудитель В выполняет роль устройства питания вибраторной антенны. 
Выходами 1,2 он соединен с вибратором, который имеет два входа (см. рис. 
4.13).  
 Первый этап проектирования МДМ включает проектирование ЭДМ и 
возбудителя. Их топология показана на рис. 4.15 а-в. На рис. 4.15 а,б 
показаны топологии делителей Д1,2, а на рис. 4.15 в топология возбудителя. 
Они выполнены на подложке с проницаемостью 4.6 и толщиной 2 мм. 
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Рис. 4.15. Топологии ЭДМ и возбудителя 
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 Поскольку делитель Д1 имеет симметрию относительно портов 2 и 3, 
то его проектирование сводится к согласованию по входу 1. Все выходы 
устройства выполнены в виде микрополосковых линий с характеристическим 
сопротивлением 50 Ом. В качестве портов используются дискретные порты. 
Боковые плечи делителя содержат четвертьволновые трансформаторы, 
которые обеспечивают согласование выходных линий передачи со входной 
линией. На рис. 4.16 показана частотная характеристика коэффициента 
отражения делителя по входу 1. Видно, что наилучшее согласование 
достигается в окрестности частоты 1.7 ГГц. При удалении от нее 
коэффициент отражение растет, оставаясь однако достаточно малой 
величиной, не превышающей – 26 дБ в полосе 1.6 – 1.8 ГГц.  

 
Рис. 4.16. Частотная зависимость модуля коэффициента отражения 
делителя Д1 по входу 1 

 
 Делитель Д2 не имеет симметрии относительно входов 2 и 3, так как он 
обеспечивает неравное деление мощности. Поэтому его проектирование 
требует не только согласования по входу 1, но и реализации заданных 
значений коэффициентов передачи от входа 1 ко входам 2 и 3. Они должны 
быть равны следующим значениям: 5.121 −=S  дБ, 34.531 −=S  дБ.  
 На рис. 4.17 показаны частотные зависимости модулей коэффициента 
отражения 11S  и коэффициентов передачи 21S  и 31S  делителя Д2. Видно, 
что он достаточно хорошо согласован по входу 1 и обеспечивает заданные 
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значения коэффициентов передачи. Согласование достигается подбором 
размеров структуры рис. 4.15(б), что удобно делать в MWO. 
 

 

Рис. 4.17. Частотные характеристики делителя Д2 
 

 Возбудитель вибратора (рис. 4.15 в) должен выполнить следующие 
функции. Он выполняет деление мощности, поступающей на вход 1 в равном 
отношении между входами 2 и 3. При этом фазы сигналов на портах 2 и 3 
должны быть сдвинуты на 1800. В этом случае в двухпроводной линии, 
которая питает вибратор, будет возбуждаться ее основная волна, у которой 
токи на проводниках также сдвинуты по фазе на 1800. Важно также, чтобы 
выходы возбудителя были согласованы со входным сопротивлением 
вибратора. Его параметры подбирались в HFSS таким образом, чтобы 
входное сопротивление в точках размещения портов имело активную часть 
равную 60 Ом и нулевую реактивную часть.  
 Исходя из этих условий, осуществлялась оптимизация топологии 
возбудителя. В результате были получены частотные характеристики, 
представленные на рис. 4.18 а,б. На рис. 4.18 а показана частотная 
зависимость коэффициента отражения по входу 1, а на рис. 4.18 б частотные 
зависимости фаз коэффициентов передачи 21S  и 31S . Видно, что 
возбудитель хорошо согласован и обеспечивает противофазное деление 
мощности.  
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 В системе MWO имеется возможность визуализации распределения 
токов на полосковых проводниках. Пример такого распределения на 
проводниках возбудителя показан на рис. 4.19.  

 
а 

 
б 

Рис. 4.18. Частотные характеристики возбудителя, показанного на рис. 
4.14 в) 
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Рис. 4.19. Распределение токов на полосковых проводниках возбудителя 

 
 Заключительная стадия проектирования МДМ состоит в расчете его 
выходных параметров. Топология МДМ показана на рис. 4.20. 

 
 

 
Рис. 4.20. Топология МДМ 

 
 В качестве примера на рис. 4.21 представлена частотная зависимость 
коэффициента отражения МДМ по центральному входу 1 (см. Рис. 4.14). 
Видно, что согласование МДМ несколько хуже согласования ЭДМ, однако в 
полосе частот коэффициент отражения не превышает – 20 дБ. 
 Следующий этап проектирования решетки состоит в расчете ее 
параметров с учетом результатов проектирования МДМ и излучающей части 
решетки в виде четырех вибраторов, выполненной в HFSS.  
 Эту часть работы удобно выполнить, экспортируя файлы данных из 
HFSS и MWO и обрабатывая их с помощью таких вычислительных систем 
как Маткад или Матлаб.  
 Файлы данных содержат матрицы рассеяния многополюсников, 
рассчитанные в HFSS и MWO. Матрица рассеяния решетки aS  представляет 
собой матрицу 8х8 в соответствии с числом ее входов. Аналогично матрица 
рассеяния МДМ dS  имеет размерность 9х9.  



 58

 
Рис. 4.21. Частотная зависимость коэффициента отражения МДМ по 

входу 1 
 

 Матрица dS имеет следующую структуру: 

   ⎥
⎦

⎤
⎢
⎣

⎡
=

ααα

α

SS
SS

Sd
1

111 ,      (5) 

где α  - группа входов с номерами 2 – 9. Таким образом, ααS  - это матрица 
размером 8х8, α1S  - матрица – строка размером 1х8, 1αS  - матрица – столбец 
размером 8х1 и 11S  - коэффициент отражения по входу 1.  
 Для расчета результирующего коэффициента отражения антенны R  
необходимо провести анализ каскадного соединения двух многополюсников, 
показанных на рис. 4.22. 

 
Рис. 4.22. Каскадное соединение МДМ и решетки 
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 Для определения коэффициента отражения R  воспользуемся 
соотношениями, приведенными в  [20]: 
  

1
1

111 )( αααααα SSSSESSR a
−−+= ,    (6) 

 
где E  - единичная матрица размером 8х8. 
  
    Также, из анализа каскадно-соединенных многополюсников, мы можем 
найти амплитуды падающих на входы решетки волн nU , 8...1=n . Их 
можно использовать далее для задания условий возбуждения решетки с 
учетом влияния МДМ. Зная эти амплитуды, мы можем с помощью HFSS 
рассчитать ДН антенны (рис. 4.10).  
 Использование разных программных средств, описанное выше 
позволяет рационально использовать их для решения тех задач, которые 
решаются с их помощью с наименьшими затратами компьютерных ресурсов. 
В данном случае HFSS используется для анализа трехмерной излучающей 
структуры, а MWO для анализа планарной полосковой схемы. В результате 
общее время, необходимое для получения конечного результата существенно 
сокращается. Кроме того, повышаются точность и достоверность решения.  
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5. Моделирование частотно-селективной поверхности 

 
 
 
К числу наиболее интересных задач прикладной электродинамики 

относятся задачи дифракции волн на периодических структурах. Широкое 
применение находят двумерно-периодические планарные решетки, которые 
получили название частотно-селективных поверхностей (ЧСП). Они 
используются в качестве пространственных фильтров, поляризационных 
фильтров, антенных обтекателей, средств радиозащиты и т.д.  

Отдельного упоминания заслуживает использование ЧСП в 
квазиоптических фидерах рефлекторных антенн метеорологических 
спутников. Применение ЧСП для построения частотно-селективных 
устройств позволяет существенно улучшить их массогабаритные 
характеристики.  

К устройствам этого типа предъявляются жесткие требования. Так, 
например, радиометр Европейского Космического Агентства MASTER 
должен обеспечивать разделение сигналов диапазонов 294-306, 316-326 и 
342-349 ГГц [13-17]. При этом вносимые потери не должны быть больше 
более 0.5 дБ, а развязка между каналами не меньше 20 дБ для уверенного 
детектирования слабых излучений молекул в атмосфере. Для минимизации 
вносимых потерь применяют апертурные ЧСП, позволяющие исключить 
диэлектрики и связанные с ним потери. Улучшение избирательных 
характеристик может быть достигнуто использованием многослойных 
структур, содержащих несколько параллельных слоев и многоэлементных 
периодических структур, содержащих несколько отражателей (апертур) в 
одной элементарной ячейке периодической структуры ЧСП. Проектирование 
такого рода устройств является актуальной задачей, решение которой сложно 
осуществить вне рамок строгого электродинамического моделирования. 
Создание модели ЧСП. Будем анализировать ЧСП с помощью периодических 
граничных условий, выделяя элементарную ячейку структуры в виде канала 
Флоке.  

Элементарная ячейка ЧСП может быть создана с использованием 
связанных границ с периодическими граничными условиями и двух портов 
Флоке. Результат решения граничной задачи анализа ЧСП представляется в 
виде S-матрицы, связывающей моды Флоке в соответствующих портах. 

В качестве примера, который рассмотрим в данной главе, служит 
проводящий экран, содержащий гексагональную решетку круговых апертур 
(отверстий). Геометрия решетки показана на рис. 5.1. На рис. 5.1 векторы 
решетки показаны углом. Угол между векторами решетки составляет 60°. 
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Рис.5.1. Геометрия частотно–селективной поверхности 
 
 

Рассмотрим нормально падающую плоскую волну на экран с 
поляризацией вектора электрического поля, показанной на рис. 5.1 красными 
стрелками. 

Рассчитаем  модули и фазы элементов матрицы рассеяния, как функции 
от частоты. Полоса частот от 8 до 20 ГГц. 

Модель одной ячейки показана на рис. 5.2. Длины стороны равна 1.73 
см, диаметр круглой апертуры равен 1.2 см и высота ячейки равна 4 см. 
Видно, что ячейка состоит из планарного металлического ромба с отверстием 
и бокса ромбической формы, на поверхностях которого заданы 
периодические граничные условия и порты Флоке. Приступим к созданию 
элементарной ячейки средствами HFSS. На первом этапе создадим 
ромбический бокс. 
       
Создание ромбического бокса. Для решения задачи выполните 
следующие действия: 
 
1. Откройте новый проект и назовите его RhombicArray. Установите 
единицы измерения длины – сантиметры (сm). 
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Рис. 5.2. Ромбовидная ячейка гексагональной ЧСП 

 
 
2. Кликните  Draw>Line, кликните в произвольном месте, чтобы установить 
начальную точку, затем кликните три другие произвольные точки и затем 
вернитесь к начальной точке, чтобы замкнуть фигуру. 
 
3. Кликните правой кнопкой, чтобы вызвать выплывающее меню и выберите 
команду Done. Этим создается многоугольник. 
 
4. В дереве проекта раскройте Sheets>Unassigned>CreatePolyline, выбрав 
первую операцию CreateLine  чтобы увидеть свойства этой линии. 
 

 
5.  Установите координаты первой точки Point1 = (0,0,0). 
 
6. Отредактируйте координаты Point2 = (0.865, 1.4982, 0). Это будет сдвиг 
сегмента первой ломаной линии, который даст требуемый размер объекта.  
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7. Повторите этот процесс со следующими тремя операциями  CreateLines в 
дереве создания и отредактируйте в них значения Point2, Point3 и Point4 (рис. 
5.3) следующим образом: 
                  Point2 (0.865, 1.4982, 0) 
                  Point3 (2.595, 1.4982, 0) 
                  Point4 (1.73, 0, 0) 
                 

Созданный плоский ромб можно использовать для создания 
ромбообразного  бокса.  Перед этим сделайте, командой Copy, копию ромба, 
которая будет полезна для создания металлического ромба. 
 

Рис. 5.3. Ромб как сечение будущей ячейки частотно-селективной 
поверхности 

 
8. Чтобы преобразовать плоский 2D объект в 3D ячейку, задайте команду  
Draw>Sweep>Along Vector. 
 
9. В строке состояния, введите нули в ячейки X, Y, Z, чтобы задать 
начальную точку. 

Это помещает курсор в первую точку, задающую вектор, и изменяет 
сообщение строки состояния на “Input the second point of the sweep vector 
(ввести вторую точку вектора развертки)”. Метки ячейки показывают 
величины сдвигов dX, dY, и dZ. 
 
10. В статус-баре введите 0, 0, и 4 и нажмите Enter.  Это начертит линию от 
начальной до конечной точки, и выведет диалог Sweep Along Vector (рис. 
5.4). 

 
 
11. В диалоге Sweep Along Vector, оставьте 0 deg как черновой угол, и 
выберите Round из выпадающего меню как тип Draft type. Затем нажмите 
OK. 
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Рис. 5.4. Завершение операции свипирования по вектору 
 

12. Эта операция преобразует ромб в 3D объект.  
13. Теперь сдвинем  этот объект вниз на 2 см, используя операцию Edit-
>Arrange-> Move. 
14. Откроется диалог Measure data и появляется возможность ввести  через 
статус-бар, а также курсором, опорную точку X, Y, и Z,   как первую точку 
вектора сдвига. 
15. В статус-баре установите Z = 0, и нажмите Enter. 
16. В статус-баре установите dZ = -2.0 и нажмите  Enter. 

Это сдвинет объект на нужное расстояние. 
 
     Создание плоского ромба с отверстием.  Если Вы сделали копию 
плоского ромба, то далее ее можно использовать. В противном случае 
повторите шаги 1 - 7. 
 
1. Кликните копию плоского ромба. 
2.  Командой Draw>Circle начертите круг, установив курсор в центре 
многоугольника.  
3. Откройте диалог свойств окружности и установите ее радиус 0.6 cm. 
4. Выберите одновременно окружность и прямоугольник и кликните 
Modeler> Boolean>Subtract. Откроется диалог Subtract. 

 
Рис. 5.5. Ячейка частотно-селективной поверхности 
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5. Переведите Rectangle в список  Blank, а окружность в список Tool. 
 
6. Кликните  OK, чтобы закрыть диалог и создать апертуру вычитанием 
окружности из прямоугольника. 
 
    Задание границ Master и Slave.  
    Для того, чтобы смоделировать ЧСП, которая состоит из периодически 
расположенных элементов, необходимо задать периодические граничные 
условия на противоположных стенках. 

Зададим границы Master и Slave на ромбическом объекте следующим 
образом. 
 
1. Выберите поверхность, показанную на рис. 5.6 и задайте команду  
HFSS>Boundaries>Assign>Master.  Появляется диалог Master Boundary. 
 
2. Оставьте имя по умолчанию как Master1. 
 
3. Чтобы установить вектор U вдоль по ребру  кликните New Vector.    
Появляется диалог Measure dialog и Create Line. 
 
4. Начертите вектор U vector на выбранной поверхности. Кликните на 
нижний левый угол как начальную точку, и прочертите курсор к правому 
углу и кликните Master1. 
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Рис. 5.6.Задание границ Master(ведущая)  и  Slave(ведомая) 

 
 
5. В диалоге  Master Boundary, для вектора V Vector, выберите опцию    
Reverse direction и нажмите OK. 
6. Выберите противоположную сторону и задайте команду     
HFSS>Boundaries>Assign Slave. Появляется диалог Slave с выбранной     
закладкой General. 
7. Для этой ведомой поверхности выберите  Master1 как ведущую границу. 
8. Начертите вектор U Vector как показано на рис. 5.6 и нажмите OK. 
9. Повторите процедуру для границ Master2 и Slave 2. 

 
Рис. 5.7. Создание второй пары периодических границ 
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Далее зададим граничное условие Perfect E для ромба с отверстием. 
Для этого нужно выбрать поверхность Aperture из дерева хронологии и 
задать команду HFSS>Boundaries>Assign>Perfect E. Граница PerfE1 
появляется в списке Boundary. 
 
     Задание портов Флоке.  
     Порты Флоке нужно установить на нижнюю и верхнюю поверхности 
модели. 
 
1. Выберите верхнюю поверхность модели и кликните 
HFSS>Excitations>Assign>Floquet Port.  Появляется ассистент порта Флоке, 
показывающий страницу General. 
 
2. Для координатной системы Lattice Coordinate System, из выплывающего 
меню для направления A, выберите  New Vector. 
 
3. Начертите вектор, нажимая нижний угол по оси Z начальную точку, и 
затем нажимая соседний угол вдоль по оси X. Когда вы сделаете двойной 
клик для завершения построения вектора, диалоги  Measure Data и  Create 
line исчезают, и снова появляется ассистент  Floquet Port, показывая, что 
вектор a определен. Повторите эту процедуру для вектора b. 
 
4. В закладке  Modes setup, введите  Number of Modes= 14. Таким образом, 
заполнится таблица Mode, которая будет иметь четырнадцать строк (рис. 
5.9). 

 
Рис. 5.8. Порт Флоке в пространстве ячейки частотно-селективной 

поверхности 
5. Кликните кнопку Modes Calculator для получения информации по 
установке мод. Появляется калькулятор мод. Установите частоту Frequency = 
20 ГГц (рис. 5.9). 
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Рис.  5.9. Калькулятор мод и установки на его запуск 

 
6. Оставьте остальные величины по умолчанию и кликните OK, чтобы 
закрыть калькулятор.  Это заполнит таблицу с рассчитанными данными. 
 
7. Выберите опцию смещения опорной плоскости,  Deembed, и задайте 
расстояние до нее Distance = 2.0 cm. 
 
8. Кликните Next для перехода на страницу 3D Refinement. 
 
9. Для  1-й моды Mode 1, выберите опцию уплотнения Affects Refinement 
(рис. 5.10). 

 
Рис. 5.10. Результаты работы калькулятора мод 
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10. Кликните OK. Первый порт Флоке появится в разделе Excitations в дереве 
проекта. 
 
11. Выберите нижнюю поверхность модели, и повторите процесс, чтобы 
установить второй порт Флоке. Информация первого порта Флоке 
копируется. 
 

 
Рис. 5.11. Ближнее поле в сечении ячейки частотно-селективной 

поверхности 
 
Установка на анализ. Для этого выполните следующие операции: 
 
1. Нажмите правой кнопкой на Analysis в дереве проекта и выберите Add 
Solution Setup. Открывается диалог Solution Setup. 
 
2. В закладке General установите Solution frequency = 20 GHz. Установите 
Maximum Number of Passes = 10, и Maximum Delta S = 0.02. 
 
3. В закладке Options, отметьте режим Do Lamda Refinement, и установите 
Lambda target = 0.2. 
 
4. Установите Maximum Refinement Per Pass = 20%, the Minimum Number of 
Passes = 6, и  Minimum Converged Passes = 2. 
 
5.  Выберите функцию First Order Basis, и кликните OK. 
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Рис.  5.12. Выбор типов волн, по которым контролируется сходимость 

процесса 
 
    Расчет характеристик в диапазоне частот. Чтобы выполнить 
расчет в полосе частот: 
 
1. Кликните правой кнопкой мыши на Setup1 в дереве проекта и выберите  
Add Frequency Sweep. Появляется диалог Edit Sweep. 
2. Для Sweep Type, выберите опцию сглаживания данных расчета в 
диапазоне частот Interpolating. 
4. Установите Max Solutions = 50, и Error Tolerance = 0.5%. 
5. Кликните кнопку Advanced Options чтобы показать диалог Interpolating 
Sweep Advanced Options. 
6. Установите Minimum Solutions = 5, и  Minimum number of Subranges = 1. 
7. Для установки сходимости Interpolation Convergence, выберите кнопку  Use 
Selected Entries Radio, и кликните  кнопку Select Entries. Появляется   диалог 
Interpolation Basis Convergence (рис. 5.12). 
8. В диалоговом окне Interpolation Basis Convergence, оставьте Entry Selection 
и Mode Selections как All. Это значит, что все моды Флоке будут 
перечислены в таблице. Затем используйте вертикальную полосу прокрутки, 
найдите строку FloquetPort2:1 и установите значение ON в столбце 
FloquetPort1:1. 
 9.  В строке FloquetPort1:1 и в строке Floquet Port2:1 также установите опцию 
ON. 
10. Нажмите OK, чтобы закрыть этот диалог, OK чтобы закрыть Interpolating 
Sweep Advanced Options, и OK, чтобы закрыть диалог Edit Sweep. 

На рис. 5.13 – 5.14 показаны рассчитанные распределения полей 
разных мод канала Флоке. 
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Рис. 5.13. Поле 2-й моды Флоке Рис.  5.14. Поле 4-й моды Флоке 
 

 
11. Нажмите Analyze для запуска расчета.  
 
Просмотр результаты расчетов. Несколько частотных зависимостей 
модулей и фаз коэффициентов отражения и прохождения по основным типам 
волн показаны на рис. 5.15, 5.16. 
 

 
 

Рис.  5.15. Фазо-частотная характеристика коэффициента передачи из 
порта Флоке 1 в порт 2 по основной волне 

 
Из рис. 5.15 видно, что ЧСП обладает частотной селективностью для 

основной моды. Из 5.16 видно, что на частоте 18 ГГц ЧСП полностью 
прозрачна для падающей волны, так как на этой частоте ее коэффициент 
отражения стремится к нулю.  

Интересно также рассчитать свойства ЧСП для волн, падающих под 
разными углами на частотно-селективную поверхность. В этом случае нужно 
задать плоскую волну, угол падения которой будет параметрически меняться. 
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Рис.  5.16. Частотные характеристики модулей коэффициентов отражения 
и передачи ЧСП по основной волне 

 
 

  Отметим, что также можно рассчитать свойства ЧСП для волн, падающих 
под разными углами на частотно-селективную поверхность. В этом случае 
нужно задать плоскую волну, угол падения которой будет параметрически 
меняться. К частотно-селективным поверхностям можно отнести 
резонансную структуру, рассмотренную в гл.1. 
   Материалы можно задать так, что они будут иметь частотную зависимость 
своих параметров. Пример частотной зависимости материалов показывается 
на рис. 5.17. 
 

  
Рис. 5.17. Частотные зависимости материала (из примера ViaWizard) 
    Библиотека материалов HFSS можно пополнять моделями с линейно-
ломанными частотными зависимостями, моделями  моделями Дебая, 
моделями Дворжека-Сахарова,  а также пользовательскими моделями, все 
параметры которых можно ввести в табличном виде [1]. 
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6. Падение плоской волны на объект 

и расчет радиолокационного сечения рассеяния 
 

 
Радиолокационное сечение рассеяния характеризует способность 

объекта рассеивать падающие на него электромагнитные волны. В 
англоязычной литературе ему эквивалентен термин Radar Cross Section 
(RCS). Этот параметр используется для оценки возможности обнаружения 
объекта (цели) с помощью радиолокатора [4,5]. Кроме этого параметра, для 
оценки параметров цели используется эффективная площадь рассеяния 
(ЭПР). 

Рассмотрим определения параметра RCS. Выделяют два разных случая. 
В первом передающая антенна, облучающая исследуемый объект и приемная 
антенна, принимающая отраженные от него волны находятся в одном месте. 
И их координаты меняются одновременно. В этом случае говорят о 
бистатической локации и параметры цели описывают с помощью 
бистатического RCS.  

Во втором случае приемная и передающая антенны находятся в разных 
точках (см. рис. 6.1). Приемная антенна в этом случае стоит фиксировано, т.е. 
в одном месте. В этом случае говорят о моностатической радиолокации и 
используют, соответственно, моностатическое RCS. 

 
 

Рис. 6.1. Схема моностатической радиолокации 
 
 Параметры RCS и ЭПР связаны следующим образом: 
  

RCS= σ/λ2,      (7) 
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где λ – длина волны в свободном пространстве, σ – ЭПР [м2].  RCS, 
определенный соотношением (6.1) называют также нормированным 
радиолокационным коэффициентом отражения, поскольку он является 
безразмерной величиной. 
 ЭПР определяется через напряженность электрического поля 
падающей на объект волны Eпад в месте расположения объекта и 
напряженность поля волны рассеянной объектом в направлении 
расположения приемной антенны Eотр в месте расположения приемной 
антенны: 
                                σ= 4πr2  |Eотр|2 / |Eпад|2,    (8) 
где r – расстояние от объекта до приемной антенны.  
 Отметим, что соотношение (8) может использоваться как в случае 
бистатической, так  и моностатической радиолокации при соответствующем 
изменении напряженности поля рассеянной волны.  
 Из соотношения (8) видно, что ЭПР характеризует исключительно 
энергетические свойства объекта, так как в его определение входят 
абсолютные значения поля. Если представляет интерес фаза рассеянной 
волны, то в этом случае используют комплексный РСР, определяемый через 
комплексную ЭПР: 

падотр EEr /4 ⋅= πσ    (9). 
       HFSS рассчитывает  бистатический, нормированный бистатический, 
комплексный бистатический и моностатический RCS. В этом примере мы 
рассчитаем нормированные RCS для моностатического и бистатического  
положений радиолокатора и цели.    Меняя угол IWavePhi от 0 до 180 
градусов (рис. 6.2), мы как бы совершаем «облет» цели, облучая цель со всех 
сторон (рис. 6.3) и принимая отраженный сигнал в одной точке. Это случай 
моностатического RCS. 

 
Рис. 6.2. Параметры плоской волны с установками для расчета 

моностатического RCS 
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Общая процедура расчета RCS  состоит из следующих шагов: 
 
1. Создание проекта  HFSS. 
 
2. Черчение геометрической модели, включающее: 

• установку область черчения (бокс, в котором будет размещен 
объект); 

• создание объекта; 
• задание материала объекта (в нашем случае объект, на который 

падает плоская волна, идеально проводящий). 
 
3. Установка параметров решения задачи: 

• установка граничных условий на поверхностях бокса (мы будем 
использовать условия PML); 

• установка источника возбуждения (плоская волна); 
• установка критериев сходимости и параметров разбиения. 

 
4. Расчет RCS. 
 
5 . Постпроцессорная обработка для визуализации RCS. 
 

Применим этот алгоритм для расчета рассеяния от простейшего 
объекта - идеально проводящего куба в пространстве. 

 

Создание модели (RCS Model). Выбираем тип задачи Driven Modal.     
 
Чтобы установить единицы длины: 

 
1. Кликните  Modeler>Units. Появляется диалог Set Model Units. 
2. Выберите единицы meter из меню Select units. Опция Rescale to new units 
не включается. 

Если установлена опция Rescale to new units, то геометрическая сетка 
автоматически масштабирует расстояние между линиями сетки к единицам, 
введенным так, что разница будет соответствовать установленным единицам.    
3. Кликните OK, чтобы установить метры, как единицы длины для этой 
модели. 
 

Построим идеально проводящий (PEC)  куб, окруженный воздушным 
боксом (рис.6.3).  На поверхностях бокса установлены граничные условия 
PML.  

На этот куб падает плоская волна. Выполним расчет RCS- Radar Cross 
Section. 
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Рис. 6. 3. Проводящий куб внутри воздушного бокса 

 
      Для создания куба, используем команду Draw>Box. Идеально 
проводящий куб имеет ребро длиной 0.75  метра (рис.6.4).  
 

 
Рис. 6.4. Параметры проводящего куба 

 
     Чтобы установить свойства куба: 
 
1. Выберите созданный бокс и кликните Properties из выплывающего меню. 
Это выводит диалог Properties. 
2. Дайте имя объекту. 
3. В поле материала задайте материал  pec из списка и нажмите OK. 
4. В диалоге Properties отредактируйте цвет и выберите его красным. 
5. Установите прозрачность 0.6. 
6. Кликните OK, чтобы выбрать эти установки и закрыть диалог. 
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Создание воздушного бокса. Начертим бокс размером 1.4 м с центром в 
начале координат, с прозрачностью 0.9. Назовем его air_box. Начертим 
воздушный бокс по команде Draw>Box, и отредактируем его размеры в 
диалоге, показанном на рис. 6.5. 
 

 
Рис. 6.5. Размеры воздушного бокса 

 
     Стороны воздушного бокса будут удалены от исследуемого идеально 
проводящего  куба на расстояние большее, чем длина волны, учитывая 
частоту 300 МГц, которую мы будем использовать. 
Задание границ PML. Чтобы создать границы PML: 
 

1. Установите опцию выбора поверхности и введите команду 
Edit>Select>Face, или нажимая клавишу F. 

2. Выберите  Edit>Select>By Name, или выберите значок в меню. Это 
выведет диалог Select by Face. 

 
3. В списке имен объектов, выберите air_box.  Этот список называется 

air_box faces. 
4. Удерживая клавишу Ctrl, кликните каждую поверхность бокса. Все 

поверхности air_box должны быть подсвечены (рис. 6.6). 
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Рис. 6.6. Выбор всех сторон воздушного бокса 
 
5. В окне черчения, вызовите правой кнопкой мыши всплывающее меню и 
выберите  Assign Boundary> PML Setup Wizard.   Появляется ассистент 
установки (рис. 6.7). 
 

 
Рис. 6.7. Ассистент установки поверхности PML 

 
6. В поле Uniform Layer Thickness (рис. 6.7), установите толщину слоя 0.4 м. 
Параметры слоев PML будут откорректированы автоматически в 
соответствии с новой толщиной. 
 
7.  Установите опцию  согласования углов и ребер: Create joining corner and 
edge objects и кликните Next.  Это создаст объекты PML и появится диалог 
Material Parameters (рис. 6.8). 
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Рис. 6.8. Установки для расчета параметров PML 

 
8. Установите минимальную частоту Min Frequency = 0.3 GHz,  и 
минимальную дистанцию излучения Minimum Radiating Distance = 0.3 м. 
 
9 . Кликните  Next чтобы вывести итоговый диалог PML Summary (рис. 6.9). 
 

 
Рис. 6.9. Завершающие установки в работе  ассистента PML 

 
10. Кликните Finish чтобы закрыть диалог рис. 6.9. Границы PML появляют-
ся в разделе Boundaries в дереве проекта, и объекты PML перечисляются в 
дереве проекта. 
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Разбиение на тетраэдры воздушного бокса. Параметры разбиения бокса 
air_box будут сильно влиять на точность расчета диаграммы направленности. 
Для установки этих параметров: 
 
1. Выделите поверхности бокса air_box. 
2. Кликните правой кнопкой мыши на  Mesh Operations в дереве проекта. 
3. Кликните Assign>On Selection>Length Based.    Это выведет диалог 
Element Length Based Refinement (рис. 6.10). 
 

 
Рис. 6.10.  Диалог задания параметров разбиения 

 
4. Установите в нём параметр Maximum length of Elements = 0.2 м. 
5. Кликните  OK чтобы закрыть этот диалог. В дереве проекта в папке Mesh 
Operations появится значек Length1. 
 
 

     Установка параметров падающей волны.  
 

1. Задайте команду из меню HFSS>Excitations>Assign>Incident 
Wave>Plane Wave. Появляется страница Incident Wave Source: 
General Data (рис. 6.11). 

2. Напечатайте имя источника в боксе Name. 
3. Выберите в разделе  Vector Input Format как Spherical. 
4. Введите 0, 0, 0 для X-, Y-, и Z-координат of the Excitation Location 

and/or Zero Phase Position (исходная точка для падающей волны). 
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Рис. 6.11.  Задание фазового центра падающей планарной волны 

 
5. Кликните Next. Появляется диалог Incident Wave Source. В нем нужно 
выбрать опцию Spherical Vector Setup (рис. 6.12). 
 

 В разделе  IWaveTheta, введите   Start=0 deg, Stop = 90 deg, и 
Step=3deg. Для моностатического случая, RCS будет рассчитываться только 
для углов IWaveTheta,  введенных здесь. Таким образом, радиолокационный 
коэффициент отражения будет рассчитываться для тридцати  углов. 
 

 Кликните  View Point List (рис. 6.12) чтобы видеть заданные значения 
угла θ. 
 

 
Рис. 6.12.  Параметры падающей плоской волны для моностатического 

режима 
 
7. Кликните Next. Появляется страница Incident Wave Source: Plane Wave 
Options (рис. 6.13). 



 82

8. В разделе Type of Plane Wave выберите Regular/Propagating;  все другие 
поля станут неактивные. 

 
Рис.6.13.  Параметры падающей волны 

 
10. Кликните Finish. Падающая волна, которую Вы определили, добавляется 
в список Excitations и линии ее падения можно видеть на рис. 6.14. 
 

 
Рис. 6.14.  Исследуемый куб и углы, для которых будет рассчитываться RCS 
 

Далее опишем, как выполнить установки параметров бесконечных сфер 
для моностатического и бистатического эксперимента. Для этих 
конфигураций можно рассчитать графики нормированного бистатического и 
моностатического RCS.  
 
Создание бесконечной сферы для определения дальнего поля. Чтобы 
рассчитать излучаемые поля в дальней зоне, нужно установить сферу, 
которая окружает объект излучения. 
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Для этого примера, создадим установки для моностатического и 
бистатического случаев. 

Когда вы устанавливаете сферическую поверхность,  чтобы 
анализировать ближние поля или поля в дальней зоне, вы задаете диапазон 
изменения и шаг изменения углов φ и θ (азимутальный угол и угол места). 
Они указывают направления, в котором вы хотите оценить излучаемые поля 
(см. рис. 6.15). Для каждого значения угла φ имеется соответствующий 
диапазон значений для θ, и наоборот. Это создает сферическую сетку. Число 
точек сетки определяется размером шага для φ и θ. 
 

 
Рис. 6.15. Сферическая система координат 

 
Установка параметров в моностатическом случае Monostatic Setup.  
 

1. Кликните HFSS>Radiation>Insert Far Field Setup>Infinite Sphere. 
Появляется диалог Far Field Radiation Sphere Setup (рис. 6.16). 
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Рис. 6.16. Задание сферы, на которой задаются точки, в которых 

рассчитываются характеристики дальнего поля 
 
2. В закладке Infinite Sphere, напечатайте имя для сферы в окне Name. Для 
моностатической сферы напечатайте имя monostatic. 
3. Определите диапазон изменения углов в диалоге рис. 6.16. Для 
моностатического случая углы не меняются, так как положение приемной 
антенны фиксировано и совпадает с положением передающей антенны. 
Поэтому RCS рассчитывается только в направлении, определяемом 
падающей волной. Это направление определяется углами IWavetheta и 
IWavephi, которые уже были заданы при определении источника 
возбуждения (рис 6.12). 
4. Откройте закладку Coordinate System (рис. 6.16), и сориентируйте сферу 
в глобальной системе координат (CS). Выберите Use global coordinate 
system. Если вы хотите сориентировать сферу в соответствии с системой 
координат, выбранной пользователем, можно выбрать Use local coordinate 
system и выбрать систему координат из списка Choose from existing 
coordinate systems. 

 
5. Кликните закладку Radiation Surface. Оставьте выбор Use Boundary 
Radiation Surfaces. Если вы хотите задать поверхность другого типа, то 
нужно использовать Use Custom Radiation Surface. 

 
6. Кликните  OK. Моностатическая сфера создана. 

 
       Задание сферы в бистатическом случае.  
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1. В дереве проекта, кликните правой кнопкой  на Radiation и из 
выплывающего меню кликните Insert Far Field Setup>Infinite Sphere. 
Появляется диалог Far Field Radiation Sphere Setup. 
 
2. Введите имя “Bistatic”. 

 
3. Установите величины Phi Start, Stop, и Step = 0. 

 
5. Установите Theta Start = 0,  Stop = 180 deg и Step = 1. 
 
6. Кликните  OK, чтобы закрыть диалог. 
 

Установка Bistatic появляется в разделе Radiate в дереве проекта.  
Зададим далее частоту 0.3 ГГц и запустим программу на расчет. 
 
     Создание графика для бистатического  RCS. Чтобы задать параметры 
графика, выполните следующие действия: 
 
1. Нажмите правой кнопкой мыши на  Results в дереве проекта и выберите 
Create Far Fields Report>Rectangular Plot. Появится диалог New Report - 
New Traces. 
 
2. Оставьте в разделе Solution вариант выбора решения как Setup1: 
LastAdaptive. 
 
3. Чтобы вывести график  RCS, вы выбираете одну из геометрий в списке 
Geometry. Для этого графика выберите  Bistatic. 
 
4. В разделе Category, выберите Normalized Bistatic RCS. 
Этот выбор предполагает список Quantity чтобы показать NormRCS для 
Total, Phi, Theta, X, Y, и Z, с выбором Total Selected. 
 
5. Для этой функции, выберите dB. После этого выбора поле Y в разделе  
Trace показывает  db(NormRCSTotal).   
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Рис. 6.17. Выбор характеристики бистатического радиолокационного 

коэффициента отражения 
 
6. Откройте закладку Families и проверьте, что угол IWaveTheta=0. 
  
7.  Кликните New Report. Выводится график рис. 6.18. 
 

 
Рис.  6.18. График радиолокационного RCS для бистатического случая 

 
     По оси x этого графика – угол наблюдения θ (в градусах). 

 
Создание графика для моностатического  RCS. Последовательность 
создания графика моностатического RCS аналогична описанной выше для 
бистатического случая, за исключением одного важного момента. 
 



  87

1. Щелкните правой кнопкой мыши на значке Result в дереве проекта, и 
выберите Create Far Field Report>Rectangular Plot. Это открывает диалог 
характеристик (рис. 6.19). 
 
2.  В рамке Context, в разделе Geometry выберите Monostatic. 
 
3. В списке Category, выберите MonostaticRCS, а в списке  Quantity 
выберите MonostaticRCSTotal. 
 
5. Из списка Function, выберите dB. Тогда коэффициент отражения будет в  
dB. 
 
6. Выберите в поле X  характеристики IWaveTheta. 
7. Нажмите New Report. Это создает отчет и добавляет его в  дерево проекта. 
 

 
Рис. 6.19. Диалог для задания параметров графика в моностатическом 

случае 
 
В разделе Primery Sweep выберите переменную IWaveTeta (рис. 6.19). 
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Рис. 6.20. Зависимость RCS от угла падения падающей плоской волны 
(моностатический режим) 

 
 На рис. 6.20 показан пример зависимости RCS как функции угла 
падения плоской волны. Видно, что при углах падения 0º и 90º отражение 
максимальное, поскольку в этом режиме сторона куба становится 
перпендикулярно лучу падения.  
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7. Расчет ЭПР объекта большого электрического размера 
 

Для решения задач, в которых моделируются объекты, имеющие 
большие электрические размеры, используется метод интегральных 
уравнений. Для его обозначения в системе HFSS используется аббревиатура 
EFIE. Существенным отличием метода интегральных уравнений от метода 
конечных элементов, который долгое время был единственным методом 
решения электродинамических задач в HFSS, является то, что дискретизации 
в методе интегральных уравнений подвергается не пространство, а 
поверхность тела, рассеивающего электромагнитные волны. Очевидно, что 
при этом порядок системы линейных алгебраических уравнений оказывается 
существенно меньшим, чем в случае метода конечных элементов. 
Сокращение размерности системы позволяет в реальные сроки 
анализировать поля, порожденные объектами с большими электрическими 
размерами. Решение подобных задач с помощью метода конечных элементов 
не представляется возможным.  

Сравнивая два метода решения граничных задач электродинамики, 
следует отметить, что метод конечных элементов является более 
универсальным методом, который не имеет принципиальных ограничений 
на анализируемую структуру. Метод интегральных уравнений 
демонстрирует большую эффективность лишь в ряде случаев. Дело в том, 
что запись интегральных уравнений основана на знании функции Грина. В 
простой форме функция Грина известна только для ограниченного набора 
объектов, к которым относятся: однородное пространство, слоистые 
структуры с бесконечными слоями, бесконечный экран и т.д. Для них 
целесообразно использовать метод интегральных уравнений. 

Однако, как только речь идет об анализе объекта произвольной формы, 
например, диэлектрического тела сложной конфигурации, то преимущества 
метода интегральных уравнений становятся менее очевидными, так как 
формулировка указанных уравнений усложняется. По существу, приходится 
численно искать неизвестную в аналитическом виде функцию Грина, что 
требует существенных затрат компьютерных ресурсов. В результате 
эффективность двух методов становится сопоставимой. 

Рассеяние волн металлическими телами, расположенными в свободном 
пространстве относится к числу задач, для решения которых метод 
интегральных уравнений весьма эффективен, так как для формулировки 
граничной задачи достаточно знать только функцию Грина однородной 
среды, которая записывается в весьма простой форме.   

В этом проекте (RCS of an Ogive) с использованием метода 
интегральных уравнений рассчитывается  эффективная поверхность 
рассеяния (ЭПР)  металлического дирижабля. Дирижабль моделируется в 
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виде трехмерного объекта, являющегося телом вращения. Поверхность 
дирижабля создается путем вращения кривой вокруг оси 0х (см. рис. 7.1). 
 

 
 

Рис. 7.1. Модель дирижабля 
  

Структура анализируется на  частоте  1.18 ГГц. Она облучается 
плоской волной, падающей на структуру под углами ϕθ , . При этом угол  θ 
= 90o, а угол φ меняется от  0 до 180o  с шагом 2o. 

Будем рассчитывать ЭПР для случая моностатической радиолокации, 
когда точка наблюдения фиксрована. Результаты анализа в виде 
моностатического ЭПР  можно видеть на графике, на котором представлена 
зависимость ЭПР от угла облучения цели IWavePhi, изменяющегося от 0 до 
180º.  Наибольший коэффициент отражения, пропорциональный 
эффективной поверхности рассеяния, как предполагается, будет достигать 
при угле 90º. 

Рассмотрим далее последовательность создания модели дирижабля и 
ее анализа в системе HFSS методом интегральных уравнений. Модель 
создается следующим образом. Выбираем единицы черчения «in». В 
плоскости XOY чертится кривая, которая является образующей тела 
вращения. Создание кривой происходит с использованием уравнения в 
аналитической форме. Затем кривая вращается вокруг оси X, чтобы создать 
3-D объект. Черчение образующей дирижабля выполняется по команде 
Draw-> Create Equation Curve. По этой команде появляется диалог рис. 7.2, 
в котором задаются координаты кривой, зависящие от изменяемой 
переменной _t. 
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Рис. 7.2. Черчение кривой в пространстве с помощью уравнения кривой в 

параметрической форме 
 
 

Уравнение образующей дирижабля имеет следующий вид: 
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где x, y, z  определены в дюймах (inches), а α - угол образующей,  выбранный 

для данного случая равным 
06.22=α  (рис. 7.4). 

Единицы измерения длины по умолчанию могут быть сейчас изменены 
на дюймы,  но возможно их изменить позднее.  
 
1. Кликните Draw>Equation Based Curve. Появляется диалог Equation 
Based Curve (рис. 7.3). 
 

В качестве параметра используем переменную _t , которая совпадает с 
координатой х: x = _t. Уравнение для координаты y приобретает вид: 
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Углы вводятся в радианах. Нужно также задать единицы измерения 
длины, для чего мы умножаем каждое значение (x и y) на величину (1in). 
Итак, в диалоге Equation Based Curve, введите уравнения следующим 
образом (рис. 7.3): 
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             X(_t) = _t*(1in) 
             Y(_t) = (sqrt(1-(_t*sin(.3948)/5)^2)-cos(.3948))/(1-cos(.3948))*(1in)) 
             Z(_t) = 0 
 
           Зададим начальную точку Start _t =-5, конечную точку  End _t=5 и 
количество точек в линии  Points =24 (рис. 7.3). 
 

 
Рис. 7.3. Черчение образующей дирижабля 

 
Нажмите OK, чтобы увидеть кривую линию. 
Найдите в дереве History в разделе Lines ссылку Equation Curve1 и 

дважды щелкните по CreateEquationCurve. Это позволяет видеть окно 
Properties. Если линия не соответствует ожидаемому виду (рис. 7.4), то её  
можно отредактировать. 

В HFSS-IE криволинейные элементы отсутствуют. Таким образом, все 
изогнутые поверхности аппроксимируются сегментированными моделями. С 
учетом этого рекомендутся вводить требуемое число сегментов в поле 
Number of Segments. 
 

 
 

Рис. 7.4.  Черчение образующей объекта 
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2. Выберите  кривую EquationCurve1 и затем кликните Draw>Sweep 
>Around Axis. Появляется диалог Sweep Around Axis (рис. 7.5). 
 
3. В диалоге Sweep Around Axis выберите ось X, Angle of sweep = 360, и 
Number of segments = 24. Кликните OK. 
 
 

 
 
Рис. 7.5. Параметры вращения кривой для создания трехмерной модели 

 
Материал по умолчанию для этого объекта выберем, например, медь. 

Обычно дирижабли (рис. 7.6) делаются из алюминия. 
 

 
Рис. 7.6. Вид анализируемого объекта с направлением наблюдения 
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4. Выберите объект Ogive и в окне  Properties кликните copper в разделе 
Material и выберите  редактирование Edit... (рис. 7.7). Это откроет диалог 
выбора материалов. 
 

 
Рис.  7.7. Редактирования свойств материала 

 
5. В окне выбора материала выберите «aluminum» и кликните  OK. Создание 
модели закончено. Она не имеет воздушного бокса, так как в методе 
интегральных уравнений он не используется.  
 
Установка падающей плоской волны. Теперь нужно добавить источник 
падающей плоской волны. Мы будем рассчитывать моностатическую  RCS в 
плоскости x-y. Т.е. радиолокационный коэффициент отражения будем 
рассматривать, облетая дирижабль в плоскости xoy (рис. 7.6). 

Поскольку это моностатическая RCS, нужно будет включить ряд углов 
падения. Для получения точно картины, можно выбрать шаг изменения угла  
равный 3°. Падающая волна задается следующими шагами: 
 
1. Снимем выделение модели и правой кнопкой мыши выберем  Assign 
Excitation>Incident Wave>Plane Incident Wave из выплывающего меню. 
Откроется диалог Incident Wave Source: General Data (рис. 7.8). 
 
2. В этом диалоге выберем опцию Spherical для формата охвата дирижабля и 
оставьте положение фазового центра в точке (0,0,0). 
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Рис. 7.8.  Задание точки излучения плоской волны 

 
3. Кликните  Next и установите в окне Spherical Vector Setup (рис. 7.9) 
значения углов Iwave Phi:      Start = 0, Stop =180 и Step = 3. 
 
4 . Для  IWave Theta  выберите  Start = 90, Stop = 90 и Step = 0. 
 
5. Затем установим величины  Eo Vector Phi =1 и E Theta = 0. 
 

     
 

Рис. 7.9. Задание параметров сферы дальнего поля 
 

6.  Кликните  Next  и затем Finish.  
 
   Возбуждение задано. Падающая волна (Incident Plane) появляется в разделе 
Excitations в дереве проекта. Если вы выбираете её, то в окне появляется 
рисунок дирижабля с «веером» в виде рассчитываемых углов.     
    Эта установка на решение для падающих волн при  θ=90° и  
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для ϕ = 0 …  180°  (61 точка).     Поляризация определяется углом ϕ,  
направленным так, что мы можем рассчитать моностатический 
радиолокационный коэффициент отражения (monostatic RCS). 
 
     Теперь выполним установки на решение, для чего: 
 
1. Нажмите правой кнопкой на  Analysis в разделе IEDesign в окне 
менеджера проекта и выберите  Add Solution Setup, чтобы открыть диалог 
Solution Setup (рис. 7.10). 
 
2. В закладке  General измените частоту Frequency = 1.18 GHZ. Остальные 
параметры оставьте по умолчанию. 
 

           
Рис. 7.10.  Задание частоты расчета 

 
3. Просмотрите данные в закладке  Options  -   уплотнение разбиения на 
ячейки lambda refinement = 0.25 (=λ0/4). Установки на расчет завершены. 
 
     Чтобы запустить моделирование: 
 
1. Нажмите правой кнопкой мыши на Setup и выберите команду Analyze. 
2. Сохраните задачу и введите имя проекта. Моделирование выполнится за 
две итерации. 
 

Вывод тока на поверхности.  Чтобы увидеть ток на поверхности 
дирижабля (рис. 7.11): 
 

1. Выберите поверхность модели и задайте вывод распределения тока 
командой Fields>J>Mag_J. Это открывает диалог Create Field Plot. 
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Рис.  7.11.   Токи на поверхности дирижабля 

 
 

2. Кликните Done.  Вы должны видеть индуцированный ток, который 
наводится на металле  при воздействии плоской падающей волны. 

 
     Вывод графика моностатического RCS.     
    Чтобы графически изобразить RCS, сначала следует ввести установки 
дальнего поля  - аналогично тому, как делается в HFSS. Создадим установки 
дальнего поля только  с  одним углом φ = 0 ° и одним углом  θ = 90°.  
    Мы будем графически изображать зависимость моностатического RCS 
при изменении угла падения плоской волны phi. Поэтому каждой точке 
наблюдения соответствует только один угол (рис. 7.12). 
 

 
 

Рис. 7.12. График зависимости моностатического радиолокационного 
коэффициента отражения при изменении угла падения Phi 

 
 

    Чтобы вывести на график зависимость  моностатического RCS в 
зависимости от азимутального угла phi падающей плоской волны:      
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1. Кликните правой кнопкой на Radiation в дереве проекта и выберите  Insert 
Far Field Setup>Infinite Sphere... Появляется диалог Far Field Radiation 
Sphere Setup. 
 
2. Введите Start и  Stop для  Phi равными 0,  и  шаг 10º (рис. 7.13). 
 
3. Введите  Start и Stop для Theta = 90º и Step size =10º.  
 

 
 

3. Кликните OK. Это закроет диалог и создаст сферу InfiniteSphere1 в 
разделе Radiation в дереве проекта. 
 

 
Рис. 7.13. Задание сферы дальнего поля для расчета дальнего поля в одной 

точке. Устанавливается  один угол φ  и один угол Θ 
 
5. Чтобы создать график, кликните на Results в дереве проекта и задайте 
команду  Create Far Fields Report>Rectangular. Выберите характеристику 
Monostatic RCS (рис. 7.12). 
 
     Итак, в данном разделе рассчитан радиолокационный коэффициент 
отражения для объекта, размер которого намного больше длины волны. В 
расчете использован метод моментов, реализованный в программе  HFSS-IE.



  99

 
8. Полосовой волноводный фильтр 

 
      

    В этом разделе мы рассмотрим анализ с помощью HFSS полосового 
фильтра, который представляет собой широко использующуюся на практике 
гребенчатую структуру. Далее модель полосового фильтра мы будем 
использовать для иллюстрации дополнительных возможностей HFSS, таких 
как учет температурных зависимостей и режим подстройки Tune. 

     Синтез СВЧ фильтра можно выполнить, используя на первом этапе 
проектирования популярную программу Microwave Office  [6]. Утилита 
Synthesis Filter этой программы позволяет рассчитать обобщенные 
параметры, входящих в состав фильтра линий передачи, а также их размеры, 
реализующие заданные частотные характеристики. Отметим, что расчет 
геометрических размеров возможен только для линий передачи планарного 
типа: полосковых, микрополосковых и т.д. Аналогично анализ частотной 
характеристики фильтра в системе MWO можно осуществить только для 
полосковых конструкций. В тоже время на практике часто применяются 
гребенчатые фильтры на основе линий передачи с цилиндрическими и 
прямоугольными проводниками, которые имеют существенно более 
высокую добротность, чем полосковые линии. Анализ таких структур 
возможен средствами HFSS. 
   Выполним анализ трехмерного гребенчатого полосового фильтра (рис. 8.1) 
в полосе 0.6 ГГц …. 2.4 1 ГГц. Фильтр состоит из восьми штырей, каждый из 
которых является резонатором. На входе первого штыря подключена 
коаксиальная линия  передачи с характеристическим сопротивлением 50 Ом. 
 

 
 

Рис. 8.1. Вид фильтра в интерфейсе HFSS-13 
 
 



 100

    Гребенчатый полосовой фильтр имеет порядок, связанный с количеством 
резонаторов. От количества резонаторов зависит качество фильтра: 
неравномерность передачи в полосе пропускания, и спад коэффициента 
передачи вне полосы пропускания.  
 
   Длина отдельных резонаторов не превышает четверти длины волны, а часто 
заметно меньше за счет эффекта укорочения, возникающего благодаря 
концевой емкости между штырем и стенкой корпуса. Расстояние между 
штырями определяет коэффициент связи между резонаторами (рис. 8.2). 

 

 Рис. 8.2. Размеры гребенчатого фильтра 
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    При решении этого примера используются многие возможности 
программы  HFSS, включая расчет зависимости характеристик фильтра от 
температуры окружающей среды. Особенность метода Driven Terminal 
заключается в том, что порты здесь создаются как источники  относительно 
внешнего корпуса. 
 
Создание нового проекта.  Чтобы создать новый проект  кликните команду 
File>New New. Из меню Project, выберите команду Insert HFSS Design 
Design.  Чтобы установить метод решения, кликните  HFSS>Solution Type. 
Появляется диалог Solution Type (рис. 8.3), в котором выберите Driven 
Terminal.  
 

 
 

Рис. 8.3. Выбор метода расчета полосового фильтра 
 

Метод Driven Terminal рассчитывает S параметры для портов, которые 
образованы многопроводными линиями передачи (multi-conductor 
transmission line ports).  Элементы S-матрицы при этом определяются через  
напряжения и токи, что отличает ее стандартного энергетического 
определения матрицы рассеяния через волны мощности. Отметим, однако, 
что для линий передачи с ТEM – волнами (коаксиальная, симметричная 
полосковая и т.д.), оба определения матрицы рассеяния дают эквивалентные 
результаты. 
 
Создание трехмерной модели.  Установите единицы модели. Для этого 
выполните следующие действия: 
 
1. Кликните  Modeler>Units. Откроется диалог Set Model Units (рис. 8.4). 
2. Выберите: in (inches). 
3. Кликните OK. 
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Рис. 8.4. Установка единиц длины - дюйм (34.5 мм) 

 
 
     В этом примере при черчении будем применять ввод координат в линейке 
состояния, т.е. в виде цифр (рис. 8.5). Чтобы начертить трехмерную 
подложку: 
 
1. Кликните Draw>Box. 
2. Используйте поля ввода координат, вводя координаты точки A 
     ( X: -1.0,  Y: -1.7,  Z: -0.3125) в окне рис. 8.5,    нажимая каждый раз Enter. 

 
Рис. 8.5. Окна линейки состояния 

 
3 . Используя поля ввода координат, введем противоположный угол 
бокса     dX: 2.0,  dY: 3.4,  dZ: 0.0,     нажимая Enter. 
 
4.  Используя поля ввода координат, введем высоту подложки 
     dX: 0.0,  Y: 0.0, Z:  0.625,       нажимая  Enter. Корпус фильтра будет иметь 
вид, показанный на рис. 8.6. 
 

 
  Рис. 8.6. Размеры корпуса фильтра в дюймах (in) 

 
   Создание внешнего цилиндра входной коаксиальной линии. Чтобы создать 
внешний проводник коаксиальной линии: 
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1. Кликните  Modeler>Grid Plane>YZ, чтобы выбрать активную плоскость,  
     на которой будет чертиться основание цилиндра. 
2. Кликните  Draw>Cylinder. 
 
3. Используя поля ввода координат, введите центральное положение        X: 
1.0,   Y: -0.9,   Z: 0.0, и нажмите Enter. 

 
Рис. 8.7.  Поля ввода координат внизу интерфейса программы HFSS 

 
4 . Используя поля ввода координат, введите радиус цилиндра  R=0.14 in 
(рис. 8.7)        dX: 0.0,     dY: 0.14,     dZ: 0.0    и нажмите Enter. 

 
Рис.  8.8. Корпус фильтра и первый цилиндр коаксиальной линии 

 
5 . Используя поля ввода координат, введите высоту цилиндра 
           dX: 0.75,   dY: 0.0,     dZ: 0.0   и нажмите Enter. 
 
    В окне свойств установите имя   feed1 и оставьте цилиндр заполненным 
вакуумом (рис. 8.9). Кликните OK. 
 

 
Рис. 8.9. Выбор вакуума для заполнения пространства 

 
 
           Создание внутреннего проводника коаксиальной линии. Чтобы 
начертить внутренний  провод коаксиальной линии на входе фильтра: 
 
 
1. Кликните Draw>Cylinder. 
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2. Используя поля ввода координат, введите положение центра 
           X: 1.0,   Y: -0.9,      Z: 0.0      и нажмите клавишу Enter. 
3. Используя поля ввода координат, введите радиус цилиндра 
         dX: 0.0,   dY: 0.06,  dZ: 0.0     и нажмите  Enter. 
4. Используя поля ввода координат, введите  высоту цилиндра 
        dX: 0.75, dY: 0.0,     dZ: 0.0,    нажмите Enter. 
 
   Зададим имя этого цилиндра (рис. 8.10) как  feedpin1 и  материал его 
заполнения как PEC. 

 
 

Рис. 8.10. Внутренняя жила коаксиального ввода 
 
     Эта внутренняя жила имеет продолжение внутрь корпуса фильтра.   
Чтобы начертить внутреннюю линию коаксиальной линии (штырек): 
 
1. Кликните Draw>Cylinder. 
 
2. Используя поля ввода координат, введите положение центра 
        X: 1.0,       Y: -0.9,      Z: 0.0,      и нажмите Enter. 
3 . Используя поля ввода координат, введите радиус цилиндра 
       dX: 0.0,     dY: 0.06,   dZ: 0.0,      и нажмите Enter. 
4. Используя поя ввода координат, величине высоту цилиндра 
       dX: -0.15,  dY: 0.0,     dZ: 0.0,    нажмите Enter. 
 
    Задайте имя этого цилиндра feedprobe1. 
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Рис.   8.11. Штырек связи с фильтром 
 

Создание резонаторов 
 
   Резонаторы будут чертиться как металлические параллелепипеды. Для 
черчения параллелепипеда (рис. 8.12) задается точка, а затем размеры. Для 
создания резонатора с именем l1: 
 
1. Кликните Draw>Box. 
 
2. Используя поля ввода координат, введите положение бокса 
       X: 0.85, Y: -0.9625, Z: -0.03,   нажмите Enter. 
3 . Используя поля ввода координат, введите противоположный угол бокса 
      dX: -1.7, dY: 0.125, dZ: 0.06,    нажмите Enter. 
 

 
 

Рис. 8.12. Черчение первой линии фильтра 
 
    Для создания штыря фильтра с именем l2 (рис. 8.13): 
 
1. Кликните Draw>Box. 
2. В поля ввода координат, введите положения бокса 
        X: -1.0,       Y: -0.75,    Z: -0.03,  нажмите клавишу Enter. 
3. Далее введите координаты противоположного угла бокса 
       dX: 1.818,  dY: 0.125,  dZ: 0.06,  нажмите Enter. 
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Рис. 8.13. Черчение второй линии фильтра 
 
     Для создания третьего штыря фильтра с именем l3 (рис. 8.14): 
 
1. Кликните  Draw>Box. 
 
2. Используя поля ввода координат, введите точку параллелепипеда: 
    X: 1.0,        Y: -0.48,       Z: -0.03, нажмите Enter. 
3. Используя поля ввода координат, введите его размер по X: 
    dX: -1.818,  dY: 0.125,  dZ: 0.06, нажмите Enter. 
 

 
Рис.  8.14. Черчение третьей линии фильтра 

 
   Чтобы создать  четвертый резонатор l4 (рис. 8.15): 
 
1.  Выберите команду  Draw>Box. 
2. Используя поля ввода координат, введите позицию бокса: 
    X: -1.0,     Y: -0.2,      Z: -0.03 и нажмите Enter. 
3. Используя поля ввода координат, введите противоположный угол бокса: 
    dX: 1.818, dY: 0.125, dZ: 0.06, нажмите Enter. 
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   Задайте также имя этого элемента l4 в окне Properties и кликните OK. 
 

 

Рис. 8.15. Созданный четвертый 
резонатор фильтра 

Рис. 8.16. Выделенное сечение порта 

 
Создание волнового порта 

 
    В методе решения Driven Terminal порты создаются, с учетом опорной 
земляной поверхности.  Выделите фаску порта (рис. 8.16), для чего: 
 
1. Кликните команду Edit>Select>Faces (или нажмите F). 
2. Выберите внешнюю фаску коаксиальной линии при  X=1.75in. 
     
     Чтобы задать возбуждение на волновой порт: 
 
1. Кликните  HFSS>Excitations>Assign>Wave Port. Появляется диалог  
    Reference Conductors for Terminals (рис. 8.17). 
2. Задайте имя порта как p1. 
3. Выберите опцию для названия терминала Use port object name. 
4. Оставьте опцию Use as Reference (рис. 8.17) неотмеченной. 
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Рис.  8.17. Описание порта 
 

Рис. 8.18. Значок нагрузки в дереве 
проекта и диалог терминала 

            
5. Кликните OK.  В дереве проекта под Excitations появляется знак порта p1.   
В методе решение Terminal к каждому порту задается опорный импеданс. 
Поэтому одновременно c  портом появляется и значок нагрузки в дереве 
проекта (рис. 8.18).  
     Далее выполним вращение вокруг центра корпуса с копированием, для 
созданной части фильтра. Чтобы выбрать объекты для дублирования: 
 
1. Нажмите “O”.  По команде Edit>Select>By Name появляется диалог Select 
Object (рис. 8.19). 
 
2. Выберите в нем объекты с именами: feed1, feedpin1, feedprobe1, l1, l2, l3, 
l4, удерживая  Ctrl + Left. 
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Рис. 8.19. Диалог выделения объектов Рис. 8.20. Диалог вращения и 

дуплицирования части фильтра 
 
 
3. Кликните OK.  Чтобы создать оставшуюся часть штырей фильтра, 
выполним копирование с разворотом на 180º для чего кликните 
Edit>Duplicate>Around Axis, а затем в диалоге рис. 8.20 выберем: 

Axis: Z 
Angle: 180 
Total Number: 2 

 и кликните OK. 

 
 
Рис. 8.21. Дублирование половины элементов, с помощью вращения вокруг 
оси 
 
     Модель полосового фильтра примет вид, показанный на рис. 8.21. 

 
Просмотр граничных условий.   Чтобы проверить, как установлены 
границы, кликните HFSS>Boundary Display (Solver View).    После 
предварительного решения появляется диалог Solver View of Boundaries 
(рис. 8.22). В этом диалоге опцию видимости Visibility можно выбрать для 
границ, которые вы желаете увидеть. Отметим следующее: 
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- Земляная плоскость background (Perfect Conductor) показывается если 
отмечено имя outer (рис. 8.22). 
 

 
Рис. 8.22. Опции просмотра границ 

 
-  Все проводники, на которые назначены граничные условия Perfect 
Conductors будут показаны как граница smetal. 
     Кликните View>Visibility,  чтобы снять видимость каких-либо частей 
проекта.  Можно также изменить вид граничных условий и портов.  
Видимость объектов можно установить в диалоге, который появляется по 
команде View->Active View Visibility (рис. 8.23). 
 

 
Рис. 8.23. Выбор режима видимости объектов, входящих в проект 

 
    Просмотр видимости граничных условий и объектов позволяет проверить 
верность создания конструкции. Нажмите также HFSS->Validate Check, 
чтобы запустить валидатор проверки геометрического построения задачи. 
Если после проверки валидатора замечаний нет, то можно выполнять 
установки на анализ. 
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     Установки на анализ.    Кликните HFSS>Analysis Setup>Add Solution 
Setup. Появляется диалог Solution Setups (рис. 8.24). В закладке General 
сделайте  установки, показанные на рис. 8.24. 
 

 

Рис.  8.24.Добавление расчета в 
диапазоне частот 

 

Рис. 8.25. Задание расчета в 
диапазоне частот методом 
быстрой развертки 

 
 
    Для  расчета в диапазоне частот кликните  HFSS>Analysis Setup>Add 
Sweep. Появляется диалог Edit Sweep, в котором зададим параметры, 
указанные на рис. 8.25. 
 
Расчет характеристик полосового фильтра.  Чтобы запустить 
процесс решения, кликните  HFSS>Analyze.   Чтобы увидеть процесс 
решения и диалог Solution Data: 
 
1. Кликните HFSS>Results>Solution Data. Появляется диалог Solution Data. 
 
2. Откройте закладку Profile, чтобы видеть файл решения. 
 
3. Откройте закладку Convergence,  чтобы видеть данные о сходимости 
решения. Сходимость можно видеть в  табличном виде (Table Table), или в 
графическом представлении (Plot). 
 
4. В закладке  Matrix Data можно видеть матрицу. Причем, чтобы увидеть 
изменение данных матрицы Matrix Data во время расчета, в  Setup1 выберите 
Last Adaptive. 
 
5. Кликните закладку  Mesh Statistics, чтобы видеть данные о сетке 
разбиения. 
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    Расчет будет выполнен на средней частоте 1.5 ГГц и  в диапазоне частот 
от 0.6 до 2.4 ГГц. С разверткой типа Fast выполнится расчет в тех частотных 
точках, где характеристики фильтра изменяются с большой скоростью.  
 
    Вывод характеристик на графики.  Чтобы вывести частотные 
зависимости S-параметров фильтра от частоты: 
 
1. Кликните HFSS>Results>Create Terminal Solution DataReport> 
    Rectangular Plot.  Открывается диалог Reports. 
2. Задайте следующие опции: 

   Solution: Setup1: Sweep1 
   Domain: Sweep 
   Quantity: St(feed1_T1,feed1T1); St(feed1_T1,feed1T2) 
   Function: dB 

3. Кликните кнопку  New Report. 
4. Нажмите  Close.  
 

 
 
Рис. 8.27. Частотная характеристика волноводного гребенчатого фильтра 
и добавление маркеров на график 
 
    Затем можно прибавить другую характеристику St(feed1_T2,feed1_T1) в  
dB, нажимая кнопку Add Trace и затем кнопку Done. 
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Рис.  8.28.Частотные характеристики фильтра 

 
    Для удобства просмотра графика можно изменить  масштаб. Для этого 
сделайте следующее: 
 
1. Дважды кликните на  Y-axis. Появляется диалог свойств Y-оси. 
 
2. Кликните закладку  Scaling, в которой установлены опции: 

Autoscale: Снимите эту опцию 
Min: -1.0 
Max: 0.0 

 
3. Кликните  OK. В этом случае можно более точно увидеть изменение 
коэффициента передачи в полосе пропускания фильтра. 
 
Просмотр поля внутри фильтра.   В данном фильтре нужно 
установить источник, который имеет внутреннее сопротивление. Такой 
источник называется Terminate Port.   Чтобы установить нагрузки порта: 
 
1. Кликните HFSS>Fields>Edit Sources. Появляется диалог Edit Sources, в 
котором сосредоточены данные о всех источниках проекта. В этом диалоге 
выберите: 

Select source: p2:T1 
Terminated: Checked 
Resistance: 50 
Reactance: 0 

4. Кликните OK. 
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Рис.  8.29. Редактирование источников, включенных в проект 
 
   Вывод рассчитанного поля в сечении.  Выберите плоскость 
XoY, активизируя Global XY Plane. 
 
1. Используя  Model Tree,  разверните папку  Planes. 
2. Выберите  плоскость Global: XY. 
3. Кликните  HFSS>Fields>Fields>E>Mag_E. Открывается диалог Create  
    Field Plot, в котором нужно выбрать: 

Solution: Setup1 : LastAdaptive, 
Quantity: Mag_E, 
In Volume: All. 

4. Кликните кнопку  Done. 
 
     Если нужно изменить вид графика поля, например подчеркнуть слабые 
поля,  кликните HFSS>Fields>Modify Plot Attributes.  Открывается диалог 
Select Plot Folder. 
 
    Выберите E Field, а затем следующие опции в диалоге E-Field1 

Откройте закладку Scale. 
Выберите  Use Limits, и установите: 

                Min: 5, 
               Max: 1500, 
               Scale: Log. 

 
    Кликните  Close. Поле на поверхности приобретает более понятный вид 
(рис. 8.30), в котором можно оценить и резонансные явления в фильтре. 
 
 

 
Рис.  8.30. Вид поля в среднем сечении фильтра 
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    Итак, в этом разделе было выполнено черчение и расчет трехмерного 
фильтра на штырях. Чтобы выполнить дальнейшую оптимизацию фильтра, 
нужно задать переменные, выбрать метод оптимизации и целевую функцию. 

      Объекты, которые используются как компоненты в проектах комплекса 
Ansoft,  которые размещены в интерфейсе схем (Workbench Project Schematic) 
можно  рассматривать как системные. В комплексе Ansoft программы, 
которые служат для решения схемных и системных задач, это: Rmxprt 14.0, 
Designer 6.1, и Simplorer 9.0. Такие продукты Ansoft, как HFSS 13.0, Maxwell 
14.0 и Q3D Extractor служат для электродинамического решения структур.  
Если вы вызываете  ANSYS DesignXplorer  (рис. 10.31), то переменные 
любого проекта также экспортируются в проект и доступны из интерфейса 
Workbench.   

 

Рис.  8.31. Добавление режимов решения и оптимизации 

     Все продукты  Ansoft объединяются в общем интерфейсе Workbench 
команды, управления и т.д.   Одна из возможностей, имеющихся в HFSS v.13 
– расчет температуры.  Эти возможности будут описаны в следующей главе. 
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     9. Учет температурных режимов  в HFSS 

 
 
 
Учет влияния температуры на параметры СВЧ систем является 

комплексной задачей, которая допускает разные формулировки. Первая 
формулировка состоит в учете зависимости от температуры окружающей 
среды, которая задает температуру СВЧ устройства и сказывается на 
параметрах материалов, формирующих ее, а также на размерах ее элементов. 
В такой постановке задача является линейной, поскольку обратная связь, то 
есть влияние СВЧ мощности на температуру объекта не учитывается.  

В рамках второй формулировки необходимо рассчитать температуру 
объекта с учетом нагрева, обусловленного воздействием на него достаточно 
мощного СВЧ сигнала. Этот подход связан с расчетом параметра SAR 
(Specific Absorbtion Ratio). При расчете этой характеристики сначала 
определяются потери в материале, а затем находится относительная 
величина поглощаемой в нем мощности. Следовательно, температура будет 
зависеть от мощности генератора. 

Наконец, третья формулировка требует учета не только изменений 
температуры из-за воздействия на объект СВЧ сигнала, но и изменений его 
параметров, обусловленных СВЧ нагревом. 

В этом разделе мы рассмотрим некоторые возможности HFSS, 
связанные с температурным режимом и его изменениями. 

Описание зависимости материалов от температуры. Рассмотрим 
возможность учета зависимостей параметров материалов от температуры. 

Каждый материал, включенный в проект, может  быть описан 
зависимостями своих характеристик от температуры. Эта зависимость может 
быть применена к любым свойствам материала: диэлектрической 
проницаемости,  проводимости и пр. Зависимость может быть задана в 
табличном виде, а может быть задана в виде формул. 

Нужно также задать температуру каждого объекта. По температуре 
HFSS рассчитывает характеристики материалов. Используя эти значения, 
рассчитываются СВЧ характеристики системы. Таков порядок учета 
температуры нагрева объектов в HFSS.  

 
Командой Edit-> View Edit Material вызовем диалог рис. 9.1, в 

котором: 
 
 1. Отметим режим Thermal Modifier в разделе View/Edit Modifier for.  
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Рис. 9.1. Включение температурных характеристик в свойства описания 
материалов 

     В этом случае таблица свойств материалов Properties of the Material  будет 
расширена и включен столбец Thermal Modifier.  

2. Выберите Edit... из выплывающего меню, или None. Появляется диалог  
Edit Thermal Modifier. 

3. Выберите  кнопку  Expression, чтобы вывести текстовое поле Parameters 
Modifier  или кнопку Quadratic, чтобы показать таблицу для Basic 
Coefficient Set и Advanced Coefficient Set. 

   В случае описания зависимости в виде выражения Expression, можно 
записать уравнение для температурной зависимости в поле Parameters 
Modifier.  

  Отметьте опцию Use temperature dependent data set  в поле  Modifier text 
field.  Теперь можно зависимость характеристик от температуры ввести в 
виде табличного набора данных Add/Import Dataset.  

   Если выбрана опция  Quadratic,  в закладке Basic Coefficient, можно 
отредактировать поле для TempRef и единиц, и поля для  C1 и C2 для 
следующего уравнения: 

P(Temp) = Pref[1+ C1(Temp - TempRef) + C2(Temp - TempRef)^2], 

где  Pref  определяется как относительная диэлектрическая проницаемость 
(например). В этой формуле P-параметр. 
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• Если выбрана опция Quadratic, то в закладке Advanced Coefficient Set 
(рис. 9.2),  можно установить нижнюю и верхнюю границу температуры  (TL 
и TU соответственно). 

 

Рис. 9.2. Выбор верхней и нижней границ изменения температуры 

    По умолчанию, они рассчитываются автоматически. Сняв опцию Auto 
Calculate TML, TMU¸ можно ввести новые величины нижней  (TML) и 
верхней границ изменения температуры (TMU). 

Установка температуры объектов. Чтобы установить температуру объекта: 

1. Используйте команду  HFSS или HFSS-IE>Set Object Temperature,  
чтобы вывести диалог Temperature of Objects (рис. 9.3).  

   В этом диалоге  сводится в таблицу объекты проекта. В первом столбце 
перечисляется имя объекта, затем материал,  затем режим включения опции 
свойств зависимости температуры, затем единицы температуры.  
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Рис. 9.3. Диалог включения температурных зависимостей отдельных 
объектов структуры в температурный анализ 

2. Чтобы редактировать свойства, отметьте опцию  Include Temperature 
Dependence.  Это делает возможным выделять объекты и устанавливать на 
них температуры. Заголовки столбцов для Object Name и столбцов  Material  
включают стрелки для направления сортировки. Можно инвертировать 
направление сортировки, нажимая на заголовок каждого столбца.  

   Если список большой, можно использовать поле Select by name. Введите 
имя объекта и нажмите Select. Выбранные объекты высвечиваются. Вы 
можете сделать несколько выборов. 

3. Чтобы установить температуру на выбранный объект или объекты, введите  
переменную или конкретную величину, или выберите существующее имя в 
поле текста. 

4. Выберите единицы из столбца Unit. 

5. Кликните Set, чтобы применить эту величину к выбранному объекту, или 
кликните Set Default чтобы установить это значение по умолчанию.   Если 
нажать Set Default, то столбец для выбранных объектов покажет величины 
их температур. 

6.  Чтобы отредактировать материал для объекта, когда диалог закрыт, вы 
можете кликнуть на столбец материала, и увидеть список в выплывающем 
меню материал и кнопку Edit....  
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   По команде HFSS->Set Object Temperature можно установить температу-
ру на объект. 
    После расчета температурного распределения, его можно вывести в виде 
поля командой Fields->Plot Fields->Other…->Temperature (рис. 9.4). 

 
 

 
 
Рис. 9.4. Вывод поля распределения температуры в корпусе рупорной 
антенны 
     
    Диалог температуры показан на рис. 9.5.  Отметим однако, что полноцен-
ный расчет температурной зависимости с учетом линейного расширения 
материалов и т.д. выполняется в комплексе ANSYS. 
 

 
Рис.  9.5. Диалог вывода карты распределения температуры 
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     В дереве проекта интерфейса ANSYS находятся опции и операции, 
которые предназначены для связи температурных характеристик объектов 
(рис. 9.6). 
 

 

Рис. 9.6. Дерево проекта в программе ANSYS Mechanical 
 

 

Возможность обратной связи по температуре между ANSYS 
Mechanical и HFSS.     

    Эта  опция появляется в  закладке Advanced    в  диалоге  Solution  Setup.  
Откройте эту закладку, если вы хотите использовать двунаправленную 
термальную связь между  HFSS или Maxwell и интерфейсом ANSYS. Вы 
должны сделать этот выбор перед запуском на решение (рис. 9.7). Тогда 
у  вас  будет  возможность  двунаправленной  передачи  данных  о 
распределении  температуры  из  интерфейса  ANSYS  Workbench  к  HFSS 
или Maxwell. 
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Рис. 9.7. Опция включения температурных параметров  

     

   Перед тем, как решать задать  на  HFSS или Maxwell, для этого типа 
объекта, вы должны поставить начальные величины для температурной 
зависимости объектов (рис. 9.8). 

 
Рис. 9.8.  Задание начальной температуры на каждый объект с 

учетом температурной зависимости 
 
 
    Если вы отмечаете опцию Enable Thermal feedback from ANSYS 
Mechanical, будет создаваться поддиректория с расширением .THM в папке 
Solution, включенной в проект, когда  будет осуществляться импорт данных 
через интерфейс из  HFSS или Maxwell.  В этой директории, записывается 
новый файл centroid.xml (рис. 9.9), чтобы использоваться  в будущем выводе 
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распределения температуры.  Программа  ANSYS Workbench 12  
последовательно экспортирует информацию о температуре в файл, 
называемый  mechanical.ths в той же самой директории Project. 
 

 
Рис. 9.9. Место расположения файлов с данными о температуре 

 

      В интерфейсе ANSYS Workbench 12 имеется команда Export Results. 

 
   Расчет температурного распределения с помощью связи с 
программой ANSYS Thermal.   
    После решения проекта на HFSS 13 или Maxwell, с установкой опции 
“Enable Thermal Feedback from ANSYS Mechanical”  в закладке Advanced 
установки на анализ,  и после выполнения связанного термоанализа в 
ANSYS Workbench 12, вы можете получить распределение температуры  из 
теплового решения. ANSYS Workbench 12 запишет файлы обратной связи 
непосредственно в директорию Project Solution HFSS, или Maxwell 
C:\Ansoft\HFSS13.0\Help\hfss. chm::/savinganewproject. htm > каталог.  
     В этом случае: 

1. Откройте проект в HFSS или Maxwell.  

2. Запустите на анализ этот проект, автоматически используя обратную связь 
от ANSYS Workbench 12. 

    Не нужно делать никаких дополнительных изменений к установкам 
решения в HFSS или Maxwell.  Просто запустите анализ командой Analyze. 
HFSS или Maxwel знает, что в решении нужно использовать информацию об 
измененной температуре.    HFSS или Maxwell выдаст измененные 
результаты, основанные на новом температурном распределении, которые 
могут быть импортированы ANSYS Workbench 12 через созданную ранее 
ANSYS  Termal Link. Чтобы сделать это, выполните следующее: 

1. Закройте проект HFSS или Maxwell. 
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2. В интерфейсе ANSYS Workbench 12, очистите командой  Clean ранее 
импортированные данные.  

3. Импортируйте новый результат из HFSS или Maxwell. 

4. Запустите термальное моделирование снова (рис. 9.10).  

 

 

   Рис.  9.10. Расчет температурных характеристик с помощью Re-solving 
After ANSYS Thermal Link Feedback 
      
    В закладке  Edit Thermal Modifier  можно установить нижнюю и 
верхнюю границу, в которых будет верна квадратичная зависимость 
изменения температуры, заданная выше. 

 
    После окончания расчета, нужно выделить объект (рис. 9.11), на котором 
мы хотим вывести поле и значения температур,  и затем зададим команду 
HFSS -> Set Object Themperature. 
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Рис.  9.11. Вывод поля температуры на плоскости анализируемых объектов 
    
    В разделе Field появляется раздел температуры на объекте (рис. 9.12). 
 

 
 

Рис. 9.12. Иконка в дереве проекта, которая показывает сохранение 
распределение температуры 

 
    Таким образом, система Ansoft, включающая программы 
электродинамического анализа и программы механического анализа 
конструкций в температурном режиме, позволят выполнить 
электродинамический анализ в условиях изменения геометрии при 
изменении температуры. Для решения таких задач нужна специальная 
лицензия. 
 
 

 
 



 126

 
 

10. Реализация режима подстройки в HFSS 
 
    В ранних версиях HFSS было несколько опций, позволяющих 
оптимизировать анализируемую конструкцию. Часто использовалась 
операция перебора, когда изменяется один, или два параметра, а остальные 
остаются неизменными. Для решения такой задачи программа HFSS для 
каждого перебираемого параметра полностью решала электродинамическую 
задачу. В версии HFSS-13 появилась возможность решить эту задачу 
быстрее и эффективней операцией Tune, так, что после решения можно 
будет менять вручную движок со значением параметра, и тут же видеть, как 
меняются характеристики анализируемого устройства. 
 
     Для того, чтобы реализовать операцию Tune, сначала нужно иметь 
переменные в проекте. Тогда в диалоге Solution Setup появляется закладка 
Derivative, в которой нужно отметить, что программа должна найти 
производные, т.е. приращение функции в зависимости от изменения 
аргумента.  После расчета с такой опцией, производные используются через 
команду Tune Report для мгновенного вывода и  исследования малых 
вариаций конструкции, без необходимости повторного решения. 
"Номинальное" решение, плюс производные содержат всю информацию, 
необходимую, чтобы узнать, как меняются характеристики при небольших 
изменениях параметров конструкции. 
   Рассмотрим пример F-образной пач-антенны (рис. 10.1). Она состоит из 
изломанного в виде буквы F вибратора, который закорочен с земляной 
платой на правом конце и имеет разомкнутую линию на другом. 

 
Рис. 10.1. Вид сбоку на планарную F образную антенну с подстраиваемым 

положением порта 
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Рис. 10.2. Вид сверху на планарную F-антенну 

 
 

Питание от дискретного источника поступает в антенну через 
цилиндрический провод с радиусом 1 мм. Пусть переменной является 
смещение точки питания F-образной антенны (равное 4.8 мм на рис. 10.2). 
Положение точки питания определяет ее входное сопротивление на 
центральной частоте рабочего диапазона. 
 
     Чтобы  HFSS рассчитал производные для какой-либо переменной, нужно: 
 
1. Открыть закладку  Derivative в диалоге Solution Setup (рис. 10.3).  
2. Для переменной feed_pos, которая будет подстраиваться, выбрать опцию 
Use. 
 

 
Рис. 10.3. Установка опции для расчета производной feed_pos 

 
 
     В этом режиме будут рассчитываться производные по параметру 
feed_pos, и после выполнения расчета можно будет командой Tune Report 
меню Result видеть изменения S-параметров при варьировании положения 
точки питания антенны. Эта возможность не относится к частотам и 
ближним полям. 
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      Создание модели F-образной антенны. В глобальной системе координат 
построим основание антенны. Командой Create -> Box начертим бокс, 
параметры которого показаны на рис. 10.4. 
 

 
 

Рис. 10.4.  Основание  антенны  высотой 5 мм. 
 
   Далее начертим верх планарной антенны операцией Draw->Box, с 
размерами, показанными в диалоге рис. 10.5. 
 

 
 

Рис. 10.5. Верх пач-антенны толщиной 1 мм 
 

    Цилиндр коаксиальной линии, положение которой меняется при 
изменении переменной feed_pos создается операцией Draw->Cilinder, и 
размеры его можно откорректировать в диалоге рис. 10.6. Положение центра 
можно будет изменять, вводя параметр feed_pos. 
 

 
Рис.  10.6. Параметры цилиндра 
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    Внутренний штырь имеет радиус R=0.8 мм, так что создадим командой 
Draw->Cilinder  и внесем в диалог значения: (10,0,1),  0.8,  8, 0. Охватим 
модель антенны боксом, которую начертим командой Draw Box (рис. 10.7) и 
на поверхность которой установим граничное условие Radiate. 
 

 
 

Рис.  10.7. Размер бокса излучения, который охватывает антенну 
 

   В нижней части коаксиальной линии поставим порт, выделяя поверхность 
цилиндра (рис. 10.8). 
 

 
Рис.  10.8. Установка порта в сечении коаксиальной линии 

 
  Теперь зададим задание на расчет в диапазоне частот 1.5 ГГц – 2 ГГц (рис. 
10.9). Режим Interpolating позволит отследить резкое изменение 
характеристик. 
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Рис.  10.9. Задание диапазона частот в режиме интерполяции 
 
    Нажмите Start. После выполнения расчета зададим вывод характеристики 
partial MagS(1,1,feed_pos) на двумерный график (рис. 10.10), а затем в 
разделе производной Derivative (рис. 10.11) выбрать переменную feed_pos. 
 

 
 

Рис. 10.10. Опции 
вывода 

характеристик 

Рис. 10.11. Выбор характеристики 
TuneS(1,1,feed_pos) 

 
 
 
    Теперь нужно открыть операцией Tune Report  диалог Report Tuning  
(рис. 10.12). Она находится в разделе Results. 
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Рис. 10.12. Наблюдение процесса смещения частотной характеристики 

антенны при изменении положения точки питания 
 
   Изменяя положение слайдера в окне Report Tuning, можно изменять 
положение точки питания антенны, и таким образом видеть, как при этом 
изменяется частотная характеристика. 
 

 
Рис. 10.13. Вывод характеристики по оси y 

 
   После выполнения подстройки можно для заданного положения смещения 
точки питания рассчитать характеристики дальнего поля. Пространственная 
диаграмма направленности F-образной антенны показывается на рис. 10.14. 
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Рис. 10.14. ДН планарной антенны 

   Итак, в этом разделе мы познакомились с такой операцией, как 
подстройка.  Кроме этого, в HFSS можно выполнить оптимизацию 
геометрии по заданной целевой функции, в которую включаются 
характеристики антенны. 

   В HFSS-13 реализованы градиентные методы поиска минимума целевой 
функции Quasi Newton, симлекс-метод, и методы случайного поиска Pattern 
Seach и Genetic Algorithm (генетический алгоритм).  
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11. Моделирование коннектора 
 
 
    В этом примере рассчитываются характеристики связанных линий 
сложной формы. Две крайние линии коннектора (римс. 11.1) замкнуты 
накоротко с земляной плоскостью. 
 
    Этот проект Connector  находится в папке Examples и выполняется 
методом Driven Terminal.  В конструкции имеется 4 порта, соединенные 
искривленными проводами. Земляная плата единая для всех портов, и 
находящихся внизу, и находящихся вверху конструкции. 
 

 
Рис.  11.1. Конструкция связанны 4-х искривленных линий 

 
    Коннектор (рис. 11.1) имеет дискретные порты на каждом конце двух 
внутренних окончаний искривленных проводников (pin).  Два внешних 
проводника заземлены с обеих сторон. Крайние параллелепипеды крепления 
(подложки) заполнены материалом  FR4. Граница излучения Radiate 
прикладывается к окружающему боксу.  
 
    Расчет выполняется с адаптацией сетки разбиения на центральной частоте  
5 ГГц.  Выберем метод расчета Driven Terminal (рис. 11.2) и единицы 
изменения мм.  
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Рис. 11.2. Выбор метода расчета 

 
   Все проводники в этом коннекторе созданы как трехмерные объекты из 
меди. В готовый проект Connector  в папке Examples установим порты и 
граничные условия. Порты и терминалы размещены в подложках FR4, 
которые расположены над и под связанными линиями (рис. 11.3). 
 

 
Рис. 11.3. Задание портов и терминалов 

 
   Порты наносятся на прямоугольные плоскости, а сверху на ребро 
устанавливаются терминалы (рис. 11.4). Особенностью метода Driven 
Terminal является то, что в одном сечении можно задать несколько портов с 
общей земляной шиной. 
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Рис. 11.4. Порты 1 и 2 и терминалы, слева и справа – КЗ 

 
    Установим порты 1 и 2 на средние площадки  (рис. 11.4). Порты 3 и 4  
подключены к этим же линиям, которые начинаются портом 1 и 2, но с 
другой стороны связанных линий (рис. 11.5). 
 

 
 

Рис.  11.5. Установка портов между проводником и земляной платой 
 

    Выведем диалог определения земляной платы (рис. 11.6) командой Assign 
Automatic. 
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Рис.  11.6.  В диалоге указывается, что проводник gnd  становится 
референсной плоскостью для всех проводных линий 
 
   Выбор опции «gnd» как “Use as Reference” показывает, что плата «gnd» 
устанавливается как земляная для всех проводов, для всех портов. 
       Расчет в полосе частот выполним методом интерполяции, так, что расчет 
выполняется от постоянного тока DC до верхней частоты  5 ГГц. 
 

 
Рис.   11.7. Вид соединителя коннектора 
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Рис.   11.8. Установки на решение 

 
       Для расчета в диапазоне частот зададим команду Add Sweep, выберем 
режим Interpolating и зададим частоты от 0 до 5 ГГц с шагом 0.01 ГГц (рис. 
11.9).  
 

 
 

Рис. 11.9. Задание диапазона частот анализа 
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    После запуска на счет, можно видеть процесс решения, нажимая правой 
кнопкой мыши на Setup1 и выбирая  Profile чтобы открыть диалог Solution. 
Данные о решении можно видеть в разделе  Convergence, Matrix Data, и 
Mesh Statistics. Можно видеть S матрицу, а также характеристики портов 
(рис. 11.10). 
 
 

 
Рис.   11.10. Рассчитанная S-матрица коннектора 

 
 
   Частотные зависимости S параметров можно вывести на декартовую 
систему координат, добавляя график в разделе  Results (рис. 11.11). 
 

 
Рис. 11.11. Частотная характеристика S параметров 

 
    Из частотных характеристик рис. 11.11 можно сделать следующий вывод: 
линии имеют хорошее согласование, однако связь между отдельными 
линиями значительная. Так, связь между рядом идущими линиями |S23|= 0.8.  
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Рис. 11.12. Электрическое поле в сечении выводов коннектора 
 
 
   В заключение этого раздела отметим, что метод Driven Terminal 
применяется в том случае, когда  имеется несколько линий, связанных и 
имеющих одну земляную опорную основу. 
 

 
Рис.  11.13. Рассчитанное поле E  в сечении линий передачи, при 

возбуждении 1-го порта 
 
    Для того чтобы наблюдать и исследовать распространение поля при 
возбуждении какого-либо порта, или волны определенного типа в этом 
порту, нужно задать команду Edit Source и вывести диалог рис. 11.14, в 
котором выбрать модули и фазы источников, действующих в проекте. 
 

 
Рис.  11.14.Установка источников возбуждения на портах 
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Дискретные порты, реализованные в HFSS-IE.   В HFSS-IE 
реализованы дискретные порты, которые в методе HFSS-IE отличаются от 
аналогичных портов  в HFSS. В дискретный порт в HFSS-IE устанавливается 
напряжение, равное 1 Вольт между терминалом и его опорным выводом на 
земляной плоскости, в то время как дискретный порт в HFSS  задает 
электрическое поле на площадке.      Дискретные порты (рис. 11.15) подобны 
традиционным волновым портам, но могут быть размещены внутри 
структуры и должны иметь заданный пользователем комплексный импеданс. 
Дискретные порты рассчитывают S-параметры в сечении порта.   

 

   
Этот порт является 
внутренним к области 
решения. Прямоугольник, 
на который ставится порт 
подводится к сигнальной 
линии, а с другой стороны 
касается земляной платы 

Этот порт является 
внутренним к области 
решения. С одной стороны 
прямоугольник касается к 
сигнальной линии, а с 
противоположной – с 
земляной платой 

Этот порт внутренний к 
области решения. Порт 
устанавливается на круг 
вокруг шара  

Рис.11.15. Реализация портов в HFSS-IE 
 

      Дискретный порт может быть задан на прямоугольнике, идущем от края 
линии до земляной платы (рис. 11.15). На всех ребрах дискретного порта, 
которые не соприкасаются с металлом или с другими границами, должно 
быть установлено граничное условие Рerfect H.  Эти установки зависят от 
того, какой режим выбран:  modal или terminal.   Важно отметить 
следующее: 
•  комплексный импеданс порта должен быть ненулевым, и сопротивление 
должно быть неотрицательным. 
• позволяется только одна мода, или только одна нагрузка (терминал), если 
решение выполняется в режиме terminal. 
• для сигнальных портов должна быть определена интегральная линия. 
• каждая нагрузка должны быть подключена к границе с идеальной 
проводимостью или бесконечной земляной плате. 
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             Считать, что порт создан верно можно только в случае, если 
максимальное расстояние от терминала до земляной платы меньше одной 
двадцатой длины волны. Если это условие нарушается, появляется 
предупреждение. 
 
    Современные цифровые устройства работают на частотах СВЧ. 
Характеристики линий передачи между процессорами и цифровыми 
блоками влияют на быстродействие компьютеров. Немаловажной является 
задача создания суперкомпьютеров, когда десятки, сотни компьютеров 
связаны в один суперкомпьютер. Поэтому одна из актуальных современных 
задач состоит в моделировании и проектировании линий связи в цифровых 
системах и устройствах. 
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12. Антенна, смонтированная на мачте 

 
 

Этот пример решается методом интегральных уравнений, который 
реализован в блоке HFSS_IE. Этот метод позволяет анализировать 
структуры больших электрических размеров.  

Рассмотрим в качестве примера антенну, установленную на 
металлической мачте. Она состоит из трех вибраторных антенн  (рис.12.1). 
Мачта расположена  на бесконечной заземляющей плоскости.  
 

 
 

Рис.  12.1. Антенна на алюминиевой матче 
 

Мачта имеет высоту 3.1 м. Вибраторы моделируются как 2-D объекты с 
границей PerfE. Возбуждения – дискретные порты. Крепежная структура 
моделируется полистироловыми держателями. Мачта стоит на проводящей 
земле, поэтому в проекте устанавливается активная опция бесконечной 
земляной платы InfGndPlane1 в разделе граничных условий (рис. 12.1). 

    Создаем новый проект, нажимая на . Выбираем единицы длины см в 
диалоге (рис. 12.2), вызываемой командой Modeler -> Units. 
 

 
Рис. 12.2. Единицы длины для черчения объектов 
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   Опции метода решения  HFSS-IE можно установить в диалоге рис. 12.3, 
которая вызывается командой HFSS->Options.  
 

 
Рис. 12.3. Установки опций метода HFSS-IE 

 
    Начертим мачту с высотой 270 см,  сечением 20 см x 20 см (рис. 12.4) и 
заполним материалом из библиотеки: алюминий. 
 

 
 

Рис.  12.4. Диалог параллелепипеда – мачты антенны 
 

    Далее начертим штырь командой  Draw -> Rectangle Poligon,  задавая 
число сегментов 8, создавая сначала  восьмиугольник, а затем превращаем 
его в трехмерный объем, протягивая по оси Z (рис. 12.5) командой Draw-> 
Sweep-> Along Vector на высоту 40 см. 
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Рис. 12.5.  Диалог, в котором редактируются размеры антенны-мачта 

    
    Этот штырь будет из полистирола с ε=2. Далее выполним черчение 
полистироловых держателей (рис. 12.6). Размеры первого приведены на рис. 
12.6. 
 
 

 
 

Рис. 12.6. Полистироловые держатели 
 
   Создание трех полистироловых держателей выполним командой Edit -> 
Copy. 
 
   Далее переведем плоскость черчения в YOZ и выполним черчение 
вибраторов антенн (рис. 12.7) в виде прямоугольников командой Draw -
>Rectangle. 
 



  145

 
Рис. 12.7.  Диалог вибратора антенны 

 
Вибраторы состоят из двух плеч, между которыми установлен 

дискретный порт. Площадку для порта также чертим как прямоугольник 
командой Draw->Rectangle.  Геометрические параметры порта показаны в 
диалоге рис. 12.8. 
 

 
Рис. 12.8.  Параметры площадки для дискретного порта вибраторной 

антенны 
 
   Антенна на мачте стоит над бесконечной землей. Этот факт отражается 
тем, что в проект вводится земляная плата бесконечного размера (рис. 12.9) 
командой HFSS IE -> Boundary-> Assign-Infinite Ground Plane. 
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Рис. 12.9.  Антенна на 
мачте 

Рис. 12.10. Задание бесконечной земляной 
плоскости

 
     Земляная плата всегда задается в плоскости XOY. В диалоге рис. 12.10 
вводится координата по Z и шероховатость поверхности, от которой зависят 
потери земляной платы. Материал ее можно задать, нажимая на кнопку 
Select Material. 
   Задание на моделирование создается командой Add Solution, по которой 
выводится диалог рис. 12.11. Выполним задание на расчет антенны методом 
HFSS-IE. 
       
 

           
 
Рис. 12.11. Задание установки на расчет и разбиение на сетку в методе 

HFSS-IE 
 
     Расчет характеристик антенны выполняется на одной частоте 0.9 ГГц, 
поэтому установим адаптационный процесс на этой частоте (рис. 12.11). 
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Рис. 12.12. Характеристики антенны на матче 
 

    Запустите на решение, нажимая  Analyze. После расчета командой HFSS-> 
Fields -> Edit Sources установим возбуждение на всех трех портах (рис. 
12.12) и просмотрим ток, текущий по металлическому покрытию мачты (рис. 
12.13) и диаграмму направленности (рис. 12.14). 
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Рис.   12.13. Токи на 
поверхности мачты 

Рис.  12.14. Сечение ДН антенны на мачте 
 

                          
    В заключение отметим, что метод интегральных уравнений позволяет 
выполнить моделирование структур как с размерами, намного больше длины 
волны, так и с размерами, намного меньше длины волны. В качестве 
практического примера можно отметить расчет проводной антенны (рис.  
12.15) высотой 100 м, работающей в диапазоне волн 100 кГц. 
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Рис.  12.15. Проволочная антенна с растяжками 

 
    Размер этой антенны намного меньше длины волны. Входной импеданс у 
такой  антенны сверхдлинноволнового диапазона очень маленький. 
Увеличить его можно с помощью подбора количества оттяжек, выбора угла 
под которым оттяжки идут относительно земли. Входное сопротивление 
также значительно зависит от проводимости земляной поверхности. 
Основной задача проектирования такой антенны можно считать увеличение 
кпд (рис. 12.16), который зависит от частоты. 
     

 
Рис. 12.16. Частотная зависимость кпд зонтичной антенны высотой 110 м 

и с длиной оттяжек 110 м. 
 
    В структуре такой антенны могут возникать очень высокие напряжения. 
Для расчета напряжений между растяжками антенны можно разбить 
расстояния от отдельных фрагментов антенны до земли в виде отдельных 
элементов. Программа рассчитывает напряженности поля и напряжения на 
этих фрагментах, Используя, например, программу Exell, можно 
проинтегрировать суммарное напряжение и найти напряжение между 
антенной и землей. 
     HFSS  может работать в тандеме и с другими  программами:  Mathlab,  
MathCAD, AutoCAD. 
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13. Расчет временного процесса в 
интегральной схеме СВЧ 

 
     
    Известно, что методами теории цепей можно выполнить расчет и в 
частотной области и во временной области. В HFSS-13 можно выполнить 
расчет во временной области, чтобы видеть распространение короткого 
импульса через устройство, в дополнение к получению S –параметров. 
      Программа расчета переходного процесса HFSS Transient – 
рассчитывает динамически изменяемое электромагнитное поле, используя  
дискретный метод Галеркина (DGTD - Discontinuous Galerkin Time Domain). 
Этот метод использует тетраэдральную сетку разбиения, и фундаментальный 
метод конечных элементов, который сделал HFSS стандартом точности в 
электромагнитном моделировании. Теперь можно выполнить исследования, 
задавая короткий радиоимпульс,  проникающий через землю, 
электростатические разряды, электромагнитные разряды и молнию. Можно 
также получить картину поля, которая меняется во времени  (TDR) при 
произвольном  заданном временном сигнале на входе.   
        Рассмотрим топологию (рис. 13.1) проекта Alinks_BGA, находящегося в 
папке Help инсталляционной папки HFSS (а не в папке Example). В процессе 
моделирования в этом проекте рассчитываются S-параметры в диапазоне 
частот, а также наблюдается распространение короткого импульса.  
          Геометрия имеет четыре сигнальных линии, которые подключены к 
портам и земляной шине. Выполним моделирование на уже созданной 
геометрии (рис. 13.1). Добавим возбуждения и установки на решение, перед 
анализом и выводом данных расчета. 
 

 
 

Рис. 13.1. Структура распределительных линий 
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        Нажмите HFSS>Solution Type  и установите метод расчета Transient 
(рис. 13.2). Это метод расчета процесса во временной области. 
 

 
Рис.13.2. Методы решения задачи в HFSS 

 

    Метод решения Transient имеет опцию  Network Analysis. Если вы 
выбираете опцию Network Analysis, то при установках на расчет появляется 
закладка входного сигнала, что позволяет выполнить, например: 

•  Моделирование возбуждением в виде импульсов, таких структур, как 
широкополосные антенны, световые волокна, электростатические 
разрядники; 

•  визуализацию поля при воздействии короткого импульса; 

•  анализ время-зависимых рефлектомеров. 

 
    Проверим установку граничных условий на готовой геометрии. 
Анализируемая структура представляет собой фрагмент СВЧ микросхемы. 
Он охвачен поверхностью air_box, на которую назначим граничные условия 
Radiate (рис. 13.3). Слева на рис. 13.3 приведены граничные условия, 
которые можно установить в методе расчета переходного процесса. 
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Рис. 13.3.Сложная форма поверхности Radiate 
 
           RadiationBoundary – граница излучения (рис. 13.3). Для точного 
моделирования объем формы, на стороны которого устанавливаются 
границы излучения, должен быть достаточно большой. 
     Другое граничное условие в разделе Boundaries, ReferencePlanes задается 
на земляные платы (“основания”) к портам. Так как сигнальные и земляные 
линии связаны с этими плоскостями, каждый сигнальный ток должен иметь 
замкнутый путь.    Выделим сразу две плоскости (рис. 13.4) 
BONDWIRE_REFPLANE_1 и SOLDERBALL_REFPLANE_1 и на них 
зададим условия Perfect E с именем Reference Plane. 
 

 
 

Рис. 13.4. Задание референсной плоскости (противовес) 
 
     Эти плоскости будут использованы при описании источников 
возбуждения.  
    На рис. 13.3 можно видеть, какие граничные условия можно применить в 
режиме  HFSS Transient. Границы, недоступные для работы в этом режиме - 
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это частотно-зависимые границы (слоистый импеданс, экранный импеданс 
screening impedance), которые непосредственно нельзя реализовать во 
временной области. 
 

      Задание источников возбуждения структуры. 
 

    1. Выберите первую из пока неописанных плоскостей LINK_12_BW в 
дереве проекта  и задайте на нем дискретный порт (рис. 13.5) командой 
Assign Axitation -> Lumped port. 
   BW означает Bound Wire (круглый провод), 
   SB – означает Silver Ball (серебряный шар). 
 

 
Рис. 13.5. Задание команды на создание дискретного порта в проекте 
 
2 . Появляется диалог рис. 13.6, в столбце  которого “Use as reference”, 
отметьте галочку, чтобы задать проводник SOLDERBALLREFPLANE_1 как 
опорную плоскость для терминала этого порта. 
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Рис. 13.6. Определение опций порта в режиме Driven Terminal 

 
    Таким же образом, создадим все 4 порта со стороны опорного проводника 
SOLDERBALLREFEPLANE_1. 
 
3. Откройте диалог свойств Properties для порта и в нем закладку Transient 
(рис. 13.7).  Не каждый порт должен быть “Active” (если задать активными 
все порты, то потребуется большое время, чтобы рассчитать всю S-матрицу). 
 

 
Рис. 13.7. Выбор состояния порта в режиме расчета переходного процесса 

 
    Если вы хотите уменьшить время расчета, сделайте только несколько 
портов активными. Пассивные порты будут работать как терминалы. Тогда 
вы получите только частичную S-матрицу. 
 
4. Откройте закладку Post Processing, и оставьте опцию Do Not Renormalize. 
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Рис. 13.8. Закладка постпроцессорной обработки данных 

 
  Если выбрать другую опцию, Renormalize All Terminals’ Spectral Domain 
Date, то данные будут нормализованы на термальные данные спектрального 
анализа. 
 
5. Выделите поверхность порта (в разделе Lumped Port) и кликните правой 
кнопкой мыши на  иконку этого порта в разделе  Excitation, и выберите 
“Auto-Assign Terminals”. По этой операции последовательно каждому порту 
автоматически создается терминал (нагрузка). 
    Отметим, что возможны и другие возбуждения в методе HFSS Transient. 
Однако некоторые задачи пока не решаются этим методом в версии 13: 
отдельные ячейки периодической структуры (фазированные антенные 
решетки, периодические частотноселективные поверхности)  или модели с 
магнитным смещением (ферритовые циркуляторы, ферритовые 
фазовращатели). Эти примеры лучше рассчитываются в частотной области с 
помощью  HFSS. 
 
Установки на расчет переходного процесса.   Сначала 
определим список фасок, на которых будут сохраняться рассчитанные поля 
переходного процесса, для чего: 
 
1 . Переключитесь на режим выбора фасок F и выберите курсором 
одновременно верхние фаски для сигнальной и земляной плоскости (рис. 
13.12), удерживая клавишу Ctrl. 
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Рис. 13.12. Выделение нескольких поверхностей 

 
2. Создадим список фасок командой Modeler>List>Create>Face List. В 
разделе List появится список FaceList1. Измените это имя на PlotFields. 
 
     Затем  подготовим установки на решение, для чего: 
 
1. Кликните правой кнопкой  Analysis>Add Solution Setup. 
 
2. В закладке  General (рис. 13.13) зададим максимальное количество шагов 
уплотнения сетки, равное 6. 
 

 
Рис. 13.13. Закладка General 

 
   Частота, на которой выполняется разбиение на сетку, будет находиться 
автоматически на основании выбранной временной зависимости. 
 
3. Выберите закладку Input Signal  (рис. 13.14). 
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4. Задайте широкополосный импульс от DC до 10 GHz и запросите расчет  
     S-параметров через каждые 10 MHz.   
 
  Заметим, что расчет во временной области можно выполнить,  задавая 
минимальную и максимальную частоты. Если вы задаете нижнюю 
граничную частоту, равной нулю, форма импульса изменится и будет 
включать частоты до постоянного тока. 
    Также заметим, что в дополнении к свипированию по частоте, может быть 
определен TDR импульс. Это - импульс,  спектр которого идет от DC до 
некоторой максимальной частоты, от которой зависит время нарастания. 
     Наконец, заметим, что вы задаете здесь одну временную зависимость для 
всех активных возбуждений. В проекте с  более чем одним общим 
переходным процессом (“non Network Analysis ”), можно задать различные 
временные зависимости для различных возбуждений, и выполнить 
моделирование одновременно со всеми возбуждениями. В методе расчета 
переходного процесса, все активные возбуждения имеют ту же самую 
временную зависимость, вы получаете один результат моделирования при 
одном активном возбуждением.  
 

 
Рис. 13.14. Закладка входного сигнала 

 
5 . Выберите закладку Duration (рис. 13.15). 
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Рис.  13. 15. Задание уровня затухания переходного процесса 

 
   Моделирование будет выполняться, пока переходные поля не затухнут до 
уровня Target Residual (рис. 13.15). Кроме того, максимальное время 
моделирования  определяется величиной  
 
                                   20x(размер модели) / (скорость света). 
 
    В этой линии передачи сигнал длительностью 1 нсек может несколько раз 
перемещаться от источника до оконечной нагрузки и назад. Поэтому резонно 
ограничить время расчета величиной  At most =1.25 ns (рис. 13.16), что равно  
вышеупомянутой 1 нсек, плюс длительности  входного сигнала. 
 

 
Рис. 13.16. Страница установки параметров временного процесса 

 
 
    Откройте закладку Saved Fields (рис. 13.17), и установите режим  
сохранения поля в плоскостях, устанавливая опцию  PlotFields.  
    Сохраняйте поля каждые 4 ps.  За время 4 ps сигнал углубляется на 0.6 мм 
в диэлектрике, так что такая частота выборок должна обеспечить плавную 
анимацию для этой модели. 
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Рис. 13.17. Установки на сохранение поля во время переходного процесса 
 
     В закладке Radiated Fields (рис. 13.17) выберем частоты, на которых будут 
сохраняться поля. Моделирование  потребует приблизительно  RAM  400 МБ 
на одно возбуждение. Если Вы установили все порты активными и имеете 
возможность выполнить распределенное моделирование, то выберите такой 
расчет. В распределенном моделировании по крайней мере с восемью 
процессорами и с достаточной RAM, каждый из восьми возбуждений дают 
собственный процесс, и они будут все решаться одновременно. Итак: 
 

1. Сохраните проект и запустите моделирование. 
 
     HFSS будет сначала выполнять адаптивный расчет во временной области. 
После этого, он будет выполнять восемь моделирований, одно на каждое  
возбуждение. 
 

2. После того, как расчет запущен, можно нажать правой кнопкой мыши 
на  Results>Create Terminal Solution Data Report>Rectangular Plot, 
чтобы в процессе расчета следить за входными и выходными 
сигналами на различных портах по мере выполнения моделирования. 
Выведем зависимости, выбирая нужные характеристики в диалоге рис. 
13.17. 
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Рис. 13.17. Вывод характеристик во временной области 
 
 
     Выберите входной сигнал  Input(LNK_12_bwire_T1), а также сигналы 
Output(TXCLK_12_bwire_T1, LNK_12_bwire_T1) и  
Output(TXCLK_12_sball_T1, LNK_12_bwire_T1). Тогда  создается график 
рис. 13.18. 
 

 
Рис. 13.18. График временного процесса 

 
     На рис. 13.19 по оси Y выводится параметр Residual (разница) в дБ. Это –
величина какого либо процесса, которая используется как критерий 
остановки. Устанавливается он в закладке Duration. По умолчанию, когда 
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пиковое поле спадает до 0.001 относительно  максимума, моделирование 
считается выполненным.  
   Контроль Residual графика во время расчета дает информацию, какое 
время моделирование может потребоваться.    Окно состояний дает 
дополнительную информацию; это основано на максимальном времени 
моделирования. 
 

 
 

Рис. 13.19. График переходного процесса 
 
    Разность не снижается до значения -60 dB, так как мы остановили 
моделирование раньше. 
 
 
             Постпроцессорная обработка матричных данных 
 
     В окне Report, в разделе Context, измените Solution от опции Time к 
Spectral. Это дает возможность составить график S-параметров в частотной 
области, полученный с помощью моделирования переходного процесса. 
Даже когда моделирование все еще выполняется, переходное решающее 
устройство уже даст S-параметры в частотной области, на основание 
информации о переходном процессе, который выполнился к настоящему 
времени. График будет модифицироваться очень часто. Моделирование 
может замедляться потому, что каждая модификация требует преобразований 
из временной области в частотную. 
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Рис. 13.20. Вывод частотных зависимостей S параметров, полученных с 

помощью БПФ в спектральной области 
 
     Характеристики S-параметров, выводимые во время моделирования 
показаны на рис. 13.21.  S-параметры, нанесенные на этом графике – это 
коэффициент отражения и передачи для конкретной сигнальной линии. 
    

 
Рис. 13.21. Частотная характеристика сигнальной линии 

 
         
     Чтобы вывести поле, распространяющееся вдоль линии: 
 
1.  В дереве модели, выберите список плоскостей PlotFields. 
 
2. В менеджере проекта, кликните правой кнопкой мыши на Field 
Overlays>Plot Fields>E_t>Mag E_t. 
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3. Выберите   Done. По этой команде на плоскости выведутся тангенциаль-
ные составляющие электрического поля. 
 
     Поле можно анимировать в плоскости резонаторов в последний момент 
времени, т.е. анимировать от 0.6 ns до 1.25 ns с подстройкой масштаба для 
поля. Пример анимации поля показывается на рис. 13.23.   
 

 
 

Рис. 13.22. Вывод поля и анимации его 
 
     

 
Рис. 13.23. Вид бегущего тока в соответствии с временным процессом 
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    Можно также видеть анимацию распределение поля и резонансные 
явления в последний момент времени. Анимацию от 0.6 ns к 1.25 ns можно 
видеть с подстройкой шкалы для поля. 
 

 
 

Рис. 13.24.  Вид бегущего поля вдоль структуры 
 
                          Вывод графиков во временной области 
 
    Исследование во временной области заключается в расчете реакции 
(отражения) во временной области (Time-Domain Reflectometry TDR) при 
возбуждении  структуры сигналом в виде скачка воздействия (переходной 
функции). В таком расчете нужно выбрать метод   Интерполирования. После 
выполнения расчета в диалоге Report нужно выбирать Time из списка 
Domain. Вы также должны определить входной сигнал, или шаг или импульс.  
 

 
Рис. 13.25. Выбор типа сигнала при задании временного процесса 

 
     При выборе области Time, вы можете выбирать из нескольких Categories и 
связанных Quantities, чтобы составлять график, например |S11|. Когда вы 
составляете график во временной области, каждый параметр в частотной 
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области сначала преобразуется во  временную область прежде, чем 
выполняется расчет по формуле. Например, если нужно вывести зависимость 

                                        S11 / (1 - S11)      (11) 

и вывести эту функцию во временной области,  то используется обратное 
преобразование Фурье IFFT: 

                                      IFFT(S11 * input) / ( 1 - IFFT(S11 * input) )   (12) 

      Отметим, что это выражение не соответствует выражению  

                                           IFFT( S11* input) / ( 1 - S11) * input ).   (13) 

      Эти два выражения не эквивалентны. 

     Если вы выбираете Time Domain Impedance как категорию Category, вы 
можете выбрать величину TDRZ.  Она определяет как 

              TDRZ(t) = Zref * ( 1 + IFFT(S11 * input) ) / ( 1 - IFFT(S11 * input) ) (14) 

     где "input" обозначает входной сигнал (step или impulse), а "IFFT(.)" 
обозначает обратное преобразование Фурье. 

    Это уравнение является отношением мгновенного напряжения во 
временной области v(t) к мгновенному значению тока i(t).  Напряжение и ток 
определяются (в частотной области) в терминах падающих и отраженных 
волн a и b, и равны   

aSZba ii )1()(ZV 00 +=+=     (15) 
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Z
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Z
1I

00

−=−=     (16) 

         Предположим, что падающая волна будет входным сигналом в виде 
ступеньки, и таким образом, когда мы берем обратное преобразование Фурье 
(IFFT) для  V и I, то получаем  v(t) и i(t) во временной области.  Создадим это 
отношение как функцию времени, и тогда получаем функцию  TDRZ(t). По 
умолчанию  Zo = 50 Oм. 

                 Чтобы создать график во временной области: 

1. Для  проекта с существующим диапазоном изменения частот, нужно 
выполнить следующие шаги 2 - 4 для сохранения характеристики. 
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2. В диалоге Report, в списке Domain, кликните Time. 

           Это позволяет выбрать кнопку  TDR Options и для рассчитанных 
нагрузочных данных включить Terminal TDR Impedance в список Category. 

3. Кликните кнопку TDR Options. Появляется диалог TDR Options. 

4. Выберите тип входного сигнала, Step (скачок) или Impulse (импульс 
Дирака). 

          Величина Step есть скачок изменения сигнала, тогда как  Impulse есть 
короткое возбуждение. Impulse это очень узкий прямоугольный импульс, со 
временем нарастания, равным нулю и временем спада с величиной 
временного шага равного 1 и высотой равной  1/(time step). 

   Выбор опции Step делает поля Rise Time и  Impulse неактивными. 

5. Если вы выбрали Step, введите время нарастания импульса в боксе Rise 
Time. 

               Время нарастания должно соответствовать частотам.   С шириной 
полосы от DC до Fmax, лучшее время разрешения, которое может быть 
достигнуто, равно 1/(2Fmax).  Время нарастания 1/(2Fmax) это самое короткое 
время нарастания, которое можно разрешить. Однако, время нарастания 
равное 0 s дает  ту же информацию, так что  0 есть величина по умолчанию в 
этой панели. 

6. Введите общее время на графике в текстовом боксе Maximum Plot Time. 

    По умолчанию максимально время в диалоге TDR Options связано с Δf в 
диапазоне частот: оно равно времени 1/2∆f,  в течение которого IFFT выдает 
информацию. Этот отрезок времени часто очень длительный, относительно 
временной задержки, которая соответствует длине тестирования вашего 
устройства, таким образом, вам захочется уменьшить эту величину. 
Альтернативно, вы можете отредактировать временные оси для 
характеристики TDR после того, как она была создана. 

7. Установите число временных точек для вывода на график  в бокс Delta 
Time. По умолчанию, это может быть равно количеству точек  в диапазоне 
частот. 

     Разница времени основана на полосе пропускания частот: с полосой 
частот от DC до Fmax наименьшее время разрешения, которое можно 
получить, равно 1/(2Fmax). Алгоритм IFFT обеспечивает интервал между 
значениями частот 1/(2Fmax), но вы можете гладко интерполировать между 
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точками, устанавливая самую лучшее разрешение, например, к 1/(10Fmax), за 
счет дополнительного времени вычисления. 

8.  По желанию, в окне TDR  измените тип окна и ширину. 

    Оконные функции в алгоритме быстрого преобразования Фурье  FFT 
сигнала чтобы получить ненулевые величины должны быть удалены от Fmax. 
Каждая оконная функция между способностью решить сопоставимые 
сигналы и частоты способностью решить сигналы различных сил и частот.  

     Список типов окон включает:  

Оконная функция Случаи использования
Rectangular Функция с низким динамическим диапазоном дающая хорошее 

разрешение для сигналов с близкими амплитудами.  Не 
подходит, когда сигналы имеют очень сложные амплитуды. 
w(n)=1. 

Bartlett Функция с большим динамическим диапазоном, с низким 
разрешением, подходит для широкого диапазона применений. 

Blackman Функция с большим динамическим диапазоном, с низким 
разрешением, созданная для широкого ряда применений. 

Hamming Модернизированная функция динамического диапазона, 
созданная для примеров с узкой полосой. 

Hanning (default) Функция модифицированного динамического диапазона, 
рассчитываемая для примеров с узкой полосой пропускания. 

Kaiser Выбор функции Кайзера также позволяет области определить 
связанный параметр Кайзера. Чем больше параметр Кайзера, тем 
шире окно. Параметр управляет компромиссом между шириной 
центрального лепестка и областью лепестков со сторон. 

Welch Этот подход применяется к окну параболической формы с 
данными в частотной области. 

9. Вы можете использовать Save as Default для установки текущих значений 
как умолчанию,  и кнопку  Use Defaults для использования ранее 
сохраненных опций. Заметим, что когда вы выбираете характеристику, 
сначала показывается величины, соответствующие  выбранной 
характеристики. 

10. Кликните OK. 

  Чтобы вывести характеристику  Terminal TDR Impedance (что означает, 
либо рассчитывать S-параметры для порта waveport1 в диапазоне частот, 
вместо расчета задержки относительно времени при конкретном импедансе), 
нужно сделать следующее: 

a. В списке Category, кликните Terminal TDR Impedance. 

b. В списке Quantity, кликните величину для нанесения графика. 



  167

     Импеданс по умолчанию (Zo) для величины  TDRZ составляет 50 ом, если 
Вы не определили по-другому, когда Вы устанавливаете импеданс 
перенормализации для терминалов, которые созданы в модели. Если нужно 
изменить величину импеданса, ее можно отредактировать в диалоге Report 
(как показано ниже), или Вы можете создать переменную Zo × (1+Sii) / (1-Sii) 
с выбранным  Zo. Отредактировать величину Zo можно в диалоге Report, для 
чего: 

1. В разделе  Category, выберите  параметры Terminal TDR Impedance, Port    
и Function.  

 

Рис.  13.26. Выбор времени по оси x 

2. Отредактируйте величину, которую нужно задать в поле Value.  В этом 
примере, величина для  Zo изменяется от значения по умолчанию  75 Ом при 
введении  ‘Zo=75ohm’ в поле Y-столбца. 

 

Рис.  13.27. Выбор функции по оси Y 

c. В разделе  Function, выберите mag для вывода модуля. 

3. Кликните Done.   Характеристика появляется в окне просмотра.  

     Если S11 = 0 на DC,  шаг временного интервала стремится к нулю, и шаг 
TDRZ  стремится к Zref. Если S11 будет отличным от нуля в DC, то ответ 
шага временного интервала устанавливается равным ненулевому значению, и 
TDRZ устанавливается равным величине, отличающейся от Zref.  Импульса 
временного интервала будет всегда спадать к нулю, как это можно видеть по 
производной характеристики. Переходной импульсный процесс TDRZ будет 
всегда нормироваться  на Zref. 
     График ниже показывает различие между коротким временем нарастания 
отличным от нуля и нулевым временем нарастания для сегмента линии 
передачи 94 Ом. Отметим, что характеристика с нулевым временем 
нарастания начинается с верного импеданса линии, в то время, как импеданс 
в другие временные точки перенормализуется.  Кроме этого, одна 
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характеристика - смещенная копия другой (рис. 15.25). Причина этого 
состоит в том, что напряжения и ток связаны нагрузкой 50 Ом, так что 
временной интервал сохраняется, v = Zref * i. Когда импульс нарастает, 
характеристика TDRZ начинает изменяться от установившегося состояния, 
потому что имеется отражение назад к источнику, импеданс которого 
отличается от характеристического импеданса линии передачи. 

 
Рис. 13.28. Временной процесс изменения импеданса TDRZ 

 
Отметим следующие моменты, которые нужно иметь в виду, используя 

TDR: Пространственное разрешение 

B
cx

2
=Δ      (17) 

где c - скорость света в среде, и B - полоса пропускания сигнала. Так как 
TDR обычно основан на диапазоне частот, который начинается с 
постоянного тока, то пространственное разрешение становится  

max2F
cx =Δ      (18) 

  
где Fmax - самая высокая частота в диапазоне частот. Например, если Fmax =  
15 ГГц и среда имеет проницаемость εr=4, то пространственный шаг будет 
равен (1.5E8 м/с) / (3E10 1/с) = 5 мм. 
    Пространственное разрешение, равное  c/(2Fmax) соответствует временному 
разрешению: 

   )2/(1 maxFt =Δ          (19)   

Пусть N - число точек в IFFT. N равняется числу временных выборок, и это 
также равняется удвоенному числу частотных выборок. Плотность 
временных выборок в развертке частоты равна:   

                tNfF Δ==Δ /TIFFT) в  точекчисло(/2 max          (20), 
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  где Т ‐ полное время. 
   Увеличение плотности частотных выборок приводит к увеличению полного 
времени T. На практике это часто приводит к большому времени затухания 
переходного процесса. Поэтому, в диалоге TDR Options можно установить 
максимальное время с меньшей величиной. 
    Интерфейс TDR Options также позволяет выбирать меньшее ∆t,  чем 
заданное уравнением (3) выше. Когда вы выбираете меньшее ∆t, вы 
увеличиваете Fmax "дополнением ноля", то есть добавлением нулевого 
значения для S11 вне расчетной ширины полосы частот. На практике это 
приводит к более гладкому сигналу TDR. 
     HFSS позволяет установить время нарастания входного сигнала. Время 
нарастания должно быть равно по крайней мере  1/(2Fmax). Входной сигнал с 
большим временем нарастания имеет меньшую плотность на высоких 
частотах и приведет к меньшему "звону" в характеристике TDR.  
    Фильтр Hamming или Hanning также уменьшит высокочастотное 
содержание и приводит к более гладкой характеристике TDR. С этими 
фильтрами можно выбрать ширину. Ширина 100 % часто - хороший выбор. 

      Для расчета временного процесса необходимо получить 
широкополосные модели SPICE. Это модели, которые отражают поведение 
электродинамических структур, но представляют собой модели с узлами. 
Это выполняет программа Full-Wave SPICE, которая   позволяет выполнить 
моделирование частотно-зависимых моделей SPICE, которые генерируются 
в форматах HSPICE, PSpice или Spectre RF для точного моделирования во 
временной области. Это обеспечивает получение широкополосных моделей 
SPICE одним нажатием кнопки. Программа Full-Wave SPICE - это 
добавочный модуль для  HFSS и Ansoft Designer. Она рассчитывает точные 
широкополосные модели  SPICE. Эта возможность позволяет разработчикам 
электронных компонентов учитывать СВЧ эффекты.  

     Программа Full-Wave SPICE позволяет пользователю реализовать:  

• Метод перевода от типов волн к узлам Modes-to-nodes technology; 
• Метод быстрого свипирования ALPS fast-sweep technology;  
• Алгоритмы создания моделей схемы SPICE.  

      Расчет временного процесса часто требует больших компьютерных 
ресурсов – памяти и времени. Поэтому рекомендуется при решении этих 
задач использовать распределенное моделирование. 
    Распределенное моделирование требует лицензии  для выполнения 
расчета задач, которые требуют больших вычислительных ресурсов.  Эта 
лицензия называется High Perfect Computing (HPC).  Режим распределенного  
моделирования устанавливается в закладке Analysis Options, которая 
находится в диалоге  Tools>Options>General Options.  
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Рис. 13.29. Задание опции распределенного расчета 
 
         Например, в диалоге рис. 13.29  пользователь имеет доступ к 
компьютеру с восемью, или большим количеством процессоров вызывается 
командой  \\ large_many_proc_machine. В диалоге рис. 13.29  компьютер 
перечислятся восемь раз, по числу процессоров. 
 
    Предположим, что  компьютер имеет 16 процессоров. Этому случаю 
соответствует установка, показанная на рис. 13.30. Это число может быть 
определено в закладке  Solver  диалога HFSS Options. 
      
 
 

 
Рис.  13.30. Опции HFSS: число процессоров в распределенном режиме 

работы 
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    В этом примере для тех процессов, которые не могут выполняться в 
распределенном режиме, пользователь запрашивает использование всех 16 
процессоров. Но например переходной процесс HFSS лучше считает в 
многопроцессорном режиме. Для распределенного моделирования, можно 
выбрать два процессора в разделе Number of Processors (рис. 13.30). 
Подробно методы реализации распределенного моделирования будут 
рассмотрены в разделе 17.  
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14. Анализ рупорной антенны во 
временной области 

 
 
 

 
В этом примере мы будем использовать метод расчета переходного 

процесса, чтобы получить S-параметры рупорной антенны в  широкой 
полосе частот. Широкополосная антенна может использоваться для передачи 
коротких импульсов, например как часть радиолокационной системы 
подповерхностной локации земли.   

Мы будем использовать имеющуюся в библиотеке примеров модель, 
содержащую антенную геометрию, создадим остальную часть модели и 
выберем метод расчета переходного процесса.       

В этом разделе рассматриваются подготовка модели и анализ 
переходного процесса в рупорной антенне во временной области. 
 
     Запуск  HFSS и открытие модели. 

 
1. Запустите HFSS 13. 
 
2. Командой File>Open загрузите файл broadbandhorn.hfss  из папки Help  в 
директории инсталляции HFSS 13. Это размещение отличается от 
расположения в папке example. Вы будете добавлять границы, возбуждение 
и задавать поверхности, на которые будут выводиться поля. 

 
Рис. 14.1. Вид рупорной антенны 
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Рис. 14.2. Размеры рупорной антенны и конструкция порта 
 
3.  Задайте  команду меню HFSS>Solution Type, чтобы выбрать тип решения 
Transient Network Analysis (рис. 14.3). 

 
Рис. 14.3. Диалог выбора типа решения 

 
 
5. Задайте свойства материала рупора как медь и объекты pin. Геометрия 
включает также воздушный бокс, стороны которого покрыты слоями PML. 
 
6. Создайте воздушный бокс с начальной вершиной (X,Y,Z)=(-100, -250, -
180) и размером (dX, dY, dZ)=(550, 500, 360). Свойства этого бокса показаны 
в диалоге, показанном на рис. 14.4. 
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Рис. 14.4. Параметры базового бокса рупорной антенны 

 
     Фаски этого бокса расположены на расстоянии, большем, чем 100 мм, от 
рупора. Так как мы собираемся использовать PML, и минимальная частота 
будет 0.7 GHZ, это даже больше, чем нужно. 
    Заполним воздухом этот бокс, дадим ему название, цвет и проницаемость. 
На сторонах этого бокса зададим  граничные условия PML. 
 
7. Выделите все фаски воздушного бокса. 
 
8. Выберите Boundaries>PML Setup Wizard. Появляется мастер создания 
идеально поглощающих плоскостей (рис. 14.5). Мастер сам корректирует 
материальные параметры, чтобы получить хорошее поглощение в слое с 
заданной толщиной. 
 

 
Рис.  14.5.  Создание идеально согласованной слоя с толщиной Thickness = 

100 mm  в ассистенте PML 
 
9. Кликните Next. 
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10. Задайте минимальную частоту и минимальную дистанцию до плоскости 
излучения Minimum Radiating Distance, как показано на рис. 16.6: 0.7 GHz 
and 100 mm. 
     Эти установки нужны, чтобы HFSS сгенерировал правильные параметры 
слоя PML. 

 
 
Рис. 14.6. Установка частоты и дистанции в ассистенте PML 
 
11. Кликните Next и затем Finish. 
 
 
Задание плоскостей для вывода динамически изменяемых 
полей.    Нужно решить заранее, где мы хотим видеть поля в полной 
трехмерной модели на каждом шаге изменения времени. Создадим два 
перпендикулярно развернутых прямоугольника, на которых мы хотим 
сохранить поля (рис. 16.7,16.8). 
 
1. Создайте прямоугольник в плоскости XY  с точки (X,Y,Z)=(-100, -250, 0) 

с размером (Xsize, Ysize)=(550, 500). 
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Рис. 14.7. Горизонтальная плоскость, 
пересекающая рупорную антенну 

Рис. 14.8. Плоскость, на котором 
выводится поле 

 
 
2. Создайте прямоугольник в плоскости XZ с точкой  (X,Y,Z)=(-100, 0, -180) 
и размером  (Xsize, Zsize)=(550, 360). 
 
3. Выведите эти прямоугольники в виде рамок. Теперь нужно определить 
этот список как  “list” для того, чтобы позже сохранять поля на них. 
 
4. Выберите оба прямоугольника. 
 
5. Задайте команду  Modeler>List>Create>Object List (или нажмите Face 
List если вы выбрали их в режиме выбора фасок). 
 

 
 

Рис. 14.9. Выбор имени “Objectlist1” на “PlotFields” в окне свойств 
Properties 

 
6. Задайте этому списку имя, например “PlotFields”, как показано ниже, через 
дерево модели и окно свойств. 
 
7. Сохраните модель командой Save. 
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Источники возбуждения.     Плоскость “source” будет волновым 
портом. 
 
1. Кликните  Tools>Options>HFSS Options, чтобы вывести диалог HFSS 
Options.   В закладке General, в разделе Assignment Options, проверьте, что   
опция Auto-assign terminals on ports не отмечена и кликните OK. 
 

 
 

Рис. 14.10.  Закладка General диалога HFSS Options 
 
2. В дереве проекта выберите плоскость с именем  “source”. 
 
3 View>Fit Selection. Заметим, что этот объект является сечением 
коаксиального кабеля, внешний проводник которого outer есть часть круга. 
 
4. Задайте Wave Port для этой плоскости. 
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Рис. 14.11. Выбор объекта для опорной (земляной) плоскости 

 
5. Дайте порту имя  p1 и кликните Next. 
 
6. Задайте порту опцию Active. Кликните Next. 
 

 
 

Рис. 14.12. Задание волнового порта активным 
 
7. Выберите опцию “Do Not Renormalize” (рис. 14.13).  Импеданс порта 
ожидается равным  точно 50 Ом, и рассматривается как действительный 
импеданс, который будет корректно согласован с импедансом модели.  
 

 
 

Рис.  14.13. Последний шаг в установке волноводного порта 
 
8. Кликните Finish. 
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    В проекте с методом Transient Network Analysis с несколькими портами, 
чтобы получить полную S-матрицу необходимо подавать сигнал на один из 
портов. Такой порт назовем активным. Каждое моделирование с одним 
активным портом дает один столбец S-матрицы. Когда вы определяете порт 
как пассивный, это означает, что сигнал на него не подается, а он нагружен 
на согласованную нагрузку. 

В проекте с расчетом переходного режима (не network analysis), все 
активные порты будут одновременно включены (ON), в то время как 
остающиеся пассивные порты будут действовать только как оконечные 
нагрузки (OFF). 
 
 

   Спецификация терминала.    Поскольку программа HFSS 
Transient использует порты Terminal-Driven, нам нужно задать сопротивле-
ния портов. 
 
1. Кликните правой кнопкой мыши p1 в дереве проекта и выберите Auto 

Assign Terminals. 
 

Рис. 14.14. Выбор опции 
автоматического определения 
терминала  

Рис. 14.15. Спецификация проводников, 
касающихся порта, которые будут 

противовесом 
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Рис. 14.16. Компоненты волнового порта 

 
 
2. Выберите  horn как  опорную плоскость Reference, так что pin будет 
терминалом. 
 
 

Расчет и вывод результатов.   Этот раздел описывает установки 
на решение временного процесса и просмотр результатов. 
 
1. В дереве проекта, выберите  Analysis>Add Solution Setup. 
 
2. Сетка для переходного моделирования создается на основании  
моделирования в частотной области. В этом моделировании программа 
останавливается на соответствующей частоте,  чтобы выполнять адаптивный 
расчет. В этом случае использовать смешанные порядки элементов и 
итеративное решающее устройство. Примите значения по умолчанию в 
закладке General (рис. 14.17). 
 
 

 
Рис. 14.17. Установки в закладке General 

 
3. В закладке Input Signal (рис. 14.18), задайте полосу частот от 700 МГц до 
1.6 ГГц. Это полоса соответствует модулированному импульсу Гаусса во 
временной области, который можно видеть в панели. 
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Рис. 14.18.  Временной процесс на входном порту 

 
 
4. В закладке Duration, вы должны задать границы по времени при анализе 
переходного процесса. Для этого примера, выберите Auto Terminate. 
 
 

 
Рис. 14.19. Здание точности расчета временного процесса 

      
Параметр Target Residual (Разница до сходимости)  характеризует 

минимальное поле в модели в данное время по отношению к его самому 
большому значению. Как только поля падают ниже 0.001 от самого высокого 
значения, моделирование может быть остановлено. Дополнительно, Вы 
можете определить максимальный (At most) и минимальный (At least) 
интервалы времени, в которые нужно моделировать переходной процесс. 
Встроенные максимальные и минимальные интервалы времени подходят в 
большинстве случаев. Они учитывают размер модели и тип сигнала.  
 
5. В закладке Saved Fields (рис. 14.20), отметьте опцию Object List or Face. 
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     Установите интервал, через который будут запоминаться значения 
поля равным 30 ps. Это - "достаточно малая" часть длительности 
широкополосного импульса, чтобы получить в дальнейшем плавную 
анимацию поля. 
 

 
 

Рис.  14.20. Опции сохранения поля в закладке Save Fields 
 
6. В разделе  Radiated Fields  установите опции сохранения полей и во 
временной и в частотной областях на частоте 1.2 GHz, как показано на рис. 
14.21. 
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Рис. 14.21. Выбор частоты, на которой сохраняется излучающее поле 
 
7.  Шаг установки на решение Solution Setup выполнен. Кликните OK. 
 
 
    Моделирование. 

 
1. Запустите моделирование. 
 

Вся область прогресса решения (см. рис. 14.22) соответствует 
максимальному времени моделирования в закладке Duration диалога 
Solution Setup, или, если оно не определено, то величине   20*(диагональ 
модели) / (скорость света). 
    Область красной стрелки показывает время моделирования  относительно 
максимального времени, в течение которого моделирование будет 
выполнено. 
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Рис.  14.22. Наблюдение процесса расчета, показывающее время 
моделирования по отношению к общему времени расчета 

 
     Во время моделирования, вы можете видеть прогресс расчета и другим 
способом. 
 
2. Нажмите правой кнопкой на Results в дереве проекта и выберите Create 
Terminal Solution Data Report>Rectangular Plot. 
 

 
 

Рис. 14.23. Выбор характеристики во временной области 
 
     Выведите  Input и Output на одном графике и Residual в dB20 на другом. 
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Рис 14.24. Напряжения  Input и Output (возбуждение и отражение) как 
временные функции  
 
 
   Input и Output показывают возбуждение и отражение на порту как 
функцию времени. 
 
      Характеристика Residual ( рис.14.25) показывает меру для уровня макси-
мального поля в модели. Моделирование завершается, когда Residual спада-
ет ниже  0.001 относительно его пика в любое время. 
 

 
Рис.  14.25. Параметр Residual в логарифмическом масштабе, как функция 
времени  
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   Визуализация характеристик структуры.  
 
1. Чтобы вывести характеристики   S-параметров как функции частоты, 
снова нажмите правой кнопкой на Results в дереве проекта и выберите 
Create Terminal Solution Data Report>Rectangular Plot. 
 
2. Измените выбор в окне Solution на Spectral как показано на рис. 14.26. 
 

 
 
Рис. 14.26. Подготовка к выводу S-параметров parameters как функцию 
частоты, т.е. в виде спектра временного процесса 
 
3. Нанесите модуль |S11|. Результирующий график показан на рис. 14.27. 
Этот график изменяется, когда расчет еще продолжается. Это позволяет вам 
видеть этот график на ранних шагах расчета. 
 

 
 
 
Рис. 14.27. Частотная характеристика |S11| для широкополосной рупорной 
антенны 
 
 
Бегущее поле рупорной антенны. 
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   Чтобы создать бегущее поле, выберите список, названный “plotfields”  в 
дереве модели, т.е. список, содержащий два прямоугольника которые вы 
создали для вывода поля.  
      В дереве проекта, кликните правой кнопкой Field Overlays>Plot 
Fields>E_t>Mag_E_t и выберите произвольное ненулевое время на 
следующей панели (рис. 14.28). Вы можете всегда подстроить время, 
изменяя его выбором  Modify. 
 

 
 
Рис. 14.28. Создание бегущего поля в заданный момент времени t= 3.044 пс 

 
    Теперь имеется возможность наблюдать бегущее поле. Причем в отличие 
от метода FEM, здесь мы видим поле, изменяющееся во времени в 
соответствии с временным процессом входного сигнала (рис. 14.29). 
 

 
Рис. 14.29.  Распространение поля в двух перпендикулярных плоскостях 
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3. Измените масштаб напряженности поля, чтобы сделать видимым поле в 
диапазоне от 0 до 10 V/m. 
 
4. Анимация графика волны распространения можно выполнить, нажимая 
правой кнопкой мыши на имя графика и выбирая Animate. В окне Setup 
Animation, вы можете выбрать число шагов. Если нужно, HFSS выполнит 
интерполяцию между сохраненными решениями поля. 
 

 
 

Рис.  14.30. Окно установки анимации поля 
  
   Визуализация поля излучения. 
 
     Чтобы рассчитать поля во временной области:  
1. Кликните правой кнопкой на Radiation и выберите  Insert Far Field 
Setup>Infinite Sphere. 
 

 
Рис.  14.31. Выполнение установок дальнего поля 

 
2.  В дереве проекта кликните правой кнопкой на Radiation и выберите Insert 
Far-Field Setup>Infinite Sphere. Задайте диапазон углов, как показано на 
рис. 14.32. Это диапазон в плоскости  XZ,  и диапазон от зенита до горизонта 
в направлении  прямого излучения  антенны. 
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Рис.   14.32. Задание только одной точки на сфере дальнего поля 

 
3. Теперь в дереве проекта, кликните правой кнопкой мыши на 
Results>Create Far- Fields Report>Rectangular Plot. 
 
4. Выберите характеристику rEz как функцию времени. 
 

 
Рис. 14.33. Вывод характеристики напряженности поля в дальней зоне 
 
5 . В закладке Families, задайте  Theta = 90° и Phi = 0°. 
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Рис. 14.34. Закладка семейств вывода характеристик 

 
    Пояснение:   Компонента Ez является доминирующей. Поэтому она 
выбрана на рис. 14.33. Произведение  r  на Ez  полезно, потому что оно не 
зависит от расстояния от источника до точки наблюдения в дальней зоне. 
Параметр rE имеет размерность  [В], так как поле E имеет размерность  
[V/м], а расстояние r [м].  

На рис. 14.35 показывается форма временной зависимости поля в 
дальней зоне. Этот график показывает, как искажается сигнал, излучаемый 
антенной. Эта информация может использоваться, чтобы улучшить 
конструкцию антенны, например,  разумно помещая резистивные ленты в 
некоторых ее точках. Это - также полезная информация на этапе  
постпроцессорной обработке данных расчета. 
 

 
Рис.  14.35. Изменение дальнего поля излучения, co-polarized, в центре 

главного луча. 
 
   Если нужно, вы можете также создать частотно-зависимое дальнее поле  
при изменении решения к Spectral  и изменения угла Theta как первичного 
параметра, как показано в диалоге рис. 14.36. 
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Рис. 14.36. Вывод характеристики дальнего поля в спектральной области 

 
    В закладке Families (рис. 14.36) можно видеть, что ранее установлена 
частота 1.2 GHz, в закладке Radiated-Fields установки решение Solution 
Setup, и таким образом, можно выбрать опцию Spectral. 
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15. Проектирование наноразмерных светодиодиодных    
модулей 

 Одной из актуальных задач,  возникающих на стыке между оптическим 
и СВЧ – диапазонами, является обеспечение эффективного излучения 
световых электромагнитных волн в средах со сложной частотной 
зависимостью их свойств. К таким средам, в которых анализ 
распространения электромагнитных волн представляет довольно сложную 
задачу, можно отнести безэлектродные разряды в плазме, метаматериалы с 
отрицательной диэлектрической и магнитной проницаемостью, а также 
полупроводниковые гетероструктуры. В данном разделе рассматриваются 
возможности повышения эффективности светодиодных модулей на основе 
резонаторных систем с  квантовыми источниками электромагнитного 
излучения[8]. 
     Развитие техники СВЧ по мере увеличения частоты всегда сдерживалось 
технологическими возможностями. Поэтому, например, в субмиллимет-
ровом диапазоне длин волн невозможно было использовать столь же 
эффективные резонаторные и замедляющие системы, как в сантиметровом 
диапазоне. 
   Однако в настоящее время в связи с успехами в развитии нанотехнологии 
такие возможности появились, и теперь можно использовать богатый опыт 
разработок СВЧ систем в приборах оптического диапазона, включая лазеры и 
светодиоды. Кроме того, результаты моделирования потоков электронов и 
фотонов позволяют в едином процессе моделировать активные и пассивные 
элементы. При этом в качестве источников электромагнитного излучения 
можно задавать точечные источники в виде коротких отрезков тока. 

  Разработчики HFSS  предусмотрели такие возможности. В библиотеку 
материалов можно включать наноразмерные изотропные и анизотропные 
материалы. Однако требуется убедиться в достоверности  работы программ 
при расчете структур с предельно малыми размерами, на которые воздейст-
вуют  электромагнитные волны светового и СВЧ диапазонов волн. Особенно 
важным является то, что необходимо правильно описать источники световых 
волн. В программах электромагнитного моделирования в качестве источни-
ков излучения можно использовать источники тока или напряжения с собст-
венными размерами, намного меньше длины волны. 

    Рассмотрим светодиоды (СД) с объёмными резонаторами (ОР), которые 
считаются перспективными  [8], поскольку имеют существенные преимуще-
ства в сравнении с обычными СД. Например,  интенсивность спонтанного 
излучения светодиода при использовании высокодобротного резонатора уве-
личивается на порядок за счёт сужения спектра люминесценции. Кроме того,  

улучшается спектральная чистота и повышается направленность, а также 
температурная стабильность излучения, как отмечено в  [8]. 
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15.1. Моделирование  структуры  и  источников 
возбуждения в оптическом диапазоне волн 

   Принцип действия светодиодов основан на использовании полупро-
водниковых гетероструктур, которые состоят  из слоев с n- и p-проводимо-
стью. Благодаря разной концентрации носителей зарядов в отдельных слоях 
и наличию в этой сложной структуре областей, в которых происходит интен-
сивное накопление зарядов, возникают условия для перехода носителей заря-
дов с одного энергетического уровня на другой, и имеют место излучения 
фотонов, обеспечивающее свечение в определённом диапазоне длин волн. 
Эти участки концентрации носителей зарядов называют квантовыми ямами, 
нитями и точками в зависимости от того, как в них локализованы фотоны [9-
11]. Простые модели этих квантовых участков в соответствии с [10] пока-
заны на рис.15.1. 

 

 
 

                    а)                        б)                        в) 

Рис.15. 1. Активные области гетероструктур, в которых источники 
света представляются в виде квантовых ям (а), нитей (б) и точек (в) 

 
В [8] приводятся фотографии и структуры реальных СД с ОР, которые 

используются в волоконно-оптических системах связи инфракрасного диа-
пазона длин волн. В качестве наиболее коротковолнового СД, излучающего 
на длине волны 650 нм, представлена структура, изображённая здесь на 
рис.15.2,а.  

        
 
                            

                       а)                                                                      б) 
Рис.15.2. Структура (а) и спектры (б) СД на основе GaInP/AlInGaP с 

МКЯ и зеркалами Брэгга из слоёв AlAs/AlGaAs. 
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Резонатор образован многослойными зеркалами Брэгга. Активная об-
ласть СД содержит множество квантовых ям (МКЯ). Спектры излучения 
этого СД показаны на рис.15.2,б, где для сравнения по интенсивности и ши-
рине приведены также спектры обычного СД при разных токах. 

 
Из рис.15.2,б следует, что введение ОР обеспечивает увеличение ин-

тенсивности свечения в заданном направлении. Светотехники при этом гово-
рят о возможности получения высококонцентрированной кривой силы света, 
а в терминологии электродинамики в данном случае используется понятие 
узкой диаграммы направленности. 

При проектировании СД с ОР в [8] рекомендуется выбирать резона-
торы с наименьшей длиной, возбуждаемые на фундаментальном виде коле-
баний (ВК), и имеющие наиболее высокую собственную добротность, т.е. 
наименьшее поглощение (потери) в резонаторе. Однако реальные СД с ОР, 
включающие распределённые зеркала Брэгга и работающие на ВК, не вполне 
удовлетворяют этим рекомендациям. 

 
    Для решения задач оптического диапазона используя программы 
электродинамического моделирования, моделирование дискретных и 
точечных источников световых волн, а также распределенных источников, 
можно выполнить, можно использовать отрезки токов вдоль линий передач. 
Поглощение и потери в металле можно моделировать так, как это делается в 
диапазоне СВЧ,  т.е. в виде скин-эффекта,  модели металла с отрицательной 
диэлектрической проницаемостью, с помощью поверхностного импеданса 
(сопротивление на квадрат поперечного размера).  Итак, после формализации 
задачи и решении вопроса о моделировании структуры, можно рассмотреть 
задачу проектирования и оптимизации пассивных структур светодиодных 
модулей. 
 
 

15.2. Падение плоской волны на частотно-селективную 
поверхность 
 

   Важной  практической  задачей  в  световом  диапазоне,  можно  считать 
расчет падения световой волны на поверхность со сложной структурой. 
Поверхность с произвольной структурой можно отнести к частному слу‐
чаю частотно‐селективной поверхности. Поэтому, поставим задачу рас‐
считать  электродинамические  характеристики  этой  поверхности  для 
различных форм, материалов и потерь, свойственных этой поверхности.  

    Если считать, что спектр световой волны, излучаемой гетерострукту‐
рой, имеет вид, показанный на рис. 15.2,б, то зная коэффициент отраже‐
ния  частотно–селективной  поверхности, можно  получить  спектр  отра‐
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женной  волны.  Для  того  чтобы  решить  задачу  падения 
электромагнитной  волны  на  поверхность,  нужно  смоделировать 
структуру  бесконечного  размера  и  применить  периодические 
граничные  условия,  которые  реализованы  в  программах  HFSS.  
Использование  периодических  граничных  условий  резко  уменьшает 
объем задачи и позволяет на  современном компьютере  с  оперативной 
памятью 4 ГБ решить задачу с нужной точностью.  

Рассмотрим  бесконечную  многоштыревую  структуру,  состоящую  из 
цилиндрических  стержней,  показанных  на  рис.  15.3,а  графическими 
средствами  HFSS  .  Для  моделирования  бесконечной  структуры  нужно 
использовать  специальные  граничные  условия,  так  называемые, 
связанные  периодические  граничные  условия.    Расчеты  показали,  что 
волна, падающая на штыри (рис. 15.4), возбуждает синфазные поля ме‐
жду штырями.  

    Программа HFSS позволяет решить задачу падения электромагнитной 
волны  на  бесконечную  структуру  с  произвольной  формой  и  с  учётом  
потерь. Сверху и снизу структуры, охваченной периодическими гранич‐
ными  условиями,  выберем  точки,  в  которых  рассчитывается  ближнее 
поле перед плоскостью, и за плоскостью (т.е. отраженная и проходящая 
волна).     Представляет интерес определение частотных характеристик  
селективной  поверхности  при  различных  структурах,  отличающихся 
также  шероховатостью  поверхности  штырей,  материалом,  формами, 
размерами  структуры,  её  периодическим  или  случайным  характером 
повторения.     Частотную характеристику можно определить, выполняя 
моделирование  падения  плоской  волны  на  поверхность,  а  также 
возбуждая структуру с помощью точечных источников света. 

Один из вариантов устройств с четвертьволновыми  ОР и КТ в виде 
квантовых дисков (КД) представлен на рис. 15.3, где в изометрии и на проек-
ции изображена многорезонаторная штыревая система (МШС) с полупро-
водниковой гетероструктурой и люминофором.  

На рис.15.3,б показаны электрические силовые линии на входе МШС и 
КД на основе нитрида галлия синего свечения, возбуждающие жёлтый лю-
минофор. Длина штырей l соответствует четверти длины волны синего цвета, 
т.е. около 115 нм. Пространственный период (шаг) частотно-селективной 
структуры в 3-4 раза меньше длины l.  Точечные источники в виде КД распо-
ложены в шахматном порядке через один штырь в синфазных электрических 
полях противофазного вида колебаний (π-вида). Этот ВК, как известно из 
техники СВЧ, является наиболее устойчивым. 

 
Размеры КД (рис. 15.3,в) взяты из [11], где отмечалось, что структура с 

КТ из GaN в матрице AlN создана  на сапфировой подложке методом моле-
кулярно-лучевой эпитаксии. 
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а)                             б)                                                           в) 
  
 Рис. 15.3. Светодиодный модуль на основе многоштыревой четверть-

волновой РС (а,б) с квантовыми точками  в виде квантовых дисков КД (в). 
 
На рис.15.3,б приведены также эпюры электрического поля в МШС и в 

районе квантовых дисков. Электромагнитное поле, проникающее из МШС в 
полупро-водниковую структуру,  спадает экспоненциально и важно выбрать 
размеры штырей с интервалами между ними таким образом, чтобы получить 
максимальное электрическое поле в квантовых дисках для обеспечения наи-
более эффективного взаимодействия штыревой системы с гетероструктурой.  

Последовательность решения поставленной задачи в системе HFSS 
можно представить следующим образом. 

Командой Draw->Cilinder создадим металлический цилиндр с радиу-
сом 50 нм и высотой 200 нм.  Затем используем команду Edit-> Duplicate 
Copy для копирования и размножения штырей по координате X и по коорди-
нате Y на расстояние шага (рис. 15.4). 

 
 
Рис. 15.4. Радиус и высота штырей – переменные параметризируемые 

величины с начальными значениями 50 нм и 200 нм 
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Зададим плоскую волну, падающую на эту структуру командой Source 
-> Plane Wave. На рис.15.5 – 15.7 показаны фрагменты полей падающей, от-
ражённой и суммарной волн.   

Зададим граничные условия на окружающий этот фрагмент бокс. Для 
того, чтобы задать этот фрагмент как бесконечно повторяющийся, нужно 
задать на противоположные стороны периодические граничные условия 
Master-Slave. На нижнюю плоскость  Ground  зададим Perfect E, а на 
верхнюю плоскость – условие идеального поглощения Radiate. 

Зададим частоту расчета, например, 400 ТГц. 
 

 
Рис.15.5.  Падающая 
компонента (Incident) 

Рис.15.6. Отраженная 
компонента (Scattering) 

Рис. 15.7. Суммарное 
поле (Total) 

 
На этой частоте, после выполнения расчета, можно вывести 

падающую, отраженную компоненту и суммарное поле в сечении частотно-
селективной поверхности (рис. 15.5-15.7). 

 
Теперь добавим диапазон частот анализа командой Add Sweep. В 

появившемся по этой команде диалоге рис. 15.8 внесем оптический диапазон 
частот 100 ТГц – 1000 ТГц с шагом 20 ТГц. 

 
 

Рис. 15.8. Задание диапазона частот. 
 
Запустим расчет командой HFSS -> Analyzes All. В качестве 

характеристики отражения волны от частотно-селективной поверхности 
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можно вывести величину RCS (Radar Cross Section), которая зависит как от 
частоты, так и от угла падения плоской волны. 

Другим способом определения частотных свойств поверхности будет 
установка дискретных источников излучения в шахматном порядке, что 
позволит моделировать квантовые точки. На рис.15.9 и 15.10 показаны 
векторы рассчитанного электрического поля и источники электромагнитного 
излучения.  

 
 
Рис. 15.9. Поле Е в сечении штырей моделируемой поверхности 
 

 
Рис. 15.10. Фрагмент поверхности со штырями, на которые нанесены 

дискретные источники (квантовые точки) 
 
 

Для того, чтобы управлять возбуждением квантовых точек, заданных в 
виде дискретных источников электромагнитного излучения (рис. 15.10), 
зададим команду HFSS -> Fields -> Edit Source и установим модули 
источников возбуждения равными 1, а отсутствующие источники – равными 
0. Возбуждение структуры с помощью дискретных источников позволяет 
вывести на график параметр |S11|, который характеризует в диапазоне частот 
коэффициент отражения поверхности (рис. 15.11). 
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Рис. 15.11. Частотная характеристика отражения от частотно-
селективной шероховатой поверхности в световом диапазоне 

      Частотные  и  др.  характеристики  зависят  от  формы  штырей.  Если 
штыри  имеют  квадратные  сечения,  то    на  ребрах  концентрируется 
электрическое  поле,  что  приводит  к    увеличению  потерь  и  соответ‐
ствующему изменению резонансных характеристик. 

 

15.3.  Характеристики  светового  излучения  в 
многорезонаторных структурах 

 
    Кроме штыревой (открытой почти со всех сторон) наноразмерной 
структуры, представляют интерес  резонаторные системы различной формы, 
открытые только с одного торца, т.е. четвертьволновые ОР. Закрытые ОР 
отличаются более высокой добротностью и поэтому обеспечивают более 
эффективное излучение.  
 
     На рис.15.12 показана многорезонаторная система с четвертьволновыми 
цилиндрическими резонаторами (ЧЦР), возбуждаемыми на низших видах 
колебаний H111. Резонаторы выполнены в виде цилиндрических углублений 
в медной пластине. 
     Система состоит из цепочек связанных резонаторов (ЦСР). Квантовые 
точки (КТ) расположены через один резонатор в синфазных электромагнит-
ных полях. 
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Рис.  15.12.  Резонансная поверхность со связанными резонаторами 

 
     Расстояния между ЦСР должны быть значительно больше расстояний 
между резонаторами для исключения связи между рядами и обеспечения 
возбуждения ВК H111  с ориентацией электрических силовых линии вдоль 
ЦСР. 
      Выберем размеры в нм  и   частоты в TГц. Начертим базовую часть 
фрагмента поверхности, на которой будем создавать шероховатую 
поверхность (см. рис.15.13), командой Draw->Box. 

     
         
Рис.  15.13. Фрагмент поверхности с цепочкой связанных резонаторов 
 
    Далее начертим цилиндры высотой h=100nm и вычтем из параллелепи-
педа, составляющего фрагмент поверхности. 
 
    Возбудить такую поверхность можно падающей плоской волной 
(рис.15.14) или дискретными источниками. 
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Рис. 15.14. Поле в сечении резонансных отверстий при падении на 
поверхность плоской волны 
 
    Для того, чтобы решить задачу, охватим фрагмент поверхности 
периодическими граничными условиями (рис. 15.15), так, как было 
выполнено в главах 2-4. 

 
 

 
Рис. 15.15. Фрагмент отражающей структуры с цилиндрическими 
открытыми резонаторами (структура бесконечная, связывающая 

периодическими граничными условиями отдельный фрагмент, состоящий из 
четырех резонаторов) 

 
     Заметим, что результаты, полученные в HFSS, подтвердили, что система с 
цилиндрическими резонаторами обладает более высокой добротностью, чем 
штыревая структура. Использование цилиндрической системы будет 
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обстоятельно рассмотрено в последующих разделах. А здесь при 
рассмотрении полей вблизи шероховатых поверхностей вернёмся к 
многоштыревой системе. 
    Для вывода ближнего поля вдоль линии нужно сначала начертить эту 
линию, которую следует добавить командой Insert Near Field Setup   
в дереве проекта в разделе Radiation.  Эта линия показана на рис.15.16 для 
штыревых структур. Там же приведены векторы ближнего поля в верхних  
сечениях резонансных шероховатых поверхностей.  

 
 

Рис. 15.16. Поля в сечении резонаторов вблизи шероховатых поверхностей 
 

 

        Чтобы выполнить параметрический анализ шероховатой поверхности с 
круглыми штырями, зададим команду Optimetric. В качестве 
параметрически изменяемых переменных выберем высоту штырей от 60 нм 
до 220 нм. На рис.15.17 приведены резонансные характеристики, полученные 
для разных высот цилиндрических штырей. 
 

 
Рис.  15.17. Частотные характеристики структуры (на отражение) для 
разных высот цилиндрических штырей 

     На  основании  экспериментальных  расчетов  подтверждено,  что 
максимум электрического поля достигается в верхнем сечении штырей 
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и    РС.  Эпюра  электрического  поля и  электрические  векторы показаны 
на рис.15.18.  
 

 

а) РС, состоящая из круглых 
стержней. 

б) РС, состоящая из прямоугольных стержней. 

Рис.  15.18.  Многоштыревые  структуры  с  круглыми  (а)  и 
прямоугольными (б) стержнями.  

   Для  структуры,  показанной  на  рис.  15.18,    а  с  круглыми  штырями, 
приведем  результаты  расчета  рабочей  полосы  частот  и  добротностей, 
которые получены в HFSS для материалов с разными проводимостями, а 
также шероховатостями.  
 

 
Рис. 15.19. Диалог задания граничного условия материала с конечной 
проводимости, в котором можно ввести в виде дополнительного 
параметры шероховатость (Surface Roughness) поверхности материала.  
 
 

Медь  Медь  с  Молибден   Вольфрам 
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σ=5.8∙107 См/м  шероховатой 
поверхностью 
 

σ=1.76∙107 См/м  σ=1.85∙107 См/м 

100 ТГц  200  250  220 

Q=10  5  4  4.5 
         
Следует отметить, что значения добротностей, приведенные в таблице, 

являются слишком малыми. Поэтому далее вместо открытой 
многоштыревой структуры рассмотрим другие резонаторные системы с 
более высокими добротностями. При этом будем обращать внимание на 
возможности использования низших ВК и обеспечивать такие размеры 
резонаторов, чтобы резонанс фундаментального ВК соответствовал 
максимуму  спектра излучений активной среды, в качестве которой в данном 
случае предполагается использование квантовых нитей и точек. 

  
 

15.4. Моделирование резонансной структуры со 
стабилизирующими резонаторами 

 
    В технике СВЧ часто применяются стабилизирующие резонаторы, 
которые влияют на открытый резонатор так, что собственная резонансная 
частота становится более стабильной за счёт увеличения собственной 
добротности всей резонаторной системы [8]. Это явление можно применить 
при создании сложной поверхности, работающей в оптическом диапазоне 
волн.  
В качестве первого примера использования стабилизирующего резонатора 

рассмотрим резонаторную систему, состоящую из двух четвертьволновых 
цилиндрических резонаторов, связанных со стабилизирующим 
полуволновым призматическим резонатором. Эта система в виде триады с 
синими, зелёными и красными КТ показана на рис.15.20. В цилиндрических 
резонаторах возбуждаются противофазные колебания на низших видах Н111, 
которые поддерживаются и стабилизируются видом колебаний Н103 в 
стабилизирующем резонаторе, созданном на основе прямоугольного 
волновода с волной низшего типа Н10. 
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Рис. 15.20. Система в виде триады, состоящей из четвертьволновых 

цилиндрических резонаторов с призматическими 
стабилизирующими резонаторами. 

 
В системе используются щели связи по магнитному полю, расположенные 

на расстоянии, составляющем половину волноводной длины волны в 
призматическом резонаторе. 

 В качестве активного элемента предполагается использование квантовой 
точки (КТ) в виде наноразмерного диска диаметром t, расположенного 
между четвертьволновыми цилиндрическими резонаторами в максимуме 
электрического поля (рис. 15.21). 
    Размеры стабилизирующего резонатора для синей, зелёной и красной длин 
волн (λ1 = 460 нм,  λ2 = 525 нм и λ3 = 635 нм) определяются по формулам, где  
и b <  (обычно). 
   Например, при 250 нм  получаем d1=304 нм, d2=362 нм и d3=482 нм. 
     Затем, исходя из  выражения для и ,  
находим  а1=302 нм, а2=341 нм и а3=396 нм; после чего выбираем b1=150 нм, 
b2=170 нм и b3=200 нм. 
    Протяжённости стабилизирующих резонаторов с ВК Н103 на основании 
выражения  получаем равными   L1=1062 нм, L2=1235 нм и L3=1596 нм. 

 Анализ излучателей в системе HFSS позволяет также получить  
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пульсирующую картину электромагнитного излучения в динамическом 
режиме. Результаты анализа излучения из одной квантовой точки 
рассмотренного ОР в системе HFSS иллюстрируются на рис.15.20, где 
показано поле в фиксированный момент времени.   

 
Рис.15.21. Картина излучения из КТ в фиксированный момент времени 

 
А на рис.15.22 зафиксировано излучение в тот момент, когда в щелях 

связи максимальное электрическое поле, а вблизи КТ минимальное из-за 
расстояния в четверть длины волны. 

 

     
  
                             а)                                                                  б) 

Рис.15.22. Излучение из КТ (а) в момент времени, когда в щелях связи 
максимальное электрическое поле (б) 

 
Необходимо отметить, что из техники СВЧ известны более 

высокодобротные стабилизирующие резонаторы, чем призматические на ВК 
Н10р. К ним, например, относятся цилиндрические резонаторы на основе ВК 
Н01р, которые будут рассмотрены в следующем разделе. 
 

15.5. Квантовые нити и точки над резонаторами 



  207

 
15.5.1. Резонаторные системы с квантовыми нитями на ламелях 

 
Рассмотрим пример наиболее высокодобротного СР, основанного на 

уникальной особенности волны типа Н01 в круглом волноводе, при 
распространении которой потери в стенках волновода чрезвычайно малы. Из 
техники СВЧ также известно, что используемые в коаксиальных 
магнетронах СР на видах колебаний Н011 дают увеличение собственной 
добротности многорезонаторной системы почти на порядок [11,12]. В связи 
с этим  предлагается использовать идеи, реализованные в обращённо-
коаксиальных и торцевых стабилизированных магнетронах (ОКМ и ТСМ), 
для создания наноразмерных излучателей.  

Один из этих вариантов относится к излучателю кругового действия, 
который можно представить, как аналог ОКМ. Так, на рис.15.23  приведена 
схема излучателя в виде обращённой системы ламельного типа, 
возбуждаемой на π-виде колебаний от азимутально-симметричного вида Н011 
во внутреннем цилиндрическом резонаторе с помощью ЩС, расположенных 
через один резонатор.  

 
 

Рис. 15.23. Излучатель кругового действия (аналог ОКМ) 
 

На концах ламелей (Л) тоже через одну Л расположены квантовые нити 
(КН) длиной не более ширины Л. Размеры Л по ширине и длине составляют 
менее четверти длины волны излучаемых колебаний, а длины СР с синими, 
зелёными и красными КН в данном случае могут быть взяты примерно 
равными 290, 370 и 620 нм при одинаковых диаметрах резонаторов по 900 
нм. 

 
Другой вариант представляет СДМ осевого излучения с СР на виде 

колебаний Н011 как аналог ТСМ (рис. 15.24).  
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Рис.15.24.  Излучатель с квантовой звёздочкой (аналог ТСМ) 
 

В отличие от излучателя  кругового действия здесь Л и ЩС находятся на 
торцевой поверхности СР с видом колебаний Н011. На концах Л (чётных или 
нечётных) расположены КН одного цвета. И такие радиальные КН на 
торцевой поверхности могут восприниматься как «квантовые звёздочки».  
[18,19].Рассматриваемая конструкция удобна для нанесения люминофорного 
покрытия, состоящего из зёрен люминофора (ЗЛ), размеры которых могут 
быть сравнимы с шириной Л. Жёлтые люминофоры в сочетании с синими 
КН обеспечивают белое свечение. При этом целесообразно использовать 
отражатель для получения желательного светораспределения излучателя.  

Излучатели, представленные на рис.15.23 и 15.24, были 
проанализированы в системе HFSS. Расчётные резонансные характеристики 
подтверждают возможность увеличения собственной добротности при 
введении СР.  

На рис. 15.25 и 15.26 приводятся иллюстрации, полученные в системе 
HFSS при анализе второго резонатора с квантовыми звёздочками на ламелях.  

                    
    
                                       а)                                                                       б) 
Рис. 15.25. Резонаторная система с торцевыми ламелями в изометрии (а) и 
в плане (б). 
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Рис.15.26.  Излучение из квантовой звёздочки в фиксированный момент 

времени. 
 

 
15.5.2. Резонаторные системы с квантовыми  

кольцами 
   Можно представить и более простые устройства излучателей, 
использующих «квантовые колечки». Один из таких излучателей показан 
схематически на рис. 15.27.  

 
Рис.15.27. Излучатель с квантовым колечком. 

 



 210

    Этот излучатель в некоторой степени является аналогом ячеек, 
приведенных на рис. 15.19. В нём используется несколько четвертьволновых 
цилиндрических резонаторов (например, четыре), расположенных по 
окружности. В данном примере в этих резонаторах возбуждаются   
синфазные колебания видов Н111, связанные через щели связи (ЩС) со 
стабилизирующим резонатором на основе полуволнового круглого 
волновода с видом Н01р (на рисунке показаны силовые линии вида колебаний 
Н012). Вместо КН в представленную ячейку введено синее квантовое колечко 
(СКК), расположенное в своей матрице (М) вдоль электрических силовых 
линий. Таким образом, излучающим элементом в данном излучателе 
является как бы КН, свёрнутая в кольцо. 
    На рис.15.28 приведена картина электромагнитного поля в резонаторной 
системе и в ближней зоне излучателя в фиксированный момент времени, а 
также частотная характеристика резонаторной системы без 
полупроводниковой структуры, которые были получены в  HFSS. 
 
 

 
 
Рис. 15.28. Частотная характеристика и картина электромагнитного поля 

на рабочей частоте 650 ТГц 
 
    Из рис.15.28 видно, что в диапазоне частот от 500 до 1000 ТГц  получено 
несколько резонансных характеристик, одна из которых соответствует 
резонансу ВК Н012 в СР на частоте 650 ТГц. Подтверждением этому факту 
является картина с двумя вариациями поля вдоль оси СР.  
   Заметим, что ВК Н012 не является низшим, и поэтому наблюдаются 
резонансы на более низких частотах. Однако разделение ВК вполне 
достаточное для того, чтобы не возникало «паразитных» колебаний, 
снижающих эффективность излучения на рабочей частоте.  
Следует обратить внимание на то, что резонансная характеристика РС с СР 
на ВК Н012 является наиболее узкой, что свидетельствует о высокой 
добротности РС на рабочей частоте. 
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На рис.15.29 приведена картина поля в момент времени, когда в щелях 

связи  электрическое поле достигает максимального значения, а вблизи КК  
при этом нулевое поле, поскольку КК находится на расстоянии в четверть 
волны от ЩС.  
На рис.15.29 также приведено распределение азимутальной составляющей 

электрического поля в радиальном направлении, т.е. вдоль линии, 
показанной на рисунке. Азимутальная составляющая электрического поля на 
ВК Н01р является единственной и кривая, соответствующая рабочей частоте 
650 ТГц, показывает, где расположен максимум электрического поля и куда 
следует поместить КК. 
  
 

 
Рис.15.29.  Распределение электрического поля в радиальном направлении и 
иллюстрация излучения в момент времени, когда в щелях связи 
максимальное электрическое поле. 
 

Заметим, что поперечные размеры рассмотренного излучателя 
ограничены диаметрами четвертьволновых резонаторов, которые не должны 
превышать 0,6 λ, чтобы они допускали возникновение только низшего ВК 
Н111, и диаметром СР, который не должен быть существенно больше 1,2 λ, 
чтобы не возникало множество высших ВК.  

Это обстоятельство находится в противоречии с необходимостью 
обеспечения достаточных технологических размеров для изготовления 
эффективных полупроводниковых структур на основе КТ из InGaN в матрице 
GaN [19]. Поэтому, желательно увеличить размеры матрицы с КТ. 

Для этого предлагается устройство излучателя, схематически 
представленного на рис.15.30, в котором используется коаксиальный СР, 
возбуждаемый на виде колебаний Н011 и расположенный внутри 
многорезонаторной системы, состоящей из цилиндрических 
четвертьволновых резонаторов (ЧР) с видами колебаний Н111. На рис. 15.30 
показаны 8 резонаторов с противофазными колебаниями при связи с СР 
через один ЧР. Над этими резонаторами расположена дисковая матрица 
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(ДМ) с КТ. Расчётные размеры резонаторов для синих и красных КТ в 
соответствии с обозначениями на рис.15.30 приведены в таблице.  

 
  Таблица. Размеры (в нм) излучателя, представленного на рис.15.30. 
Цвет Длина 

волны 
Dчр Dср d h 1 h 2 Dм 

Синий 460 340 680 100 555 370 1360 
Красный 640 480 960 140 750 755 1920 

  
 

 
 

 
     

Рис. 15.30. Излучатель с коаксиальным стабилизирующим резонатором. 
 

 Для обеспечения наиболее эффективной электромагнитной связи между 
СР и ЧР их размеры следует подобрать таким образом, чтобы отрезки 
волноводов, из которых получены резонаторы, имели одинаковые 
критические и соответственно волноводные длины волн, т.е. h 1 = 3/4λв и h 2= 
λв/2. 

Устройство рассматриваемого излучателя удобно тем, что диаметр 
матрицы Dм можно  увеличивать за счёт увеличения количества ЧР. При 
этом с увеличением диаметра Dср необходимо будет соответственно 
увеличивать диаметр стержня d для сохранения резонансной частоты.                               

Подводя итоги рассмотрения предлагаемых излучателей отметим, что 
световой поток одного такого наноразмерного устройства очень мал, и эти 
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излучатели следует собирать в массив. Каждый излучатель при этом может 
дополняться отражателем.  Такие излучатели могут группироваться, 
например, в полноцветные (синие, зелёные и красные) триады. Полученное 
светоизлучающее устройство может быть использовано как источник света с 
регулируемой цветностью хроматического или белого излучений, а также 
применяться в дисплеях с высокой разрешающей способностью. 

Световая отдача излучателя с синими КН в сочетании с жёлтым 
люминофором во многом зависит от собственной добротности 
многорезонаторной системы, настроенной на частоту синего цвета. При 
использовании цветовых триад без люминофоров световая отдача каждого 
цветового элемента также существенно зависит от добротности  и настройки 
многорезонаторной системы со стабилизирующим резонатором на длину 
волны, излучаемую квантовой звёздочкой или квантовым колечком. 
 

15.6. Анализ структуры, составленной из восьми 
резонаторов в оптическом диапазоне длин волн 

 
    Рассмотрим этапы анализа резонаторной структуры оптического 
диапазона длин волн в системе HFSS на примере излучателя, 
представленного на рис.15.30.  
   На первом этапе осуществляется черчение и создание конструкции 
резонатора. Выберем единицы черчения «нм»  и  частот «TГц». 
 
Для синего света λс = 460 нм  
D =1.5 мкм, Dс = 750 нм, d =100 нм, Dч=380 нм, lч=490 нм и  lс=325 нм;  
 
для красного  λк = 640 нм   
D=2.1 мкм, Dс =1050, d=150 нм Dч=525 нм, Длиныч  = 675 нм,  lс=450 нм. 
 
Длина щели связи: 400 нм. 
 

Резонаторная структура с указанными размерами и квантовым колечком, 
выполненная графическими средствами HFSS, показана на рис.15.31 в 
изометрии и в плане.  
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Рис.15.31.  Структура, в которой щели расположены через один внешний 
резонатор, т.е. связаны с центральным коаксиальным резонатором 1,3, 5, и 
7 внешние цилиндрические резонаторы 
 
     Создание этих рисунков выполнено при использовании следующих 
команд.  Начертим базовую структуру резонатора командой Draw-> Box 
(рис.15.32). 
 

 
Рис.15.32. Размеры базового металлического бокса 

 
   Далее в этом боксе нужно вырезать один центральный цилиндр радиусом 
525 нм и 8 цилиндров радиусом 262.5 нм. 8 резонаторов размещены так, что 
между центральными боковыми располагается щель связи (рис.15.33 и 
15.34). 
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Рис. 15.33.Центральный цилиндр Рис.15.34. Малые цилиндры 
 
    Командой Edit->Duplicate->Around Axis  дублируем цилиндры вокруг 
оси и умножаем на 8.  
     Далее начертим внутренний стержень, расположенный вдоль оси Z 
(рис.15.35) 

 
Рис.15.35.  Размеры внутреннего металлического стержня. 

 
    Далее на высоте 400 нм начертим колечко, вычитая один цилиндр из 
другого (рис.15.36 и 15.37). 

Рис.15.36. Размеры внешнего 
цилиндра. 

Рис.15.37. Размеры внутреннего 
цилиндра. 

 
    В результате вычитания получаем планарное кольцо шириной 20 нм. 
Установим граничные условия Perfect E на квантовое колечко. Чтобы 
вставить в это кольцо 8 портов, которые будут возбуждать 
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последовательный ток в  кольце, прорежем в планарном кольце 8 
прямоугольников, размер первого из которых соответствует рис. 15.38.  
 

 
Рис. 15.38.  Координаты прямоугольника в разрыве квантового колечка, на 
который устанавливается  дискретный порт.  
 
     Создав этот прямоугольник, зададим на него дискретный порт командой 
HFSS->Exitation-> Assign Lumped Port и задавая импедансную линию 
посередине этого прямоугольника. Далее выполним дублирование этого 
прямоугольника с сохранением граничных условий относительно оси Z. 
 

 
 
          Рис.15.39.  Диалог дискретного порта, поставленного в разрыв 
квантового колечка. 
 
   Созданную структуру, показанную на рис. 15. 31 охватим боксом, 
созданным по команду Draw->Box, размеры которого в нанометрах указаны 
на рис. 15.40.  



  217

 
Рис.15.40. Размеры бокса Radiate. 

 
 На этот параллелепипед установим граничные условия излучения, а на 
боковые стенки – периодические граничные условия Master-Slave на 
противоположные стенки бокса излучения (рис. 15.41). 
   

 
 
 
Рис.15.41. Постановка периодических граничных условий Master-Slave на 
противоположные стороны бокса, охватывающего одну ячейку резонатора. 
 
    Выполним установку на расчет командой HFSS-> Analysis setup->Add 
Solution Setup. Центральная частота 467 ТГц соотв. длине волны 640 нм (рис. 
15.42). 
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Рис.15.42.  Задание центральной 
частоты анализа 

Рис.15.43.  Задание полосы частот 
(режим интерполяции) 

  
    Заметим, что если квантовые точки будут расположены равномерно в 
квантовом колечке, то они будут возбуждаться противофазно в соответствии 
с полями в цилиндрических резонаторах. Картина излучения в этом случае 
представлена на рис.15.44 и 15.45. 
 

 
 
Рис.15.44. Излучение электромагнитной волны оптического диапазона из 

квантового колечка в системе с внутренним коаксиальным 
стабилизирующим резонатором 
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Рис.15.45.  Ближнее поле в сечении резонатора  при установке 

противофазного возбуждения квантовых точек. 
 
     На рис.15.46 приведена частотная характеристика, а на рис.15.47 - 
картина электромагнитного поля при возбуждении КТ, расположенных в КК 
через один резонатор. 
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Рис. 15.46. Частотная характеристика S11 по каждому порту, внедренному 

в КК (8 портов) 
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Рис.15.47. Картина электромагнитного поля при возбуждении КТ, 
расположенных в КК через один резонатор 

 
  Анализируя динамическое движение картины электромагнитного поля, ко-
торое рассчитывается, изменяя фазу источника возбуждения, можно видеть, 
как взаимодействуют электромагнитные поля, излучаемые от отдельных ре-
зонаторов, общую картину поля и типы волн, которые резонируют в отдель-
ных полостях цилиндрических резонаторов. 
 
Выводы. Рассмотренные  варианты СДМ на основе ОР с квантовыми 
точками, звёздочками и колечками ни в коей мере не ограничивают 
разнообразия этих устройств. Не трудно представить и другие 
конструктивные варианты СДМ на основе четвертьволновых 
многорезонаторных систем с другими видами колебаний, в том числе и с 
разнообразными высокодобротными стабилизирующими резонаторами.  

В настоящее время представление излучателей в виде квантовых звёздо-
чек и колечек могут показаться нереально фантастическим, и моделирование 
таких источников  еще требует многостороннего экспериментального под-
тверждения.  Однако прогресс теоретического анализа перспективных нано-
материалов и успехи нанотехнологии показывает, что это будет реализовано 
в недалёком будущем.         

Многочисленные публикации, в которых показано использование 
HFSS показывают, что ее можно успешно применять для оптимизации 

структуры светодиодного модуля. Можно с уверенностью утверждать, что 
поиски оптимальных решений при создании СДМ на основе элек-

тродинамических систем с квантовыми точками позволят существенно 
улучшить параметры световых приборов с наноразмерными источниками из-

лучений.
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16. Установка конфигурации для распределенного 
расчета на нескольких компьютерах 

        

   HFSS -13 имеет возможность решать задачи огромного размера, когда 
число  тетраэдров разбиения может достигать многих тысяч. 

     В последние 10 лет наблюдался огромный  прогресс в усилении 
компьтерных средств для решения больших задача - от создания больших 
вычислительных серверов,  до распределенных кластеров и 
многопроцессорных настольных рабочих станций. Параллельно шло 
улучшение математических алгоритмов и программ их реализации. На рис. 
16.1 показываются вехи прогресса в расчете физических задач, в 
механическом анализе, и в решение электродинамических задач поля  
Ansoft. В настоящее время считается, что применение HFSS в процессе 
проектирования на 15% ускоряет процесс разработки новых изделий от идеи 
до воплощения в железе.  

 

Рис. 16.1. История роста характеристик производительности системы HFSS 
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     Один из способов увеличить производительность состоит в параллельном 
моделировании. Из рис. 16.1. видно, что  в 1998-1999 можно было решить 
систему уравнений в 10M ячеек. В 2004  HFSS Ansoft решал структуру с 
100M ячейками. Сегодня ANSYS может анализировать структуру с 1 
миллиардом ячеек, и уровень точности моделирования очень высокий.  
 
   Т.о. ключевым является новый метод, для реализации которого необходи-
мо иметь специальную лицензию High Performance Computing  (HPC). 
     Этот  метод позволяет реализовать 2 подхода к расчету: 
 
       1) Domain Decomposition, 
       2) Multi-processing. 
 
     Решение методом HPC сводится к мультипроцессному расчету, используя 
опции распределенного расчета, используя до 100 ядер на одно 
моделирование. Заметим, что далее в этом разделе термина «вычислительная 
машина» может относиться к персональному, а также супер-компьютеру. 
Ядры и процессоры могут характеризовать любую из этих машин. 
 
      Начиная с HFSS v.12, компания Ansoft  развивает метод HPC используя 
метод декомпозиции задачи. Метод MP (multi-processing) был реализован в 
HFSS-7.  Опция распределенного решения DSO реализована начиная с 
HFSS-10. Эти опции используются уже сегодня, чтобы уменьшить время 
моделирования от дней до часов, позволяя инженеру выполнить 
многократные моделирования в течение одного рабочего дня.   Для этого 
были разработаны и предложены специальные методы мультипроцессорного 
и мультикомпьютерного расчета  HPC и реализованы дополнительные 
улучшения в HFSS v.12 (улучшенное разбиение на сетку и смешанные 
порядки элементов разбиения) для существенного увеличения  
производительности. 
 
    Поясним термины, которые пришли в проектирование вместе с усилением 
мощности численного моделирования. 
 

1. HFSS HPC –  новая опция, появившаяся  в HFSS 12 
     HPC = High Performance Computing 
 
2. Enables Domain Decomposition, метод декомпозиции - новый метод 
     решения в HFSS 12. DDM = Domain Decomposition Method. Новый 
      метод DMP в HFSS. DDM - это метод высокого запараллеливания, 
причем: 

– это метод объединения памяти и ядер с помощью сети; 
– DDM реализует значительное увеличение памяти для больших и 

очень больших задач; 
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– быстрое решение, использующее большое количество 
процессоров. 

 
     3. Multi-Processing - многопроцессорный метод параллелизации разде- 
         ляемой памяти, введенный в HFSS 7.    MP = Multi-Processing 

– “Традиционный” многопроцессорный SMP. 
 
    4. Необходимое количество лицензий “ HPC licenses ” для моделирования 
зависит   от числа ядер, которые требуются для расчета. 

5.  Работа в режиме пакета (Packs) или " плавающем (pool) " режиме. 
 

– Packs позволяет использовать заданное число ядер для 
программы; 

– “Pool” лицензии позволяют любое число ядер, управляемых 
мульти-серверами. 

 
• SMP = Shared Memory Parallel. 
• DMP = Distributed Memory Parallel. 

 
• DSO = Distributed Solve Option - много-параметрическое (геометрия, 

частота) параллельное моделирование. 
• RSM = Remote Simulation Manager - новая программа 

распределенного анализа, появившаяся в HFSS v12, предназначенная 
для работы компьютера  в сети 

 

 
Примеры расчетов, которые выполнены, используя 

лицензию HPC 
 

    Пример 1. Военный автомобиль Хаммер имеет антенну, 
расположенную на крыше.  Задача электромагнитной совместимости 
решается на частоте 1.8GHz и имеет размер > 7500λ3   и использует: 

• Базисные функции второго порядка (2nd order);    
• 730,000  тетраэдров; 
• 14M неизвестных в матрице (это даже мало, для использования метода 

DDM); 
• Выполнение расчета с помощью трех связанные групп компьютеров; 
• Общая память=115 GB. 
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Рис.  16.2. Пример расчета структуры антенны на движущемся объекте  
 
    Результаты расчета пространственной диаграммы направленности показа-
ны на рис. 16.2. 
 

Пример 2. Антенна, смонтированная на корпусе истребителя F-
35.    Анализируемая щелевая антенна (рис. 16.3) находится в крыле внизу 
фюзеляжа самолета  
• F-35 Joint Strike Fighter: UHF blade antenna @ 350 MHz 
• Размер задачи = 1400λ3 

 

 

 

 

Рис. 16.3. Военный истребитель F-16 с антенной 
внизу фюзеляжа 

Рис.16.4. Щелевая антенна 

 

При решении этой задачи используется метод DDM. 
• DDM подобласти разбиваются на сетку разбиения в маленьких 

подобластях “sub-domains” так, что поле в них рассчитывается 
параллельно на нескольких компьютерах. Для этого выполняется: 

– Выбор узла “master” итерационного солвера для общего решения 
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– Автоматическое разбиение области решения на подобласти 
• Пользователь определяет набор N доступных компьютеров для 

использовании методом  DDM: 
– n=1  это узел “master”, одно ядро; 
– n=2 до  N это узлы подобластей решения по сравнению с прямым 

решением. 
 
 

 
Рис. 16.5. Разбиение пространства расчета на тетраэдры, области и 

подобласти 
 
Результаты расчета совпадают, при решении непосредственно 

программой HFSS, и при использовании метода DDM. Однако время 
расчета значительно отличаются. 
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Рис. 16.6. Сечение диаграммы 
направленности антенны на 
корпусе самолета 

Рис. 16.7. Пространственная 
диаграмма направленности 

 
 
 
 

 

 
Рис. 16.8. Частотная 
характеристика 

Рис. 16.9. Время расчета в 
зависимости от количества 
областей разбиения 

 
 
 

Пример 3:   Двухзеркальная параболическая антенна (рис. 
16.10) создана по схеме Коссегрена. Размер  задачи  ~17,500 λ3 . 

 

   Время решения   при решении на 8 ядрах 12509 сек. Время решения 
ускоряется в 17-24 раз и равно 3891 сек при использовании лицензии HPC. 
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Рис. 16.10. Двухзеркальная параболическая антенна 

 
    В таблице рис. 16.11. приведены машинные ресурсы, затрачиваемые при 
моделировании двухзеркальной параболической антенны, которые зависят 
от числа ядер. И ускорение процесса решения задачи при включении 
дополнительных ядер. Видим, что ускорение доходит до 6 по сравнению с 
базовой конфигурацией с 8 ядрами.  Отметим, что ускорение расчета по 
сравнению с работой на одном процессоре выполнить невозможно. 
 
 

 
Рис. 16.11. Компьютерные ресурсы, требуемые при решении двухзеркальной 
антенны. Ускорение Speed-up по сравнению с базовым компьютером с  8 
ядрами 
 
   
    Для решения подобных задач необходимо установить менеджер 
удаленного моделирования RSM (Remote Simulation Manager). Эта 
программа инсталлируется как отдельная программа и автоматически 
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создает удаленные или связанные в сети моделирования в режиме связи  
“links”. 
  

• Метод нового распределенного анализа для работы с удаленными 
компьютерами 

• Активизирует возможности солвера в режиме DDM, DSO и удаленного 
решения 

     

Установка конфигурации распределенного расчета. 
 Чтобы создать новую конфигурацию распределенного расчета на нескольких 
компьютерах: 

1. Кликните  HFSS или HFSS-IE>Tools>General Options чтобы вывести 
диалог General Options и выбрать закладку  Analysis Options.  

 

Рис. 16.12. Диалог опций HFSS 

2. Выберите закладку  Analysis Options, и в разделе  Analysis Machine 
Options, выберите опцию Distributed.  Эти изменения будут показаны в 
закладке Analysis Machine Options и покажут панель для просмотра и 
редактирования конфигурации компьютеров (рис. 16.13). 
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Рис. 16.13. Опции анализа  компьютеров в сети 

3. Кликните кнопку Edit Distributed Machine Configurations. 

 

Рис. 16.14. Диалог конфигураций распределенного расчета 

   Это выведет диалог Distibuted Machines Configurations (рис. 16.14). Этот 
список существующих конфигураций показывает все машины и выбранные 
конфигурации, а также информацию, заблокированы они или нет. Здесь вы 
можете добавить новую конфигурацию нажимая Add, отредактировать  
конфигурацию командой  Edit, удалить выбранную конфигурацию командой 
Delete, или дублировать существующую конфигурацию командой Clone, 
обычно редактируя имя и содержание конфигурации.  

4. Чтобы создать новую конфигурацию, кликните  в диалоге рис. 16.14 
кнопку Add.  

Это открывает диалог Distributed Analysis Machines (рис. 16.15). Нажатие 
Edit или Delete также открывает диалог Distributed Analysis Machines, но 
включает имеющиеся выбранные конфигурации.  
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Рис. 16.15. Диалог списка машин, используемых в распределенном расчете 

 Здесь вы можете отредактировать имя конфигурации, вид, добавление, тес-
тирование и блокирование машин в списке.  

5. Задайте имя конфигурации. Он не может быть пустым и не может иметь 
ранее заданное или зарезервированное слово. 

6. Для каждой машины чтобы вручную добавить список, under Remote 
Machine details, задайте адрес IP , имя DNS или имя  UNC. Вы можете также 
использовать Import Machines from File... для использования текстового 
файла для упрощения процесса. 

 

Рис. 16.16. Раздел, в котором включаются машины в список 

   Кнопки управления позволяют добавить машину в список командой Add 
machine to list (рис. выше) или удалить командой Remove (рис. ниже) 
машины из списка.  
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     Каждая машина в текущем списке имеет окно Enabled.  Вы можете 
заблокировать или подключить любые машины в списке по вашему 
желанию. Сверху таблицы, диалог позволяет учитывать общее количество 
машин, и это число может быть включено или заблокировано. 

 
Рис. 16.17. Блокирование и включение машин в распределенный расчет 

 
   В общем случае, HFSS и HFSS-IE используют машин в распределенном 
списке машин анализа в порядке, в котором они появляются. Если выбран 
Распределенный метод расчета, и Вы запускаете несколько расчетов от того 
же самого интерфейса, то HFSS и HFSS-IE выбирают машины, которые 
выполняют наименьшее количество компьютеров в порядке, в котором 
компьютер находятся в списке. Например, если список содержит 4 машины, 
и Вы запускаете моделирование, которое требует одну машину, HFSS 
выбирает первую машину в списке. Если другое моделирование запущено, в 
то время как выполняется предыдущее, и это моделирование требует две 
машины, HFSS выбирает машины 2 и 3 из списка. Если первое 
моделирование тогда завершается, и мы запускаем другое моделирование, 
требующее три машины, HFSS выбирает машины в порядке 1, 4, и 2. 
 
   Отображенный список всегда показывает порядок, в который Вы ввели их 
независимо от загрузки на машинах. Чтобы управлять порядком в списке, 
выберите один или большее количество машин, и используйте кнопки Move 
up  или  Move  down. Передвижение вверх и вниз  допускаются, когда Вы 
выбираете один или большее количество смежных имеет машин. Также, 
когда Вы выбираете один или большее количество имен машин, Вы будете 
видеть поле текста ниже управления сети, показывая сначала имя машины, 
сколько раз она появляется, допускается, и заблокирована.  
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Рис. 16.18. Передвижение машин в списке для изменения 

последовательности их включения 
 
7.  Test  Machines‐  Когда несколько пользователей в сети используют 
распределенное дистанционное решение, нужно проверить состояние этих 
машин перед запуском моделирования, чтобы убедиться, что никакие другие 
процессы Ansoft не запущены. Чтобы сделать это, вы можете выбрать одну 
или большее количество машин в диалоге (рис. 16.18) и нажать кнопку Test 
Machine.   Открывается диалог Test Machines. После тестирования дается 
отчет относительно состояния каждой машины.  
     Тестирование можно выполнить и над группой машин, включенных в 
распределенных расчет. Включить или выключить машины можно в списке 
диалога рис. 16.18. 

8. Кликните OK, чтобы сохранить изменения и закрыть диалог Distributed 
Analysis Machines.  Только машины, отмеченные как Enabled  появляются в 
списке распределенных машин в закладке Analysis. 

     Независимо от машины, на которой фактически выполняется анализ, 
числа процессоров и установки Desired RAM Limit, и заданных по 
умолчанию параметров настройки приоритета процесса теперь читается из 
машины, из которой Вы запускаете анализ.  

   Если конфигурация установлена, то ее можно выбрать на инструменталь-
ной панели, выбирая значки: 

 
Рис. 16.19. Кнопки на панели HFSS, позволяющие оперативно переключать 
режим локальной, удаленной и распределенной работы  
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   Заметим, что эта опция активна только в том случае, если имеются 
несколько машин для распределенного анализа. Режим распределенного 
анализа рекомендуется использовать в том случае, если не достаточно 
ресурсов одного компьютера.  
     На одном компьютере HFSS работает следующим образом. Сетка - по 
существу большая матрица, которая должна быть инвертирована и решена. 
HFSS пытается сделать всё это в RAM. Как только доступная RAM 
исчерпана, HFSS начинает    разделять матрицу на части, в которых 
некоторые матричные элементы записываются на жесткий диск, и другие 
части сохранены в RAM. Однако имеется минимальный размер матрицы, 
которая должна быть сохранена в RAM, и должно остаться пространство в 
памяти, чтобы была возможность инвертировать и решить матрицу. Если 
матрица является настолько большой (сетка является настолько большой), 
что этот минимальный размер больше не помещается в RAM, HFSS 
остановится. 
      Пользователь имеет два несколько вариантов действий.  
    Он может 1)увеличить RAM компьютера, или 2)может использовать 
итерационное решающее устройство, или 3) использовать лицензию, и 
соответственно метод HPC, чтобы решить проблему.  Рекомендуется  
использовать итерационное решающее устройство. Использование  Iterative 
Solver может резко уменьшить требования RAM. 

        Правила использования итеративного солвера 
 
1. Итеративный солвер работает более эффективно, когда структура не 
содержат много источников возбуждений. (Например, число возбуждений – 
меньше, чем удвоенное число процессоров.) 
 
 2. Если вы хотите использовать преимущество итерационного решающего 
устройства, и ваш анализ включает расчет на многих дискретных частотах, , 
адаптивное решение должно лучше сходиться на самой высокой частоте  вм 
полосе частот.  
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Рис. 16.20. Раздел Solution Options, включающий выбор порядка базисной 
функции и параметров итеративного солвера 

3.  Relative Residual обеспечивает критерий остановки. Разность оценивает 
итерационного решающего устройства при решении матричного уравнения. 
Значение действует на характеристики  итерационного решающего 
устройства следующим образом: 
 
• По умолчанию она равна 1E-4. Это дает точные S-параметры и поля, 
неразличимые от полученных прямым решающим устройством. Ansoft 
рекомендует устанавливать эту величину Residal. 
 

•  При большей величине Residual, например, 1E-3 или 1E-2, итеративный 
процесс остановится с меньшим количеством итераций, и решение будут 
меньше сходиться. S-параметры  не будут отличаться много от результатов, 
полученных прямым решением, например, разница в третьей или второй 
цифре. Поля и диаграммы направленности антенны - визуально те же самые. 

 
•   Величина Residual = 0.1 может использоваться для быстрого адаптивного 
измельчения сетки рано в адаптивном процессе, но S-параметры будут 
заметно отличаться. 

• Величина Residual =1  не должна никогда использоваться. В окно не 
имеется  возможность ввести величину Residual  больше 0.1. 

    Выбор порядка базисных функций. В HFSS-13 можно выбрать 
базисные функции  HFSS используя интерполяцию величин поля между 
узлами тетраэдров. Для этого в разделе Options  диалога Solution Setup  
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выбирается опция Order of Basis.    Это может быть Zero Order, First Order 
(по умолчанию), Second Order, или Mixed order.   Опции Order of Basis  
влияют на уплотнение сетки по критерию Lambda Refinement и выбираются 
следующим образом. 

   Опция с нулевым порядком (Zero Order)  полезна, когда модель 
разбивается на сетку с более чем 100 000 тетраэдров, но размер модели 
является маленьким по сравнению с длиной волны. Более высокие порядки  
увеличивают количество неизвестных для каждого тетраэдра и 
используются, когда требуется большая точность расчета поля.  Если вы 
выбираете Zero Order Solution Basis, все тетраэдры в модели должны иметь 
длину ребер меньше, чем 1/20 длины волны.  

 
        Опции установки при работе на одном компьютере 
 

 
Рис. 16.21. Опции расчета компьютера, работающего самостоятельно 

 
   Для многопроцессорной обработки, выберите опцию Enable 
multiprocessing using HPC licenses.  Эта опция позволяет  использовать 
лицензии HPC, включающие многопроцессорную обработку. 
    Требования к RAM растут линейно с увеличением размера модели. При 
использовании итеративного солвера также имеет место линейное 
увеличение требований к RAM. Если Вы используете базовый солвер, 
требования к RAM увеличиваются нелинейно. 
   Установки решения с доменами всегда используют лицензирование HPC. 
Даже при том, что домены распределяются и могут использовать 
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многопроцессорную обработку, они не используют распределенное решение 
или многопроцессорные лицензии - все это включается в лицензирование 
HPC, включающая домены. 
      Лицензия HPC основана на подсчете общего количества ядер при 
моделировании. Например, выполняя распределенное решение, используя 10 
узлов, с многопроцессорной обработкой, включающей 2 ядра на узел, общее 
количество ядер 2x10, или двадцать ядер. 
    Лицензия HPC  ограничивает тип и число лицензий, которые будут 
проверены для данного числа ядер. Для типа HPC одна лицензия будет 
проверена для каждого используемого ядра. Таким образом, моделирование 
с двадцатью ядрами потребовало бы двадцати лицензий HPC. Для лицензии 
типа HPC Pack, один пакет включает работу с восемью ядрами, и каждый 
дополнительный пакет включает в четыре раза больше ядер. Таким образом, 
моделирование с двадцатью ядрами потребует двух лицензий  HPC Pack, 
охватывающих работу с 8x4, или 32 ядрами. 
5. Для многопроцессорной обработки, отметьте опцию Enable 
multiprocessing using HPC licenses.  Эта опция позволяет использовать 
лицензии HPC, включая многопроцессорную обработку, даже при решении 
задач, которые не включают области-домены. В этом случае лицензии HPC  
выполняют роль лицензии MP. 
6. Выберите один из следующих приоритетов из списка Default Process 
Priority: 

• Critical (highest) Priority (Не рекомендуется) 
• Above Normal Priority (не рекомендуется) 
• Normal Priority (нормальный приоритет) 
• Below Normal Priority (ниже нормального) 
• Idle (lowest) Priority (медленный приоритет) 

   
           Можно установить эти значения, используя дополнительное 
программирование на  Visual Basic. 
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Рис. 16.22. Диалоги свойств рабочего диалога Ansoft 

   Для передачи данных  и управления решением задачи используем 
диалог Submit HPC Job (рис. 16.22). 

     Чтобы представить задания, используя  диалоговое окно Submit HPC Job, 
должно быть установлено кластерное главное имя узла. Выбирая команду 
Tools>Windows HPC>Select Head Node...  появляется запрос (рис. 16.23) на 
выбор имя узла кластера, который вы хотите использовать. 

 
Рис. 16.23.  Выбор имени узла 

 
   Можно ввести главное имя узла кластера в диалоговое окно, а можно  
щелкнуть по кнопке [...],  чтобы просмотреть сеть для кластера, который вы 
хотите использовать. 
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Рис.  16.24. Задание нескольких установок расчета в диалоге 

   После установки заголовка узла имени хоста, выберите Tools>Windows 
HPC>Submit HPC Job ...  

Вы можете выбрать установки в разделе  Analyze Setups (рис. 16.24). 
Здесь можно выбрать следующие опции:  

• All setups in the project; 

• All setups in a specified design: вы выбираете проекта из открывающее 
 гося списка; 

• Specify setups:  Вы можете добавить одну или больше установок ис- 
             пользуя диалог Add Setups...  

     Если вы задаете несколько установок, задачи вызываются 
последовательно в порядке, показываемом в боксе edit. 

    Блок Resource Requirements управляет используемыми вычислительными 
ресурсами. Настройки Distributed Analysis управляют использованием 
ресурсов для части анализа, который может быть распределен по различным 
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ядрам. Настройки Non-Distributed Analysis управляют начальной частью 
анализа, который работает перед запуском любого распределенного анализа 
- эта начальная часть не может быть распределена, чтобы разделить узлы, и 
должна быть выполнена на единственном ядре. 
     Есть две настройки Distributed Analysis. Число механизмов - число групп 
компьютеров, которые запускаются параллельно; компьютеры могут 
работать на отдельных узлах. Установленное число ядер на один компьютер 
управляет степенью параллельной обработки в пределах каждого 
компьютера; эти параллельные потоки данных выполнения должны быть на 
том же самом узле. В случае HFSS каждый распределенный механизм 
представляет один домен большой модели, часть анализа развертки частоты 
или часть анализа установки Optimetrics. 
     Есть только одна установка для не распределенного анализа, потому что 
эта часть анализа должна произойти на единственном узле. Number of cores 
управляет степенью параллелизма, используемого для этой части анализа. 
     Отметьте  Log Analysis Progress, чтобы записать процесс анализа в файле  
<projname.progress>. Этот файл  содержит  сообщения об ошибках, 
предупреждения и др. информация. 
     Нажатие кнопки Next принимает текущие настройки, и совершенствуется 
к диалоговому окну Submit HPC Job: Properties. Нажатие кнопки Cancel 
закрывает диалоговое окно. 
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Заключение 
 
 
   Программа HFSS версии 13, разработанная американской фирмой Ansoft, 
освоению которой в учебном процессе посвящена данная книга – не един-
ственная, которая нашла широкое применение в России в научно-исследо-
вательских учреждениях и учебных заведениях.  Самое большое 
распространение получила так называемая «тройка»: HFSS, CST, FEKO. 
         Часто выбор программного обеспечения диктуется традицией, или 
скоростью обучения на программном продукте. HFSS, начиная с версий, 
разработанных компаниями Hewlett Packard  и Agilent, оказался наиболее 
популярным в России среди программ  электромагнитного моделирования 
трехмерных конструкций, и вносит свой вклад в учебном процессе во 
многих ВУЗах России. 
   Структура радиосистем в настоящее время решительно поделена на циф-
ровую часть и радиочасть – радиоприемники и радиопередатчики, причем 
чаще всего радиотехническая часть - это антенны и самые первые каскады, 
следующие за ними. Цифровая обработка наступает и отвоевывает все боль-
шую часть радиосистемы. Больше того, в управлении антенной решетки 
большую роль выполняет цифровая часть. Поэтому можно сказать, что для 
радиоинженера освоение HFSS – только часть пути подготовки.    
    Выбор программного обеспечения фактически сводится к нахождения 
компромисса между скоростью расчета, имеющимися вычислительными 
ресурсами и объемом задачи (размером в единицах длин волны). Все это 
сводится к  решению задачи оптимизации процесса проектирования совре-
менных СВЧ устройств, выработке соотношения между аналитическими и 
численными методами, решению актуальных задач, стоящих как перед 
организаторами научной работы, так и перед исполнителями от научных 
сотрудников до инженеров. 
     Процесс освоения современного программного обеспечения на студен-
ческой скамье, доведенный до понимания тонкостей процесса проектиро-
вания, это новый и спасительный шаг обучения и подготовки радиоспе-
циалистов высокой квалификации.  
  Надеемся, что метод анализа задач, использованный в учебнике – 
пошаговое построение и анализ результатов – поможет разработчикам СВЧ 
устройств освоить программу HFSS и широко использовать её в своей 
работе. 
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